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Rosemount 5408 and 5408:SIS Level Transmitters – Non-Contacting Radar

NOTICE
Read this manual before working with the product. For personal and system safety, and for optimum product performance, make
sure you thoroughly understand the contents before installing, using, or maintaining this product.

For technical assistance, contacts are listed below:

Customer Central

Technical support, quoting, and order-related questions.

• United States - 1-800-999-9307 (7:00 am to 7:00 pm CST)

• Asia Pacific- 65 777 8211

North American Response Center

Equipment service needs.

• 1-800-654-7768 (24 hours a day — includes Canada)

• Outside of these areas, contact your local Emerson representative.

WARNING!
Failure to follow safe installation and servicing guidelines could result in death or serious injury.

• Make sure the transmitter is installed by qualified personnel and in accordance with applicable code of practice.

• Use the equipment only as specified in this manual. Failure to do so may impair the protection provided by the equipment.

• For installations in hazardous locations, the transmitter must be installed according to the Rosemount 5408 and 5408:SIS 
Product Certifications document and System Control Drawing (D7000002-885).

Explosions could result in death or serious injury.

• Verify that the operating atmosphere of the transmitter is consistent with the appropriate hazardous locations
certifications.

• Before connecting a Field Communicator in an explosive atmosphere, ensure the instruments are installed in accordance
with intrinsically safe or non-incendive field wiring practices.

• In Explosion-proof/Flameproof and Non-Incendive/Type n installations, do not remove the transmitter covers when power is
applied to the unit.

• Both transmitter covers must be fully engaged to meet Explosion-proof/Flameproof requirements.

Electrical shock could cause death or serious injury.

• Avoid contact with the leads and terminals. High voltage that may be present on leads can cause electrical shock.

• Make sure the mains power to the transmitter is off and the lines to any other external power source are disconnected or not
powered while wiring the transmitter.

Process leaks could result in death or serious injury.

• Make sure that the transmitter is handled carefully. If the process seal is damaged, gas might escape from the tank.

Any substitution of non-recognized parts may jeopardize safety. Repair, e.g. substitution of components etc., may also jeopardize
safety and is under no circumstances allowed.

• Unauthorized changes to the product are strictly prohibited as they may unintentionally and unpredictably alter
performance and jeopardize safety. Unauthorized changes that interfere with the integrity of the welds or flanges, such as
making additional perforations, compromise product integrity and safety. Equipment ratings and certifications are no
longer valid on any products that have been damaged or modified without the prior written permission of Emerson. Any
continued use of product that has been damaged or modified without the written authorization is at the customer’s sole risk
and expense.

https://www.emerson.com/documents/automation/product-certifications-rosemount-5408-5408-sis-level-transmitters-en-202464.pdf


CAUTION!
Hot surfaces

The flange and process seal may be hot at high process temperatures. Allow to cool before servicing.

CAUTION!

The products described in this document are NOT designed for nuclear-qualified applications. Using non-nuclear qualified products
in applications that require nuclear-qualified hardware or products may cause inaccurate readings.

For information on Rosemount nuclear-qualified products, contact your local Emerson Sales Representative.
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1 Introduction

1.1 Using this manual
The sections in this manual provide information on installing, operating, and maintaining
the Rosemount™ 5408 and 5408:SIS Level Transmitters – Non-Contacting Radar.

The sections are organized as follows:

Chapter 2 provides an introduction to theory of operation, a description of the transmitter,
information on typical applications, and process characteristics.

Chapter 3 contains mechanical installation instructions.

Chapter 4 contains electrical installation instructions.

Chapter 5 provides instructions on configuration of the transmitter.

Chapter 6 contains operation and maintenance techniques.

Chapter 7 provides troubleshooting techniques for the most common operating problems.

Chapter 8 contains identification, commissioning, maintenance, and operations
information for safety-certified transmitter used in Safety Instrumented Systems (SIS)
applications.

Appendix A supplies reference and specification data, as well as ordering information.

Appendix B contains safety approval information and approval drawings.

Appendix C provides extended information about the configuration parameters.

1.2 Product recycling/disposal
Recycling of equipment and packaging should be taken into consideration and disposed of
in accordance with local and national legislation/regulations.

Introduction
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2 Transmitter Overview

2.1 Measurement principle
The Rosemount™ 5408 and 5408:SIS are two-wire transmitters for continuous level
measurements over a broad range of liquids, slurries, and solids. The measurement
principle is fast-sweep Frequency Modulated Continuous Wave (FMCW).

The transmitter continuously emits signal sweeps with a constantly varying frequency
towards the product surface. Since the transmitter continuously changes the frequency of
the transmitted signal, there will be a difference in frequency between the transmitted and
the reflected signals (see Figure 2-1).

The frequency of the reflected signal is subtracted from the frequency of the signal
transmitted at that moment, resulting in a low frequency signal which is proportional to
the distance to the product surface. This signal is further processed to obtain fast, reliable,
and highly accurate level measurements. See Figure 2-2 for a schematic overview of the
signal processing.

FMCW-methodFigure 2-1:   

Δf≈d=distance

A. Frequency (GHz)
B. Time (s)
C. Transmitted signal
D. Reflected signal

Transmitter Overview
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Flowchart of the Signal ProcessingFigure 2-2:   

Peak search

Fast Fourier transform 
(FFT)

Peak interpolation

Echo tracker

Echo identifier

Distance filtering

Variable calculation

Aout handler LCD handler HART

Microwave module

A/D coverter

2.2 Process characteristics

2.2.1 Dielectric constant
A key parameter for measurement performance is reflectivity. A high dielectric constant of
the media provides better reflection and enables a longer measuring range.

2.2.2 Foam and turbulence
Foaming liquids or turbulence may cause weak and varying surface echo amplitudes. The
effects of turbulence are usually minor, but in the most challenging conditions, the
transmitter may be mounted in a still pipe. In addition, measurement performance can be
optimized by configuring the appropriate process conditions settings, see 
Process conditions.

Transmitter Overview
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Measurement in foamy applications depends largely on the foam properties. When the
foam is light and airy, the actual product level is measured. For heavy and dense foam, the
transmitter may measure the level of the foam’s upper surface. The Double Surface
Handling function allows the user to select if the foam layer or product surface should be
used as output (see Double surface handling).

2.2.3 Dust
Dust is often present in solids applications, and even if the non-contacting radar is not
affected by the dust in the vapor space, dust can be sticky and create a layer on the
antenna. If this layer becomes too thick, it may affect the measurement. This is best
managed by using air purging.

2.2.4 Solid surface
Solids have some common characteristics which may cause weak and varying surface
reflections. The surface is rarely flat or horizontal, the angle of the sloping surface differs
during filling and emptying, and the dielectric constant of many solids is fairly
low.Table 2-1 presents common characteristics of some solids applications.

The parabolic antenna is ideal for applications with weak surface reflections. A larger
diameter concentrates the radar beam and ensures maximum antenna gain. The parabolic
antenna comes with a swivel connection that adjusts for angled tank roofs.

Common Characteristics of Solids ApplicationsTable 2-1:   

Applications

Common characteristics

Particle size Vapor space

Dust or powder Small (<1 in.) Larger (>1 in.) Dust Steam or condensation

Wood chip bins Yes Yes Yes Yes Possible

Grain silo - small kernel grains Yes Yes No Yes No

Grain silo - large kernel grains No Yes No No No

Lime stone silo No Yes Yes Possible No

Cement - raw mill silo Yes Yes No Yes No

Cement - finished product silo Yes Yes No Yes No

Coal bin Yes Yes Yes Yes Yes

Saw dust Yes Yes No Yes No

High consistency - pulp stock No No No No Yes

Alumina Yes Yes No Yes No

Salt No Yes Yes No No

Transmitter Overview
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2.3 Vessel characteristics

2.3.1 In-tank obstructions
The transmitter should be mounted so that objects such as heating coils, ladders, and
agitators are not in the radar signal path. These objects may cause false echoes resulting in
reduced measurement performance. However, the transmitter has built-in functions
designed to reduce the influence from disturbing objects where such objects cannot be
totally avoided.

Vertical and inclined structures cause minimal effect since the radar signal is scattered
rather than directed back to the antenna.

2.3.2 Tank shape
The shape of the tank bottom affects the measurement signal when the product surface is
close to the tank bottom. The transmitter has built-in functions which optimize
measurement performance for various bottom shapes.

2.4 Application examples
The Rosemount 5408 and 5408:SIS are ideal for level measurements over a broad range of
liquid and solids applications. The transmitters are virtually unaffected by changing
density, temperature, pressure, media dielectric, pH, and viscosity. Non-contacting radar
level is ideal for harsh conditions such as corrosive and sticky media, or when internal tank
obstructions are a limiting factor.

Storage and buffer tanks

The Rosemount 5408 provides accurate and reliable level measurement for both metallic
or non-metallic vessels containing almost any liquid (e.g. oil, gas condensate, water,
chemicals).

Reactors

The Rosemount 5408 is ideal for the most challenging applications, including reactors
where there can be agitation, foaming, condensation as well as high temperatures and
pressures.

Transmitter Overview
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Blenders and mixers

The Rosemount 5408 can help you withstand the rigors of blenders and mixing tanks. Easy
to install and commission, it is also unaffected by virtually any fluid property change.

Open atmospheric applications

The Rosemount 5408 measures reliably in open applications, from short range sumps or
ponds to long range dams.

Still pipe and chamber installations

The Rosemount 5408 is an excellent choice for level measurement in tanks with still pipes.
It may also be used in chambers, but guided wave radar is generally the best fit for these
applications. See Section 3.3.8 for installation guidelines.

Transmitter Overview
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Bulk solids

The Rosemount 5408 is the ideal solution for small to medium sized silos with rapid level
changes. The narrow beam avoids internal obstructions while still keeping good level
measurement.

Safety applications

The Rosemount 5408:SIS is the ideal choice for safety functions such as overfill prevention,
level deviation monitoring or dry-run prevention.

SIL 2

2.5 Components of the transmitter
Figure 2-3 shows the different components of the transmitter. There are different antenna
types and sizes available for various applications.

Transmitter Overview
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ComponentsFigure 2-3:   

A. Terminal compartment I. Alignment marker (one per side)

B. Transmitter housing (aluminum or stainless steel) J. Threaded process connection (NPT or BSPP
(G))

C. Sensor module with signal processing electronics K. Air purge ring (option code PC1 for cone an-
tenna)

D. External ground screw L. Integrated air purge connection

E. Flanged process connection M. Parabolic antenna

F. Cone antenna N. Parabolic antenna with swivel mount

G. Two cable/conduit entries (½-14 NPT, M20 x 1.5,
or G½)

Optional adapters: eurofast™ and minifast™

O. Process seal antenna

H. LCD display (optional) P. Tri-Clamp process connection

Transmitter Overview
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2.6 System integration
The transmitter is loop-powered, and uses the same two wires for power supply and
output signal. The output is a 4-20 mA analog signal superimposed with a digital HART
signal. The transmitter can be configured for either HART Revision 6 (default) or 7 (option
code HR7). The HART Revision can be switched in field.

By using the optional Rosemount 333 HART Tri-Loop™, the digital HART signal can be
converted into three additional 4-20 mA analog signals. With the HART protocol,
multidrop configuration is possible. In this case, communication is restricted to digital,
since current is fixed to the 4 mA minimum value.

The transmitter can be combined with the Emerson™ Wireless 775 THUM™ Adapter to
wirelessly communicate HART data with IEC 62591 (WirelessHART®) technology. In
addition, the transmitter can be connected to a Rosemount 751 Field Signal Indicator, or it
can be equipped with an LCD display.

The transmitter can easily be configured by using a PC with the Rosemount Radar Master
Plus software (running in the Instrument Inspector™ Application), a Field Communicator,
the AMS Device Manager, or any other Device Descriptor (DD) or Field Device Integration
(FDI) compatible host system.

The Rosemount 5408 and 5408:SIS are compliant with NAMUR NE 107 Field Diagnostics
for standardized device diagnostic information.

Transmitter Overview
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System ArchitectureFigure 2-4:   

A. Emerson Wireless 775 THUM Adapter
B. Rosemount 5408
C. Rosemount 751
D. Field Communicator
E. Approved IS barrier (for Intrinsically Safe installations only)
F. Rosemount 333
G. Host/DCS system
H. HART modem
I. Rosemount Radar Master Plus or AMS Device Manager

Transmitter Overview
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3 Mechanical Installation

3.1 Safety messages
Instructions and procedures in this section may require special precautions to ensure the
safety of the personnel performing the operations. Information that potentially raises
safety issues is indicated by a warning symbol ( ). Refer to the following safety messages
before performing an operation preceded by this symbol.

WARNING!

Failure to follow safe installation and servicing guidelines could result in death or serious
injury.

• Make sure the transmitter is installed by qualified personnel and in accordance with
applicable code of practice.

• Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.

• For installations in hazardous locations, the transmitter must be installed according to
the Rosemount 5408 and 5408:SIS Product Certifications document and System Control
Drawing (D7000002-885).

Process leaks could result in death or serious injury.

• Make sure that the transmitter is handled carefully. If the process seal is damaged, gas
might escape from the tank.

Explosions could result in death or serious injury.

• Verify that the operating atmosphere of the transmitter is consistent with the
appropriate hazardous locations certifications.

3.2 Confirm approval type
For hazardous locations transmitters labeled with multiple approval types:

Permanently mark the checkbox of the selected approval type(s).

Mechanical Installation
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Label with Multiple Approval TypesFigure 3-1:   

3.3 Installation considerations
Before installing the transmitter, follow recommendations for mounting position,
sufficient free space, nozzle requirements, etc.

3.3.1 Mounting position
When finding an appropriate location on the tank for the transmitter, the conditions of the
tank must be carefully considered.

Consider the following guidelines when mounting the transmitter:

• For optimal performance, the transmitter should be installed in locations with a
clear and unobstructed view of the product surface.

• The transmitter should be mounted with as few internal structures as possible
within the signal beam, see Section 3.3.6.

• Do not install the transmitter in the center of the tank.

• Do not mount close to or above the inlet stream.

• Multiple Rosemount 5408 and 5408:SIS Level Transmitters can be used in the same
tank without interfering with each other.
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Recommended Mounting PositionFigure 3-2:   

3.3.2 Free space requirements
If the transmitter is mounted close to a wall or other tank obstructions such as heating
coils and ladders, noise might appear in the measurement signal. Therefore the following
minimum clearance, according to Table 3-1, must be maintained.

For easy access to the transmitter, mount it with sufficient service space (see Table 3-2).

Free Space RequirementsFigure 3-3:   
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Distance to Tank Wall (L)Table 3-1:   

Application Minimum Recommended

Liquids 8 in. (200 mm) ½ of tank radius

Solids 8 in. (200 mm) ⅔ of tank radius

Free Space RequirementsTable 3-2:   

Description Distance

Service space width (A) 20 in. (500 mm)

Service space height (B) 24 in. (600 mm)

3.3.3 Antenna size
Choose as large antenna diameter as possible. A larger antenna diameter concentrates the
radar beam and ensures maximum antenna gain. Increased antenna gain permits greater
margin for weak surface echoes.

In addition, a larger antenna diameter results in a smaller beam angle and thereby, less
interference from any internal structures in the tank.

3.3.4 Antenna inclination
Ensure the antenna is aligned perpendicular to the product surface (see Figure 3-4). The
parabolic antenna comes with a swivel connection that adjusts for angled tank roofs.

Note that if the surface echo is weak in solids applications, then a small inclination of the
parabolic antenna toward the surface slope may improve the performance.
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InclinationFigure 3-4:   

Max. 1.5°

90°

A

B

90°

Max. 3°

A. Cone antenna/process seal antenna
B. Parabolic antenna

3.3.5 Non-metallic tanks
The walls in non-metallic tanks can be invisible to the radar signal, so nearby objects
outside the tank may cause disturbing radar echoes. Wherever possible, the transmitter
should be positioned so that objects close to the tank are kept outside the signal beam.

3.3.6 Beam width and beam angle
The transmitter should be mounted with as few internal structures as possible within the
signal beam. Refer to Table 3-3 for beam angle and Table 3-4 for beam width at different
distances.
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Beam Angle and Beam WidthFigure 3-5:   

Beam AngleTable 3-3:   

Antenna size Beam angle (α)

2-in. (DN50) cone/process seal 18°

3-in. (DN80) cone/process seal 14°

4-in. (DN100) cone/process seal 10°

8-in. (DN200) parabolic 4.5°

Beam Width, ft. (m)Table 3-4:   

Distance (D)

Beam width (W)

2-in. cone/ process
seal

3-in. cone/ process
seal

4-in. cone/ process
seal Parabolic

16 (5) 5.2 (1.6) 4.0 (1.2) 2.9 (0.9) 1.3 (0.4)

33 (10) 10.4 (3.2) 8.1 (2.5) 5.7 (1.8) 2.6 (0.8)

49 (15) 15.6 (4.8) 12.1 (3.7) 8.6 (2.6) 3.9 (1.2)

66 (20) 20.8 (6.3) 16.1 (4.9) 11.5 (3.5) 5.2 (1.6)

82 (25) 26.0 (7.9) 20.1 (6.1) 14.3 (4.4) 6.4 (2.0)

98 (30) 31.2 (9.5) 24.2 (7.4) 17.2 (5.3) 7.7 (2.4)

131 (40) 41.6 (12.7) 32.2 (9.8) 23.0 (7.0) 10.3 (3.1)
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3.3.7 Nozzle requirements
In order to allow the microwaves to propagate undisturbed, the nozzle dimensions should
be kept within the specified limits as given in Table 3-5, Table 3-6, and Table 3-7.

Nozzle requirements for cone antenna

For best performance, the cone antenna should extend at least 0.4 in. (10 mm) below the
nozzle. If required, use the extended cone antenna versions (option code S1 or S2).

However, the antenna can be recessed in smooth nozzles up to 4 ft. (1.2 m). Note that if
the inside of the nozzle has irregularities (e.g. due to bad welding, rust, or deposit), then
use the extend cone antenna.

Mounting of the Cone AntennaFigure 3-6:   

H

> 0.4 in. (10 mm)

D

Nozzle Requirements for Cone Antenna, in Inches (Millimeters)Table 3-5:   

Antenna size Minimum nozzle diameter (D)(1)

Recommended maximum nozzle height (H)(2)(3)

Antenna Antenna with air purge ring (code PC1)

2-in. (DN50) 1.94 (49.3) 5.71 (145) 4.69 (119)

3-in. (DN80) 2.80 (71.0) 5.63 (143) 4.61 (117)

4-in. (DN100) 3.78 (96.0) 6.54 (166) 5.51 (140)

(1) The antennas are sized to fit within schedule 80 or lower schedules.

(2) The values are valid for cone antennas without antenna extension.

(3) For liquid applications, the cone antenna can be recessed in smooth nozzles up to 4 ft. (1.2 m), but note that the accuracy may be
reduced in the region close to the nozzle.

Nozzle requirements for process seal antenna

The antenna can be used on nozzles up to 4 ft. (1.2 m). Disturbing objects inside the nozzle
may impact the measurement, and should therefore be avoided.
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Mounting of the Process Seal AntennaFigure 3-7:   

Nozzle Requirements for Process Seal AntennaTable 3-6:   

Antenna size Minimum nozzle diameter (D)(1)
Recommended maximum nozzle height
(H)(2)

2-in. (DN50) 1.77 in. (45 mm) 4 ft. (1.2 m)

3-in. (DN80) 2.76 in. (70 mm) 4 ft. (1.2 m)

4-in. (DN100) 2.76 in. (70 mm) 4 ft. (1.2 m)

(1) The antennas are sized to fit within schedule 120 or lower schedules.

(2) For hygienic applications, the nozzle height (H) must not exceed 2 × nozzle diameter (D) to ensure
cleanability. Maximum nozzle height is 5 in. (127 mm).

Nozzle requirements for parabolic antenna

See Table 3-7 for nozzle height recommendations at different inclination angle.
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Mounting of the Parabolic AntennaFigure 3-8:   

H

Ø 8 in. (200 mm)

A B

H

D

A. Nozzle mounting
B. Flange mounting in manhole cover

Nozzle Requirements for Parabolic Antenna, in Inches (Millimeters)Table 3-7:   

Nozzle size (D) Inclination angle (α) Maximum nozzle height (H)(1)

Pipe schedule std, Ø 8 in. (200 mm) 0° 5.9 (150)

3° 5.5 (140)

6° 1.6 (40)

9° 1.2 (30)

12° 1.0 (25)

15° 0.6 (15)

Pipe schedule std, Ø10 in. (250 mm) 0° 8.0 (200)

3° 8.0 (200)

6° 8.0 (200)

9° 8.0 (200)

12° 5.9 (150)

15° 4.3 (110)

(1) Note that the inside of the nozzle must be smooth (i.e. avoid bad welding, rust, or deposit).

3.3.8 Still pipe/chamber installations
Installation in still pipe/chamber is recommended for tanks where there are excessive
foaming or turbulence. Still pipe/chamber may also be used to avoid disturbing objects in
the tank.

Still pipe

Consider the following still pipe requirements:
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Pipe • Pipes should be an all-metal material.

• Pipe should have a constant inside diameter.

• The inner surface must be smooth and clear of any rough edges.
(Smooth pipe joints are acceptable, but may reduce accuracy.)

• The end of the pipe must extend beyond the zero level.

Holes • Maximum hole diameter is 1 in. (25 mm).

• Minimum distance between holes is 6 in. (150 mm).

• Holes should be drilled on one side only and deburred.

• Drill one hole above maximum product surface.

Antenna • All cone/process seal antenna sizes can be used for still pipe/chamber
installations.

• The gap between the cone antenna and the still pipe should be
maximum 0.2 in. (5 mm). If required, order a larger antenna and cut on
location. See Table A-19 for antenna dimensions.
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Still Pipe RequirementsFigure 3-9:   

A. Max. 0.2 in. (5 mm)
B. Max. 1 in. (25 mm)
C. Min. 6 in. (150 mm)
D. Max. 1°
E. Level = 100%
F. Level = 0%

Chamber

Consider the following chamber requirements:

• Pipes should be an all-metal material.

• Pipe should have a constant inside diameter.

• Inlet pipes should not protrude into the inside of the stand pipe.

• The inner surface must be smooth and clear of any rough edges. (Smooth pipe joints
are acceptable, but may reduce accuracy.)

• The gap between the cone antenna and the stand pipe should be maximum 0.2 in.
(5 mm). If required, order a larger antenna and cut on location. See Table A-19 for
antenna dimensions.
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Chamber RequirementsFigure 3-10:   

A. Min. 0.4 in. (10 mm)
B. Min. 6 in. (150 mm)
C. Max. 1°
D. Max. 0.2 in. (5 mm)

For more information and installation requirements, refer to the Guidelines for Choosing
and Installing Radar in Stilling Wells and Bypass Chambers Technical Note.

3.3.9 Ball valve installation
The transmitter can be isolated from the process by using a valve:

• Use a full-port ball valve.

• Ensure there is no edge between the ball valve and the nozzle or still pipe, the inside
should be smooth.

• Valves can be combined with still pipes.
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3.4 Mounting preparations

3.4.1 Assemble the segmented cone antenna
This section applies to the segmented cone antenna (option code S2). Use only one
segment; the total antenna length should not exceed 47.2 in. (1200 mm).

To determine the antenna length, follow the guidelines in section Section 3.3.7.

Procedure

1. Insert the segment into the cone antenna until it bottoms.

2. Mark where to cut the segment.

1 2 3 4 5 6 7 80 9

3. Remove and cut the segment at the marking.

4. Remove any burrs.

5. Insert the segment into the cone antenna until it bottoms.

6. Secure the segment to the antenna.
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1 2 3 4

7. Measure the Antenna Extension Length (L).

1 2 3 4 5 6 7 80 9

8. Update the transmitter configuration to the new Antenna Extension Length (L).

• Rosemount Radar Master Plus:

- Under Configure, select Level Setup > Antenna.

• AMS Device Manager and Field Communicator:

- Select Configure > Manual Setup > Level Setup > Antenna.

3.4.2 Shorten the extended cone antenna
This section only applies to the extended cone antenna (option code S1).

To determine the antenna length, follow the guidelines in section Section 3.3.7.

Procedure

1. Mark where to cut the antenna.

1 2 3 4 5 60

2. Cut the antenna at the marking.
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3. Remove any burrs.

4. Measure the Antenna Extension Length (L).

1 2 3 4 5 60

5. Update the transmitter configuration to the new Antenna Extension Length (L).

• Rosemount Radar Master Plus:

- Under Configure, select Level Setup > Antenna.

• AMS Device Manager and Field Communicator:

- Select Configure > Manual Setup > Level Setup > Antenna.
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3.5 Mount the cone antenna

OverviewFigure 3-11:   

A. Flanged version (see page 29)
B. Flanged version with air purge ring (see page 30)
C. Threaded version, D < d (see page 31)
D. Threaded version, D > d (see page 34)
E. Bracket mounting (see page 36)

3.5.1 Protective cap
For spare antennas, keep the protective cap in place until installing the transmitter head.
The cap protects the process seal from dust and water.
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Protective CapFigure 3-12:   

3.5.2 Flanged version
1. If applicable, assemble the segmented cone antenna (see Section 3.4.1).

2. Lower transmitter with antenna and flange into the nozzle.

Gasket

3. Tighten bolts and nuts with sufficient torque for the flange and gasket choice.

4. Align the transmitter head (see Section 3.5.7).

Mechanical Installation

Rosemount 5408 and 5408:SIS Level Transmitters 29



3.5.3 Flanged version with air purge ring (option code PC1)
1. If applicable, assemble the segmented cone antenna (see Section 3.4.1).

2. Place a suitable gasket on the tank flange.

3. Place the purge ring over the gasket.

4. Place a suitable gasket over the purge ring.

Note
A minimum gasket thickness of 0.125 in. (3.2 mm) is required for flanges with protective
plate design.

5. Lower transmitter with antenna and flange into the nozzle.

Antenna with air purge holes

6. Tighten bolts and nuts with sufficient torque for the flange and gasket choice.
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1.0 in. (25.5 mm)

7. Connect the air purging system. Use thread sealant or suitable gasket according to
your site procedures.

0.4 in. (10 mm)

or

G3/8-in.

Incoming Air Supply SpecificationTable 3-8:   

Maximum pressure Recommended pressure

190 psi (13 bar) 100 to 115 psi (7 to 8 bar)

8. Align the transmitter head (see Section 3.5.7).

3.5.4 Threaded version, antenna diameter (D) < Thread
diameter (d)

Flanged tank connection
1. If applicable, assemble the segmented cone antenna (see Section 3.4.1).

Mechanical Installation

Rosemount 5408 and 5408:SIS Level Transmitters 31



2. Place a suitable gasket on the tank flange.

3. Place the customer supplied flange over the gasket.

4. Tighten the bolts and nuts with sufficient torque for the flange and gasket choice.

5. Apply anti-seize paste or PTFE tape on threads according to your site procedures.

 Gasket may be used as a sealant for adapters with 1½- or 2-in. BSPP (G) threads.

6. Lower transmitter with antenna and flange into the nozzle.
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Gasket 
(for 1½-in. and 2-in. 

BSPP (G) threads only)

7. Align the transmitter head (see Section 3.5.7).

Threaded tank connection
1. If applicable, assemble the segmented cone antenna (see Section 3.4.1).

2. Apply anti-seize paste or PTFE tape on threads according to your site procedures.

 Gasket may be used as a sealant for adapters with 1½- or 2-in. BSPP (G) threads.

3. Mount the transmitter on the tank.
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Gasket 
(for 1½-in. and 2-in. 

BSPP (G) threads only)

4. Align the transmitter head (see Section 3.5.7).

3.5.5 Threaded version, antenna diameter (D) > Thread
diameter (d)
1. If applicable, assemble the segmented cone antenna (see Section 3.4.1).

2. Unscrew and remove the antenna.

H2 mm

Note
Be careful not to scratch the microwave launcher. The microwave launcher is sensitive to
mechanical impacts.

Microwave launcher
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3. Apply anti-seize paste or PTFE tape on threads according to your site procedures.

 Gasket may be used as a sealant for adapters with 1½- or 2-in. BSPP (G) threads.

4. Mount the adapter on the customer supplied flange.

Gasket 
(for 1½-in. and 2-in. 

BSPP (G) threads only)

5. Mount the antenna.

H2 mm

38 mm
Torque 250 in-lb (28 N-m) 

Torque 5 in-lb (0.5 N-m)

Note
Visually inspect the microwave launcher for damage and dirt.

6. Lower transmitter with antenna and flange into the nozzle.
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Gasket

7. Tighten the bolts and nuts with sufficient torque for the flange and gasket choice.

8. Screw the adapter until it is properly tightened.

9. Align the transmitter head (see Section 3.5.7).

3.5.6 Bracket mounting
1. Mount the bracket to the pipe/wall.

On pipe:

Mechanical Installation

36  Reference Manual



4X

Horizontal pipe

Vertical pipe

On wall:
4X

2. Mount the holder to the bracket.

3. Unscrew and remove the antenna.

H2 mm

Note
Be careful not to scratch the microwave launcher. The microwave launcher is sensitive to
mechanical impacts.
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Microwave launcher

4. Screw the transmitter into the holder.

5. Mount the antenna.

H2 mm

38 mm

Torque 5 in-lb (0.5 N-m)

6. Align the transmitter head (see Section 3.5.7).

3.5.7 Align transmitter head
1. Loosen the nut slightly and turn the transmitter.
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60 mm

2. Verify the transmitter head is properly aligned.

Option Description

Open tank Align the marking on the sensor module toward the tank wall (see Figure 3-13).

Still pipe Align the external ground screw toward the holes of the still pipe (see 
Figure 3-14).

Chamber Align the external ground screw toward the process connections (see 
Figure 3-15).

3. Tighten the nut.

60 mm
Torque 355 in-lb (40 N-m) 

Open TankFigure 3-13:   
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Still pipeFigure 3-14:   

ChamberFigure 3-15:   

3.6 Mount the process seal antenna

OverviewFigure 3-16:   

A. Flanged version (see page 40)
B. Tri-Clamp version (see page 42)

3.6.1 Flanged version
1. Lower the transmitter into the nozzle.
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Note
Be careful not to scratch or otherwise damage the PTFE sealing.

PTFE sealing

2. Tighten the bolts and nuts (see Table 3-9).

Note

• Re-tighten after 24 hours and again after the first temperature cycle.

• Check at regular intervals and re-tighten if necessary.
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Torque Value, lb-ft (N-m)Table 3-9:   

Process connection size (1) (2)

Process connection rating(1)(2)

ASME B16.5 EN1092-1 JIS B2220

Class 150 Class 300 PN6 PN10/PN16 PN25/PN40 10K

2-in./DN50/50A 29 (40) 52 (70) 15 (20) 26 (35) 29 (40) 18 (25)

3-in./DN80/80A 33 (45) 48 (65) 37 (50) 37 (50) 41 (55) 22 (30)

4-in./DN100/100A 59 (80) 52 (70) 37 (50) 37 (50) 74 (100) 26 (35)

(1) The conditions used for the calculation are: Standard mating metal flange, A193 B8M Cl.2 / A4-70 bolt material, and a friction
coefficient of μ=0.16.

(2) Low strength bolt and non-metallic mating flange may require lower tightening torque.

3. Align the transmitter head (see Section 3.5.7).

3.6.2 Tri-Clamp version
1. Lower the transmitter into the nozzle.

Note
Be careful not to scratch or otherwise damage the PTFE sealing.

PTFE sealing

2. Tighten the clamp to the recommended torque (see the manufacturer’s instruction
manual).
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3. Align the transmitter head (see Section 3.5.7).

3.7 Mount the parabolic antenna

OverviewFigure 3-17:   

A. Flanged version (see page 43)
B. Threaded version (see page 45)
C. Welded version (see page 49)

3.7.1 Flanged version
1. Lower the flange and antenna assembly into the nozzle.

Gasket
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2. Tighten the bolts and nuts with sufficient torque for the flange and gasket choice.

3. Adjust the inclination of the antenna (see Section 3.7.4).

4. Connect the air purging system (see Section 3.7.5).
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3.7.2 Threaded version

ComponentsFigure 3-18:   

2x

A. Antenna E. Lock nut BSPP (G) 3½"

B. Purge plug kit F. Antenna adapter with ball joint

C. Threaded sleeve G. O-ring

D. M20 adapter

Procedure

1. Remove the lock nut.
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2. Mount the O-ring.

3. Mount the antenna adapter on flange/manhole cover. Ensure the antenna adapter
fits tightly to the flange/manhole cover.

Ø 3.98 ± 0.02 in.
(Ø 101 ± 0.6 mm)

OR
G 3½"

Max. 1.18 in. (30 mm)

> 0.59 in. (15 mm)

4. Remove the M20 adapter and visually inspect the O-rings for damage and dirt.

D

A

O-rings

5. Carefully insert the antenna.

Mechanical Installation

46  Reference Manual



6. Secure the antenna.

27 mm

C D

Torque 180 in-lb (20 N-m) 

7. Tighten the set screw.

H2 mm
Torque 5 in-lb (0.5 N-m)

8. Lower the antenna assembly into the tank.
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Gasket

9. Tighten the bolts and nuts with sufficient torque for the flange and gasket choice.

10. Adjust the inclination of the antenna (see Section 3.7.4).

11. Connect the air purging system (see Section 3.7.5).

Mechanical Installation

48  Reference Manual



3.7.3 Welded version

ComponentsFigure 3-19:   

A. Antenna G. Weld protection bar

B. Purge plug kit H. O-ring

C. Threaded sleeve I. Ball joint

D. M20 adapter J. Clamp flange

E Weld protection plate K. Washer

F Flange ball L. M8 screw
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Procedure

1. Mount the protection plates to flange/manhole cover. These plates protect the
internal surfaces of the flange ball from dust and sparks during welding.

Ø 3.94 ± 0.02 in.
(Ø 100 ± 0.5 mm)

Max. 1.18 in. (30 mm)

G

E

E

F

2. Weld the flange ball.

3. Remove the protection plates and visually inspect the internal surfaces of the flange
ball for damage and dirt.
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4. Mount the O-ring.

5. Mount the ball joint.

a. Insert the ball joint and place the clamp flange with the “7 Nm” marking side up.

b. Gradually tighten the M8 screws.

H6 mm
Torque 65 in-lb (7 N-m)

J
L
K

I

6. Remove the M20 adapter and visually inspect the O-rings for damage and dirt.
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D

A

O-rings

7. Carefully insert the antenna.

8. Secure the antenna.

27 mm

C D

Torque 180 in-lb (20 N-m) 

9. Tighten the set screw.

H2 mm
Torque 5 in-lb (0.5 N-m)

10. Lower the antenna assembly into the tank.
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Gasket

11. Tighten the bolts and nuts with sufficient torque for the flange and gasket choice.

12. Adjust the inclination of the antenna (see Section 3.7.4).

13. Connect the air purging system (see Section 3.7.5).

3.7.4 Adjust the inclination of the antenna

WARNING!

Contents may be under pressure.

• Do not loosen the M8 screws while in operation. Attempting to do so may release
pressurized gases, resulting in serious injury or death.

Procedure

1. Loosen the M8 screws until the antenna can rotate smoothly.
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H6 mm

2. Rotate the antenna so the air purge connection is directed toward the tank wall.

or

3. Place the circular level on top of the antenna assembly.

4. Adjust the inclination of the antenna.
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5. Gradually tighten the M8 screws.

H6 mm
Torque 65 in-lb (7 N-m)

6. Remove the circular level.

7. Mount the transmitter head.

Align the marking on the sensor module with the air purge connection.
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Torque 355 in-lb (40 N-m) 
60 mm

36 mm

3.7.5 Connect the air purging
If air purging is not used, plug and seal the entry with the purge plug kit.
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Air PurgingFigure 3-20:   

Air purging
B

Use thread sealant or 
gasket according to your 

site procedures.

G3/8-in. 0.3-0.4 in. (8-10 mm)
(gasket excluded)

YesNo

17 mm
Torque 180 in-lb (20 N-m) 

Incoming Air Supply SpecificationTable 3-10:   

Maximum pressure Recommended pressure

190 psi (13 bar) 100 to 115 psi (7 to 8 bar)

3.8 Adjust display orientation (optional)
To improve field access to wiring or to better view the optional LCD display:

1. Loosen the set screw until the transmitter housing can rotate smoothly.

2. First, rotate the housing clockwise to the desired location. If the desired location
cannot be achieved due to thread limit, rotate the housing counterclockwise to the
desired location (up to 360° from thread limit).

3. Re-tighten the set screw.
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Rotate the Transmitter HousingFigure 3-21:   

Torque 30 in-lb (3 N-m)
H3/32 in.

Note
In high vibration applications, the transmitter housing must be fully engaged into the sensor
module to meet the vibration test specifications. This is achieved by rotating the transmitter
housing clockwise to thread limit.

Mechanical Installation

58  Reference Manual



4 Electrical Installation

4.1 Safety messages
Instructions and procedures in this section may require special precautions to ensure the
safety of the personnel performing the operations. Information that potentially raises
safety issues is indicated by a warning symbol ( ). Refer to the following safety messages
before performing an operation preceded by this symbol.

WARNING!

Failure to follow safe installation and servicing guidelines could result in death or serious
injury.

• Make sure the transmitter is installed by qualified personnel and in accordance with
applicable code of practice.

• Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.

• For installations in hazardous locations, the transmitter must be installed according to
the Rosemount 5408 and 5408:SIS Product Certifications document and System Control
Drawing (D7000002-885).

Explosions could result in death or serious injury.

• Verify that the operating atmosphere of the transmitter is consistent with the
appropriate hazardous locations certifications.

• Before connecting a Field Communicator in an explosive atmosphere, ensure the
instruments are installed in accordance with intrinsically safe or non-incendive field
wiring practices.

• In Explosion-proof/Flameproof and Non-Incendive/Type n installations, do not remove
the transmitter covers when power is applied to the unit.

• Both transmitter covers must be fully engaged to meet Explosion-proof/Flameproof
requirements.

Electrical shock could cause death or serious injury.

• Avoid contact with the leads and terminals. High voltage that may be present on leads
can cause electrical shock.

• Make sure the mains power to the transmitter is off and the lines to any other external
power source are disconnected or not powered while wiring the transmitter.

4.2 Cable selection
Use 24-14 AWG wire. Twisted pairs and shielded wiring are recommended for
environments with high EMI (electromagnetic interference).
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Two wires can be safely connected to each terminal screw.

4.3 Cable gland/conduit
For explosion-proof/flameproof installations, only use cable glands or conduit entry
devices certified explosion-proof or flameproof.

4.4 Power supply
The transmitter operates on 12-42.4 Vdc (12-30 Vdc in Intrinsically Safe installations) at
the transmitter terminals.

4.5 Load limitations
For HART® communication, a minimum loop resistance of 250 Ω is required. Maximum
loop resistance is determined by the voltage level of the external power supply.

Load LimitsFigure 4-1:   

Maximum Loop Resistance = 43.5 * (External Power Supply Voltage - 12)

A. Loop Resistance (Ohms)
B. External Power Supply Voltage (Vdc)

4.6 Hazardous areas
When the transmitter is installed in hazardous areas, local regulations, and specifications
in applicable certificates must be observed. See Appendix B for more information.
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4.7 Wiring diagram

4-20 mA/HART CommunicationFigure 4-2:   

1 2 3

4 5 6

7 8

0

9

A. Field Communicator
B. Approved IS barrier (for Intrinsically Safe installations only)
C. HART modem
D. Load resistance (≥250 Ω)
E. Current meter
F. Power supply

For Rosemount 5408:SIS and Rosemount 5408 with option code EF1 (ready for upgrade to
Rosemount 5408:SIS), connect the transmitter as shown in Figure 4-3.
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4-20 mA/HART Communication - Terminal Block with TEST TerminalFigure 4-3:   

1 2 3

4 5 6

7 8

0

9

A. Field Communicator
B. Approved IS barrier (for Intrinsically Safe installations only)
C. HART modem
D. Load resistance (≥250 Ω)
E. Current meter
F. Power supply
G. Blue plug
H. TEST terminal

Note
Blue plug must only be disconnected during loop current measurement procedure.

4.8 Grounding
Make sure grounding is done according to national and local electrical codes. Failure to do
so may impair the protection provided by the equipment.

Transmitter housing

The most effective grounding method is direct connection to earth ground with minimal
impedance. There are two grounding screw connections provided (see Figure 4-4).
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Ground ScrewsFigure 4-4:   

A. Internal ground screw
B. External ground screw

Signal cable shield grounding

Make sure the instrument cable shield is:

• Trimmed close and insulated from touching the transmitter housing.

• Continuously connected throughout the segment.

• Connected to a good earth ground at the power supply end.

Cable ShieldFigure 4-5:   

A. Insulate shield
B. Minimize distance
C. Trim shield and insulate
D. Connect shield back to the power supply ground

4.9 Connect wiring and power up
1.  Verify the power supply is disconnected.

2. Remove the cover.
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3. Remove the plastic plugs.

4. Pull the cable through the cable gland/conduit. (1)

Identification of thread size and type

5. Connect the cable wires (see Section 4.7).

Torque 7 in-lb (0.8 N-m)

(1) Unless marked, the conduit/cable entries in the transmitter housing use a ½–14 NPT thread form.
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6. Ensure proper grounding (see Section 4.8).

7. Tighten the cable gland.

PTFE tape or other sealant

Note
Make sure to arrange the wiring with a drip loop.

8. Seal any unused ports with the enclosed metal plug.

PTFE tape or other sealant

9. Attach and tighten the covers. Make sure the covers are fully engaged.

a. Verify the cover jam screws are completely threaded into the housing.
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Cover jam screw
(one per side)

H2.5 mm

b. Attach and tighten the covers.

c. Turn the jam screw counterclockwise until it contacts the cover.

 Required for explosion-proof/flameproof installations only.

d. Turn the jam screw an additional ½ turn counterclockwise to secure the cover.

10. Connect the power supply.

Note
It may take up to 15 seconds before the LCD display lights up.

4.10 Optional devices

4.10.1 Rosemount™ 333 HART Tri-Loop™

The Rosemount 5408 and 5408:SIS Level Transmitters output a HART signal with four
process variables. By using the Rosemount 333 HART Tri-Loop, up to three additional
analog 4-20 mA outputs are provided.
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Each Tri-Loop channel receives power from control room. Channel 1 must be powered for
the Tri-Loop to operate.

Rosemount 5408 or 5408:SIS receives power from control room.

Note
The operational mode on the Rosemount 5408:SIS must be set to Control/Monitoring when used
with the Rosemount 333 HART Tri-Loop.

Example Installation of Rosemount 333 with Rosemount 5408Figure 4-6:   

A. Approved IS barrier
B. DIN rail mounted Rosemount 333
C. Load resistance (≥250 Ω)
D. Control room

Refer to the Rosemount 333 HART Tri-Loop Reference Manual for further information on
how to install and configure the Rosemount 333.
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5 Configuration

5.1 Safety messages
Instructions and procedures in this section may require special precautions to ensure the
safety of the personnel performing the operations. Information that potentially raises
safety issues is indicated by a warning symbol ( ). Refer to the following safety messages
before performing an operation preceded by this symbol.

WARNING!

Explosions could result in death or serious injury.

• Verify that the operating atmosphere of the transmitter is consistent with the
appropriate hazardous locations certifications.

• Before connecting a Field Communicator in an explosive atmosphere, ensure the
instruments are installed in accordance with intrinsically safe or non-incendive field
wiring practices.

• In Explosion-proof/Flameproof and Non-Incendive/Type n installations, do not remove
the transmitter covers when power is applied to the unit.

• Both transmitter covers must be fully engaged to meet Explosion-proof/Flameproof
requirements.

Electrical shock could cause death or serious injury.

• Avoid contact with the leads and terminals. High voltage that may be present on leads
can cause electrical shock.

5.2 Overview
This chapter provides information about configuration and configuration tools. Appendix C
provides extended information about the configuration parameters. The menu trees can
be found in Section C.1.

5.3 System readiness

5.3.1 Confirm correct device driver
The transmitter meets the NAMUR recommendation NE 53. Verify the latest Device
Descriptor (DD) or FDI Package is loaded on your systems to ensure proper
communication.
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Procedure

1. Within Table 5-1, use the HART® Universal Revision and Device Revision numbers to
find the correct DD or FDI Package.

2. Download the latest DD at EmersonProcess.com/DeviceFiles.

3. Download the latest FDI Package at Emerson.com/RosemountRadarMasterPlus.

Identification and Compatibility According to NAMUR NE 53Table 5-1:   

Release
date Device identification

DD and FDI identifica-
tion Review instructions

Review
functionali-
ty

 

NAMUR
hardware
revision (1)

NAMUR
software
revision(1)

Device
software
revision (2)

HART
®

 uni-
versal revi-
sion (3)

Device re-
vision (4)

Manual document
number

Change de-
scription

March-17 1.0.xx 1.0.xx 1.Axx 6 1 00809-0100-4408 N/A

7 1

(1) NAMUR Revision is located on the transmitter label. Differences in level 3 changes, signified above by xx, represent minor product
changes as defined per NE53. Compatibility and functionality are preserved and product can be used interchangeably.

(2) Device software revision is located on the transmitter label, e.g. 1.A3. It can also be found in Rosemount Radar Master Plus (under
Overview, select Device Information > Revisions ).

(3) HART Revision 6 and 7 can be switched in field. Default HART universal revision from factory is located on the transmitter head label,
e.g. PROTOCOL 6.

(4) Device revision is located on the transmitter label, e.g. DEVICE REV 1.

5.4 Get started with your preferred configuration
tool

5.4.1 Configuration tools
The transmitter can easily be configured using:

• Rosemount Radar Master Plus (running in the Instrument Inspector™ Application)

• Device Descriptor (DD) based systems, e.g. AMS Device Manager, 475 Field
Communicator, AMS Trex™ Device Communicator, and DeltaV™, or any other EDDL
or enhanced-EDDL host

• Field Device Integration (FDI) based systems

Rosemount Radar Master Plus is the recommended tool for configuration.
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5.4.2 Rosemount Radar Master Plus
The Rosemount Radar Master Plus is a user-friendly software package that includes basic
configuration options, as well as advanced configuration and service functions. The
Instrument Inspector Application or any FDI compliant host is needed to run Rosemount
Radar Master Plus.

Instrument Inspector is shipped with every transmitter. See the CD installation guide for a
list of supported HART modems and system requirements.

Instrument Inspector is also available at: Emerson.com/InstrumentInspector

Get the latest FDI Package

The Rosemount 5408 FDI Package is typically installed together with Instrument Inspector.
If the FDI Package is not installed, it can be found on the enclosed CD. The latest FDI
Package can also be downloaded from: Emerson.com/RosemountRadarMasterPlus

After downloading, add the FDI Package to Instrument Inspector.

Procedure

1. Start Instrument Inspector.

2. From the menu bar, select , and then select Add Device Package.

3. Browse to the downloaded FDI Package and select Open.

4. Select Add.

5. Select Back.

5.4.3 AMS Device Manager

Get the latest Device Descriptor (DD)

The Device Descriptor (DD) is a configuration tool that is developed to assist the user
through the configuration. The Rosemount 5408 DD is typically installed together with
AMS Device Manager.

To download the latest DD, visit the Emerson™ Device Install Kit site at: 
EmersonProcess.com/devicefiles

After downloading, add the DD to AMS Device Manager:

Procedure

1. Close AMS Device Manager.

2. Click the Start button, and then select All Programs > AMS Device Manager > Add
Device Type.

3. Browse to the downloaded DD files and select OK.

Configuration

Rosemount 5408 and 5408:SIS Level Transmitters 71

http://www.Emerson.com/InstrumentInspector
http://www.Emerson.com/RosemountRadarMasterPlus
http://www2.emersonprocess.com/en-US/documentation/deviceinstallkits/Pages/deviceinstallkitsearch.aspx


In the Add Device Type application, select the Help button for more information on
how to complete this operation.

Configure the HART modem interface

Before connecting to the device using a HART modem, the HART modem interface must
be configured in AMS Device Manager:

Procedure

1. Close AMS Device Manager.

2. Click the Start button, and then select All Programs > AMS Device Manager >
Network Configuration.

3. Select Add.

4. In the drop down list, select HART modem and select Install.

5. Follow the on-screen instructions.

In the Network Configuration application, select the Help button for more
information on how to complete this operation.

5.4.4 Field Communicator

Get the latest Device Descriptor (DD)

If the DD is not installed in your Field Communicator, see the appropriate Field
Communicator User’s Manual available at Emerson.com/FieldCommunicator for instructions
on how to update the Field Communicator with the latest DD.

5.5 Confirm HART revision capability
If using HART based control or asset management systems, confirm the HART capability of
those systems prior to transmitter installation. Not all systems are capable of
communicating with HART Revision 7 protocol. This transmitter can be configured for
either HART Revision 6 or Revision 7.

5.5.1 Switch HART revision mode
If the HART configuration tool is not capable of communicating with HART Revision 7, the
device will load a generic menu with limited capability.

To switch the HART revision mode from the generic menu:

Procedure

1. Locate the “Message” field.

2. In the Message field, enter HART6 or HART7 and then 27 trailing spaces.

Configuration

72  Reference Manual

http://www.Emerson.com/FieldCommunicator


5.6 Configure device using Guided Setup
The options available in the Guided Setup wizard include all items required for basic
operation. All basic configuration parameters are described in Appendix C.

5.6.1 Configure using Rosemount Radar Master Plus
1. Start Instrument Inspector Application.

2. Under HART, double-click the device icon.

3. From the Overview screen, select Rosemount Radar Master Plus.

4. Under Configure, select Guided Setup and follow the on-screen instructions.

5.6.2 Configure using AMS Device Manager
1. Start AMS Device Manager.

2. Select View > Device Connection View.

3. In the Device Connection View, double-click the HART modem icon.

4. Double-click the device icon.

5. Select Configure > Guided Setup.

6. Select Basic Setup and follow the on-screen instructions.

5.6.3 Configure using Field Communicator
1. Turn on the Field Communicator and connect to the device.

2. Select Configure > Guided Setup.

3. Select Basic Setup and follow the on-screen instructions.

5.7 Verify level
The Verify Level tool matches the product level reported by the device to a reference
measurement (measured by using for example handgauging).
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If any difference, the Calibration Offset parameter will be adjusted. A minor adjustment
using Calibration Offset is normal. There may, for example be a deviation between the
actual tank height and the configured value.

Calibration OffsetFigure 5-1:   

A. Positive Calibration Offset value
B. Negative Calibration Offset value
C. Reported level
D. Actual level

Note
Before running Verify Level, make sure that: the product surface is calm, the tank is not being filled or
emptied, and the actual level is well above the tank bottom.

5.7.1 Use Rosemount Radar Master Plus
Verify Level is included as part of the Guided Setup wizard. The tool is also available as
follows:

Under Configure, select Verify Level to check your level measurement, and follow the on-
screen instructions.

5.7.2 Use AMS Device Manager and Field Communicator
Verify Level is included as part of the Guided Setup wizard. The tool is also available as
follows:

1. Select Configure > Guided Setup.

2. Select Verify Level to check your level measurement, and follow the on-screen
instructions.

Configuration

74  Reference Manual



5.8 Establish multidrop communication
Multidropping transmitters refers to the connection of several transmitters to a single
communications transmission line. Communication between the host and the
transmitters takes place digitally with the analog output of the transmitters deactivated.

In multidrop communication, each transmitter in the loop must have a unique HART
address.

5.8.1 Use Rosemount Radar Master Plus
1. Under Configure, select Device Setup HART.

2. Under Communication Interface, select HART Multidrop.

3. In the HART Address box, type or select the HART address you want to use.

4. Select Save.

5.8.2 Use AMS Device Manager
1. Select Configure > Manual Setup > Device Setup > HART.

2. Select Change Address, and then type the HART address you want to use.

3. Select Next.

4. Select Finish when the Method Complete message appears.

5. Ensure the Multidrop check box is selected.

5.8.3 Use Field Communicator
1. Select Configure > Manual Setup > Device Setup > HART.

2. Select Change Address.

3. Type the HART address you want to use, and then select ENTER.

4. Ensure Multidrop is set to ON.

5.9 Use with the Rosemount 333 HART Tri-Loop
To prepare the transmitter for use with a Rosemount 333 HART Tri-Loop, the transmitter
must be configured to Burst Mode and the process variable output order must be set. This
can be done using the AMS Device Manager or a Field Communicator.

Procedure

1. Make sure the transmitter is properly configured.

2. If desired, change the measurement units.

a. Select Configure > Manual Setup > Device Setup > Units.
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3. Set the desired transmitter variable to use for Primary Variable (PV), Secondary
Variable (SV), Third Variable (TV), and Fourth Variable (QV).

a. Select Configure > Manual Setup > Device Setup > HART.

b. Under Variable Mapping, select variables for PV, SV, TV, and QV.

4. Set the Rosemount 5408 to Burst Mode.

• HART Revision 6:

a. Select Configure Burst Mode.

b. Under Burst Mode, select On.

c. Under Burst Command, select PV, SV, TV, QV.

d. Select Send.

• HART Revision 7:

a. Select Configure Burst Mode.

b. Select View/Configure Message 1.

c. Under Message 1 Broadcast, select Wired HART Enabled.

d. Under Burst Command, select PV, SV, TV, QV, and then select Next.

e. Under Burst Msg Trigger Mode, select Continuous, and then select Next.

f. Set the Update Period, and then select Finish.

5. Prior to exiting the configuration, note the selected variables for SV, TV, and QV, and
the units set for each of the variables. The same configuration must be used for the
Rosemount 333.

Refer to the Rosemount 333 HART Tri-Loop Reference Manual for full information
about installing and configuring the Rosemount 333.
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6 Operation

6.1 LCD display screen messages
The optional LCD display shows output variables and abbreviated diagnostic messages.

LCD Display (Option Code M5)Figure 6-1:   

6.1.1 Startup screen sequence
The following screens are shown on the LCD display when the transmitter is switched on:
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Startup Screen SequenceFigure 6-2:   

   

1. All segments on 2. Device type and communica-
tion protocol

3. Software revision

  

 

4. Serial number 5. Device HART address  

6.1.2 Variable screens
The Rosemount™ 5408 and 5408:SIS Level Transmitters can display the following variables:

LCD Display VariablesTable 6-1:   

Parameter
Presentation
on display Description

Level LEVEL The current level measurement value.

Distance DIST Distance from the upper reference point to the product
surface.

Level Rate LR The current velocity at which the level is moving. A posi-
tive value indicates the surface is moving up.

Signal Strength AMP The signal amplitude of the surface echo.

Volume VOLUM Volume of the product at the current level.

Electronics Temper-
ature

ITEMP The current temperature at the electronics.

Signal Quality (1) SIG QUALITY The quality of product surface echo signal compared to
surface threshold and noise.

Scaled Variable(1) SCALE (2) A variable calculated from a scaling table (as defined by
pairs of input/scaled values).
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LCD Display Variables (continued)Table 6-1:   

Parameter
Presentation
on display Description

Percent of Range
Primary Variable

PV %RANGE A variable value expressed in percent within a range de-
fined by a Lower Range Value (LRV) and an Upper Range
Value (URV).

Auxiliary Percent of
Range

AUX %RANGE A variable value expressed in percent within a range de-
fined by a Lower Range Value (LRV) and an Upper Range
Value (URV).

User Defined Varia-
ble(1)

USER(2) A variable associated with a selected register in the device.
Refer to Table C-5 for a list of suitable register variables.

(1) Only for transmitters ordered with Smart Diagnostics Suite (option code DA1).

(2) Default, user selectable display text (up to five characters).

6.2 Set up the LCD display
It is possible to specify the variables to be presented on the optional LCD display.

6.2.1 Use Rosemount Radar Master Plus
1. Under Configure, select Device Setup, and then select the Display tab.

2. Select the desired variables to be displayed on the LCD display.

3. Select Save.

6.2.2 Use AMS Device Manager and Field Communicator
1. Select Configure > Manual Setup > Device Setup > Display.

2. Select the desired variables to be displayed on the LCD display.

3. Select Send.

6.3 View measurement data
Measurement values can be viewed using Rosemount Radar Master Plus, AMS Device
Manager, Field Communicator, or other communicator.

6.3.1 Use Rosemount Radar Master Plus
Current measurement data of the primary variables are presented on the Overview screen
together with a graphical representation of the tank.

Select All Variables to view a complete list of all variables within the transmitter.
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Rosemount Radar Master Plus - Overview ScreenFigure 6-3:   

6.3.2 Use AMS Device Manager and Field Communicator
Current measurement data of the primary variables are presented on the Overview screen.
To view all current measurement values, do the following:

1. Select Service Tools Variables.

2. Select Mapped Variable, Process, Device, or Signal Quality.

6.3.3 Interpret measurement status
A “Good” or “Bad” status next to a value is an indication of the reliability or integrity of the
data being received, not an indication of whether or not the value is within the configured
upper or lower ranges. A value that triggers an alert, such as a high or low temperature
indication, will change the overall status of the device, but the measurement might still be
indicated as “Good” if the reliability of the data is good.
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AMS Device Manager - Status IndicatorsFigure 6-4:   

6.4 Device status
The overall device status is presented under the Overview screen in Rosemount Radar
Master Plus, AMS Device Manager, and Field Communicator. The transmitter reports
diagnostic alerts when there is a device malfunction. For information on these alerts, see 
Section 7.2.

The device can also be configured to report user defined alerts based on the measured
variables, see Section C.4.3 for more information.

6.4.1 Check device status
Follow this procedure to check device status and see whether there are any active alerts
reported.

1. Go to the Overview screen to view the overall device status.

2. If status is anything than Good, click the button in the device status image to open a
window with active alerts. The different device status images are shown in Table 6-2
and Table 6-3.

Active Alerts can also be obtained via Service Tools > Alerts.
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Presentation of Device Status Images as per NAMUR NE 107 - AMS Device ManagerTable 6-2:   

Device status image Category Description Action

 

Good No active alert. N/A

 

Failure At least one Failure alert is ac-
tive.

Click the Troubleshoot button to
open a window with active alerts to-
gether with recommended actions.

 

Function
Check

At least one Function Check
alert is active (and no Failure
alerts).

Click the Investigate button to open
a window with active alerts togeth-
er with recommended actions.

 

Out of Specifi-
cation

At least one Out of Specifica-
tion alert is active (and no
Failure or Function Check
alerts).

 

Maintenance
Required

At least one Maintenance Re-
quired alert is active (and no
Failure, Function Check, or
Out of Specification alerts).

Presentation of Device Status Images as per NAMUR NE 107 - Rosemount Radar Master PlusTable 6-3:   

Device status image Category Description Action

 

Good No active alert. N/A

 

Failure At least one Failure alert is ac-
tive.

Click the device status image to
open a window with active alerts to-
gether with recommended actions.

 

Function Check At least one Function Check
alert is active (and no Failure
alerts).
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Presentation of Device Status Images as per NAMUR NE 107 - Rosemount Radar Master Plus
(continued)
Table 6-3:   

Device status image Category Description Action

 

Out of Specifi-
cation

At least one Out of Specifica-
tion alert is active (and no
Failure or Function Check
alerts).

 

Maintenance
Required

At least one Maintenance Re-
quired alert is active (and no
Failure, Function Check, or
Out of Specification alerts).
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7 Service and Troubleshooting

7.1 Safety messages
Instructions and procedures in this section may require special precautions to ensure the
safety of the personnel performing the operations. Information that potentially raises
safety issues is indicated by a warning symbol ( ). Refer to the following safety messages
before performing an operation preceded by this symbol.

WARNING!

Failure to follow safe installation and servicing guidelines could result in death or serious
injury.

• Make sure the transmitter is installed by qualified personnel and in accordance with
applicable code of practice.

• Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.

Explosions could result in death or serious injury.

• Verify that the operating atmosphere of the transmitter is consistent with the
appropriate hazardous locations certifications.

• Before connecting a Field Communicator in an explosive atmosphere, ensure the
instruments are installed in accordance with intrinsically safe or non-incendive field
wiring practices.

• In Explosion-proof/Flameproof and Non-Incendive/Type n installations, do not remove
the transmitter covers when power is applied to the unit.

• Both transmitter covers must be fully engaged to meet Explosion-proof/Flameproof
requirements.

Process leaks could result in death or serious injury.

• Make sure that the transmitter is handled carefully. If the process seal is damaged, gas
might escape from the tank.

Electrical shock could cause death or serious injury.

• Avoid contact with the leads and terminals. High voltage that may be present on leads
can cause electrical shock.

• Make sure the mains power to the transmitter is off and the lines to any other external
power source are disconnected or not powered while wiring the transmitter.

7.2 Diagnostic messages
Diagnostic messages per NAMUR NE 107 are listed in Table 7-1 to Table 7-5.
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Status - Failed Table 7-1:   

LCD display
message

Host diagnostic mes-
sage Description Recommended actions

ELEC FAILUR Electronics Failure,
Transmitter

An electronics error has occurred.

 

The device measurement reading is
invalid.

1. Restart the device.
2. If the condition persists, replace

the device.

ELEC FAILUR Electronics Failure, Sen-
sor Module

An electronics error has occurred.

 

The device measurement reading is
invalid.

1. Restart the device.
2. If the condition persists, replace

the device.

MEMRY FAILUR Device Memory Failure A device memory error has occur-
red.

 

The device measurement reading is
invalid.

1. Restore default settings, restart
device, and reconfigure the de-
vice.

2. If the condition persists, replace
the device.

SIGNL FAILUR Radar Signal Failure The received radar signal is invalid
resulting in an invalid device meas-
urement reading.

1. Clean the antenna.
2. If the condition persists, replace

the device.

START FAILUR Startup Failure Device repeatedly failed to start up
with user configuration settings.

 

The device measurement reading is
invalid.

1. Check supply voltage is within
range and restart device.

2. Restore default settings, restart
device, and reconfigure the de-
vice.

3. If the condition persists, replace
the device.

SW ERROR Software Error The software in the device encoun-
tered a problem and stopped run-
ning which may cause an invalid
measurement reading.

 

In some cases, problems may be
caused by temporary environmen-
tal conditions (e.g. electromagnetic
interferences) and not observed
again.

1. Restart the device.
2. Restore default settings and re-

configure the device.
3. If the condition persists, replace

the device.
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Status - Failed (continued)Table 7-1:   

LCD display
message

Host diagnostic mes-
sage Description Recommended actions

MEAS

FAILUR

Level Measurement Lost No valid level reading. Reasons may
be multiple:
• No valid surface echo peak in

the measuring range.
• Incorrect device configuration.

1. Analyze the Echo Curve at time
of loss for reason and check de-
vice configuration, especially
thresholds.

2. Check device physical installa-
tion (for instance antenna con-
tamination).

3. Consider increasing Measure-
ment Recovery Time parameter
for intermittent conditions.

4. Restart the device.
5. Restore default settings and re-

configure the device.
6. If the condition persists, replace

the device.

CONFG ERROR Configuration Error The device has detected a configu-
ration error. Reasons may be multi-
ple (see Table 7-2 for details).

1. Click the Details button for
more information.

2. Correct the parameter causing
the error.

Configuration Error DetailsTable 7-2:   

Host diagnostic message Description Recommended actions

Volume Configuration Error The volume cannot be calculated correctly
with the current configuration.

1. If strapping table is used, check that
level-volume values are entered in in-
creasing order.

2. If strapping table is used, check that
number of strapping points to use is
correct.

3. If tank dimensions are used for volume,
check that geometry shape and size
measures are correct.

4. If condition persists, restore default
settings and reconfigure the device.

Scaled Variable Configura-
tion Error

The Scaled Variable configuration is incor-
rect.

1. Check that the value pairs in the scaled
variable table are entered in increasing
order.

2. Check the number of table points to
use is correct.

3. If condition persists, restore default
settings, and reconfigure the device.

Geometry Configuration Er-
ror

The configured tank geometry results in a
too large level measuring range for this de-
vice.

1. Check tank geometry configuration
and reduce Reference Height.

2. If condition persists, restore default
settings and reconfigure the device.
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Configuration Error Details (continued)Table 7-2:   

Host diagnostic message Description Recommended actions

Primary Variable Configura-
tion Error

The Primary Variable selection is not sup-
ported.

Note
Rosemount 5408:SIS only supports level or
distance as Primary Variable.

1. Change Primary Variable to variable
supported by device.

2. Consider purchasing an upgrade of the
device to access additional variables.

Measurement Correction
Configuration Error

The factory measurement correction data
is invalid.

1. Restore default settings and reconfig-
ure the device.

2. If the condition persists, replace the
device.

Threshold Configuration Er-
ror

The surface threshold configuration is in-
correct.

1. In the threshold table, check that dis-
tance-threshold values are entered in
increasing order.

2. Check that the number of threshold
points to use is correct.

3. If condition persists, restore default
settings and reconfigure the device.

Factory Approval Error The Sensor Module factory approval is
missing.

1. Restart the device.
2. Restore default settings and reconfig-

ure device.
3. If the condition persists, replace the

device.

The Transmitter factory approval is miss-
ing.

SIS Configuration Error It is currently not possible to enable Safety
Mode due to other active alerts.

Note
Rosemount 5408:SIS only supports liquids
level measurement when operating in
Safety (SIS) mode.

1. Clear other active alerts by priority or-
der until this alert is cleared.

2. Change Operational Mode to Control/
Monitoring if device is not intended to
be used as safety device.

3. If the condition persists, restore default
settings and reconfigure device.

Function Not Supported Functionality in the device is enabled, but
not supported by this device.

 

Additional features may be enabled by pur-
chasing an upgrade of the device.

1. Check that selections for variables (e.g.
Primary Variable) are supported by this
device.

2. Turn off functionality not supported by
this device.

3. Consider purchasing an upgrade of the
device to access additional variables
and functionality.

4. If condition persists, restore default
settings and reconfigure device.

Antenna Type Configuration
Error

The configured Antenna Type is not sup-
ported by the device.

1. Check configuration of Antenna Type.
2. Make sure the configured antenna type

matches the physical antenna for the
device.
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Configuration Error Details (continued)Table 7-2:   

Host diagnostic message Description Recommended actions

Factory Calibration Error The factory calibration in the device is
missing.

• Replace the device.

Analog Out Span Configura-
tion Error

The span for the configured analog out
range is too small.

• Increase analog out span by adjusting
Upper or Lower Range Value.

Analog Out Calibration Error Analog output calibration failed. 1. Try calibrating the analog output
again.

2. If the condition persists, replace the
device.

SIS Multidrop Error HART multidrop mode is not supported for
safety (SIS) devices. Only 4-20 mA output
is supported for safety devices.

1. Disable multidrop mode.
2. Change Operational Mode to Control/

Monitoring if device is not intended to
be used as safety device.

3. If the condition persists, restore default
settings and reconfigure device.

Engineering Unit Configura-
tion Error

One of the configured engineering units is
not supported by the device.

1. Check unit configuration.
2. If condition persists, restore default

settings and reconfigure device.

Burst Mode Configuration Er-
ror

The burst mode configuration is incorrect. 1. Check configuration of burst mode.
2. If condition persists, restore default

settings and reconfigure device.

Start Code Configuration Er-
ror

The start code to enable options in the de-
vice is invalid.

Note
Start codes are unique for individual devi-
ces and cannot be copied from one device
to another.

1. Enter a valid start code for this device
using the Upgrade function.

2. If condition persists, contact your local
Emerson representative to get a valid
start code.

Status - Function Check Table 7-3:   

LCD display
message

Host diagnostic mes-
sage Description Recommended actions

SAFE

DISBLD

Safety Mode Not Activa-
ted

Safety Mode is disabled and device
is in alarm mode.

 

This device is configured for use in
Safety Instrumented Systems (SIS)
which requires Safety Mode to be
enabled.

1. Change Safety Mode to Enabled
for use in SIS application.

2. Change Operational Mode to
Control/Monitoring if device is
not intended to be used as safe-
ty device.
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Status - Function Check (continued)Table 7-3:   

LCD display
message

Host diagnostic mes-
sage Description Recommended actions

SIMUL ACTIVE Simulation/Test Active The device is in simulation or test
mode and is not reporting actual in-
formation.

1. If this behavior is not desired,
stop simulation or test mode.

2. If the condition persists, restart
device.

Status - Out of Specification Table 7-4:   

LCD display
message

Host diagnostic mes-
sage Description Recommended actions

TEMP LIMITS Electronics Temperature
Out of Limits

The temperature of the electronics
board has exceeded the transmit-
ter’s operating range.

1. Verify ambient temperature is
within the operating range.

2. Remote mount the transmitter
away from the process and envi-
ronmental conditions.

Status - Maintenance RequiredTable 7-5:   

LCD display
message

Host diagnostic mes-
sage Description Recommended actions

SUPLY LOW Supply Voltage Low The supply voltage is low and may
affect device operation.

• Check supply voltage is within
range.

LOW

SIG Q

Low Signal Quality The Signal Quality is below the de-
fined alert limit.

1. Take action based on your in-
tended use of this alert.

2. Clean the antenna.
3. If no actions were necessary,

consider to change the limit.

HIGH ALERT High User Defined Alert The user defined variable is above
the defined limit.

1. Bring the system to a safe state.
2. Verify that the process variable

is within specified limits.
3. Reconfirm the user defined

alarm limit.
4. If not needed, disable this alert.

LOW ALERT Low User Defined Alert The user defined variable is below
the defined limit.

1. Bring the system to a safe state.
2. Verify that the process variable

is within specified limits.
3. Reconfirm the user defined

alarm limit.
4. If not needed, disable this alert.
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Status - Maintenance Required (continued)Table 7-5:   

LCD display
message

Host diagnostic mes-
sage Description Recommended actions

VAR OUTRNG Linearized Variable Out
of Range

The level measurement is outside
the configured range for volume or
scaled variable, or both.

 

Accuracy of volume/scaled variable
measurement may be degraded.

1. If volume strapping table is
used, make sure level values
within operating range are in-
cluded.

2. If scaled variable table is used,
make sure input variable values
within operating range are in-
cluded.

DC DEGRAD Dielectric Constant Esti-
mation Degraded

The dielectric constant estimation is
degraded.

 

Accuracy of level measurement
may be degraded.

1. Check configuration of Bottom
Product Dielectric Constant.

2. Check configuration of Refer-
ence Height and Bottom Offset.

3. If not needed, disable Tank Bot-
tom Projection.

7.3 Troubleshooting guide
If there is a malfunction despite the absence of alerts, Table 7-6 see and Table 7-7 for
information on possible causes and recommended actions.

The troubleshooting guide contains the following symptoms:

• Incorrect level readings (see Table 7-6)

• Troubleshooting the 4-20 mA/HART output (see Table 7-7)

Incorrect Level ReadingsTable 7-6:   

Symptom (1) Possible causes Recommended actions

Reported level is too high or low.

Le
ve

l

Time

 

Incorrect tank geometry con-
figuration.

• Verify the tank geometry parameters
are configured correctly (especially the
Reference Height).

• Run Verify Level to adjust level meas-
urement, see Section 5.7.

• Analyze the echo curve and check am-
plitude thresholds, see 
Amplitude thresholds.

• Restore default settings and reconfig-
ure the device.

Level is stuck in measuring range. Incorrect alignment of the
transmitter.

• Verify the transmitter head is correctly
aligned, see Section 3.5.7.
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Incorrect Level Readings (continued)Table 7-6:   

Symptom (1) Possible causes Recommended actions

Le
ve

l

Time

 

Disturbing objects in the
tank.

• Use the suppress false echoes function
to manage strong disturbance echoes,
see Suppressing false echoes.

• Analyze the echo curve and check am-
plitude thresholds, see 
Amplitude thresholds.

• Remove the disturbing object.
• Change alignment of transmitter head

in steps of about 15 degrees, see 
Section 3.5.7. After each step, check if
impact of disturbing echoes is de-
creased using the echo curve.

• Put an inclined metal plate on top of
the disturbing object.

• Move the transmitter to another posi-
tion. Refer to Section 3.3 for installation
considerations.

Level is stuck in full tank.

Le
ve

l

Time

 

Disturbing objects near the
antenna.

• Use the suppress false echoes function
to manage strong disturbance echoes,
see Suppressing false echoes.

• Analyze the echo curve and check am-
plitude thresholds, see 
Amplitude thresholds.

• For process seal antenna installed in a
nozzle taller than 10-in. (25 cm), adjust
the pre-configured amplitude thresh-
old, see Section 7.5.1.

• Increase the Upper Null Zone, see 
Section 7.5.1.

• Remove the disturbing object.
• Move the transmitter to another posi-

tion. Refer to Section 3.3 for installation
considerations.

Product build-up on the an-
tenna.

• Clean the antenna.
• Use transmitter with air purging con-

nection.

Cone antenna does not ex-
tend below the nozzle.

Use the extended cone antenna.
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Incorrect Level Readings (continued)Table 7-6:   

Symptom (1) Possible causes Recommended actions

Level value drops to a lower value when
product surface is close to antenna.

Le
ve

l

Time

 

Product surface is within the
Upper Null Zone and a dis-
turbance echo is interpreted
as the product surface.

Check the setting of the Upper Null Zone,
see Upper null zone.

Measured value jumps to a lower value.

Le
ve

l

Time

 

Multiple products in the tank,
e.g. thin oil layer on top of
water that is sometimes de-
tected, sometimes not.

Set Double Surface Handling to Track Up-
per Surface or Track Lower Surface, see 
Double surface handling.

Measured level fluctuates.

Le
ve

l

Time

 

Excessive foaming or turbu-
lence.

• Under turbulent conditions with low
level rates, consider increasing the
Damping value, see Damping value.

• Enable the Foam parameter or Turbu-
lent Surface parameter, or both. See 
Process conditions.

• If two surfaces are seen in foamy appli-
cations, set Double Surface Handling to
Track Lower Surface. See 
Double surface handling.
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Incorrect Level Readings (continued)Table 7-6:   

Symptom (1) Possible causes Recommended actions

Measured level is occasionally unstable.
Le

ve
l

Time

 

May be caused by an empty
tank with the amplitude
threshold set too low.

Analyze the echo curve and check ampli-
tude thresholds, see Amplitude thresholds.

The product surface is close
to a suppressed false echo.

If possible, remove the disturbing object.

Measured level lags during rapid level
changes.

Le
ve

l

Time

 

Damping value too high. If there is a problem with lag during rapid
level changes, consider decreasing the
Damping value, see Damping value.

Maximum Level Rate value
too low.

Verify Maximum Level Rate configuration.

Incorrect level when using still pipe.

Le
ve

l

Time

 

Device is not configured for
still pipe measurement.

Enable pipe measurement, see 
Mounting type.

Incorrect Pipe Inner Diameter
configuration.

Verify the configured Pipe Inner Diameter
matches the physical inner diameter.

Ghost echo problems below
the product surface.

Enable the Track First Echo function, see 
Section 7.5.3 .
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Incorrect Level Readings (continued)Table 7-6:   

Symptom (1) Possible causes Recommended actions

Measured level is correct at 0% (4 mA) but
incorrect at 100% (20 mA).

Le
ve

l

Time

 

Upper Range Value is not set
correctly.

Check that the Upper Range Value match-
es the 100% (20 mA) level in the tank.

Incorrect level when the product surface is
above the 50% level.

Le
ve

l

Time

 

Strong double bounce echo
that is interpreted as the
product surface.

Enable the Double Bounce Handling func-
tion, see Section 7.5.4.

Measured value drops to zero level.

Le
ve

l

Time

 

Transmitter has locked on a
strong tank bottom echo.

• Verify the Reference Height is config-
ured correctly.

• Enable the Tank Bottom Projection
function, see 
Use tank bottom projection.

• Enable the Bottom echo visible when
tank is empty parameter, see 
Enable bottom echo visible when tank is
empty.
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Incorrect Level Readings (continued)Table 7-6:   

Symptom (1) Possible causes Recommended actions

When the product surface is near the slop-
ed tank bottom, the transmitter enters
alarm mode.

Le
ve

l

Time
 

Reduction of projected sur-
face area close to sloping
tank bottom.

• Verify the tank geometry parameters
are configured correctly (especially the
Reference Height and Bottom Offset).

• If measurement in this region is not
crucial, increase the Empty Tank Detec-
tion Area, see Empty tank handling.

• Verify the Bottom echo visible when
tank is empty parameter is disabled,
see 
Enable bottom echo visible when tank is
empty.

(1)  = actual level  = reported level

Troubleshooting the 4-20 mA/HART OutputTable 7-7:   

Symptom Recommended actions

Transmitter milliamp reading is zero. • Verify power is applied to signal terminals.
• Verify power supply voltage is adequate at signal terminals,

see Section 4.4.
• Verify transmitter and power supply are properly grounded.

Transmitter milliamp reading is too low or high. • Verify level.
• Check the settings of the 4-20 mA range values, see 

Upper/lower range value.
• Verify output is not in alarm condition.
• Check that power wires are connected to the correct signal

terminals.
• Perform Calibrate Analog Out, see Section 7.4.5.

Milliamp reading is erratic. • Verify power supply voltage is adequate at signal terminals,
see Section 4.4.

• Check for external electrical interference.
• Verify transmitter is properly grounded.
• Verify shield for twisted pair is only grounded at the power

supply end.
• Under turbulent conditions with low level rates, consider in-

creasing the Damping value.

Transmitter will not respond to changes in level. • Verify level is between the 4 and 20 mA set points.
• Verify output is not in alarm condition.
• Verify transmitter is not in loop test or simulation mode.
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Troubleshooting the 4-20 mA/HART Output (continued)Table 7-7:   

Symptom Recommended actions

There is no HART communication (lost device com-
munication).

• Verify power supply voltage is adequate at signal terminals,
see Section 4.4.

• Check load resistance (250 ohms minimum).
• Check if transmitter is at an alternate HART address.
• Check current analog output value to verify that transmitter

hardware works.
• Verify the blue plug is attached to the TEST terminal (if appli-

cable). When unplugged, HART communication to configura-
tion tool may be compromised.

7.4 Service and troubleshooting tools
This section briefly describes tools and functions in the Rosemount Radar Master Plus, AMS
Device Manager, and Field Communicator, which may be useful for service and
troubleshooting of the Rosemount 5408 and 5408:SIS Level Transmitters.

7.4.1 Using the echo curve
The Rosemount Radar Master Plus software includes functions for viewing and recording
single instances or movies of the echo curve. The echo curve represents the tank, as seen
by the radar transmitter. Each peak corresponds to a strong reflection of the radar signal.

When connected to Rosemount Radar Master Plus, past measurement records and echo
curves including the 10 highest peaks, as well as the 50 last alert events are automatically
transferred from the transmitter’s internal memory to the hard drive on your local
computer. Past measurement records are then available the next time you connect to the
transmitter using the level trend timeline.
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Echo CurveFigure 7-1:   

Measurement problems can be understood by studying the position and amplitude of the
different peaks. Additionally, the recorded echo curves give insight into unexpected and
intermittent measurement behaviors, for instance, at the time of the triggered alert.

Read the echo curve
To read the echo curve in Rosemount Radar Master Plus:

1. Under Service Tools, select Echo Curve. Rosemount Radar Master Plus reads one echo
curve and then stops.

2. To continuously update the echo curve, select the Play icon.

Analyzing the echo curve

The following echo peaks may appear in the echo curve:

Echo Peak TypesTable 7-8:   

Type Description

Surface Echo tracked as the current surface echo

Unknown Echo not recognized by the device, which might interfere with meas-
urement

Suppressed Echoes that are identified but suppressed by the device

Suppressed (double
bounce)

Echo managed as a double bounce echo by the Double Bounce func-
tion
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Echo Peak Types (continued)Table 7-8:   

Type Description

Secondary surface Echo tracked as the current secondary surface (if Double Surface Han-
dling function is enabled)

Tank bottom echo Echo considered as an echo from the tank bottom

Echo Curve with Typical Echo PeaksFigure 7-2:   

A. Suppressed (dashed line indicates use of false echo suppression)
B. False echo suppression
C. Unknown
D. Amplitude threshold
E. Surface

View level trends and historical echo curves
• To go to a desired point in the displayed part of the timeline, drag the slider, or click

anywhere in the timeline.

• To move the timeline forward or backward, click the left or right arrow, or drag
anywhere in the timeline.

Tip
To speed up the upload time of historical data in a specific area, click or drag the slider to the
desired start point on the timeline. Rosemount Radar Master Plus continues to load data from
that point forward.
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View active/historical alerts

In the timeline, click the left or right arrow to scroll to the alert, and then select the alert
icon for details.

Level Trend TimelineFigure 7-3:   

A. Play or pause
B. Left arrow
C. Timeline slider
D. History alert icon
E. Drag anywhere in the timeline to move the timeline forward or backward.
F. Right arrow
G. Export echo curves
H. Options

Play echo curve movies
1. Set the start point.

a. Click the left or right arrow, or drag anywhere in the timeline.

b. Click the start point in the timeline.

2. Select Play, or drag the timeline slider to move one frame at a time.

Export echo curve movies
1. Under Service Tools, select Echo Curve.

2. Select Export.

3. Type your desired file name.

4. Browse to the desired directory, and then select Save.

5. Under Time range, select Last 1 hour, Last 3 hours, Last 24 hours, or User defined
range.

6. If User defined range is selected, specify the start and end times.

7. Select Export.

8. Select Back.
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Set echo curve range
1. Under Service Tools, select Echo Curve.

2. Select Options.

3. Under Echo Curve Range, select User Defined.

4. Enter the desired values.

5. Select Save.

6. Select Back.

Set timeline resolution
To set the resolution of the level trend timeline:

1. Under Service Tools, select Echo Curve.

2. Select Options.

3. In the Timeline Resolution list, select the desired length (in hours) of the timeline.

4. Select Save.

5. Select Back.

7.4.2 Managing disturbance echoes
There are two general methods for managing disturbance echoes:

• Set amplitude thresholds to filter out weak disturbance echoes and noise.

• Use the suppress false echoes function to manage strong disturbance echoes.

Amplitude thresholds

The amplitude thresholds are used to filter out noise and disturbing echoes from the
product surface echo. The transmitter uses certain criteria to decide which type of echo
peak that is detected. Only echoes above the amplitude threshold might be considered
the product surface. The amplitude threshold can either be set to a constant value, or split
into sections as defined by up to 10 anchor points.
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If necessary, a customized amplitude threshold section can for instance be used to remove
the influence from the tank nozzle, or disturbances close to the tank bottom. Additionally,
it might be needed in areas where there are occasionally strong echoes present, for
instance due to wide mixer blades. Suppressing false echoes may not be sufficient in those
areas.

Note
Do not create a customized amplitude threshold section around echoes which are already registered
as false echoes.

General recommendations

Use the following best practices to apply custom threshold adjustments:

• Generally, set amplitude threshold to about 10% of surface echo amplitude.

• Do not set the amplitude threshold to less than 150 mV (50 mV for solids
measurements) (1).

Adjust the threshold value

Prerequisites

It is recommended to adjust thresholds using Rosemount Radar Master Plus.

Procedure

1. In Rosemount Radar Master Plus, under Service Tools, select Echo Curve.

2. In the echo curve, drag the amplitude threshold point left or right, or type the
desired value (Figure 7-4).

3. Select Save.

(1) If required in solids applications with weak surface echoes, the amplitude threshold can be set down to 50 mV, as long as it is greater than
the disturbance echoes.
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Amplitude Threshold PointFigure 7-4:   

A. Amplitude threshold point

Set the endpoint of a threshold segment

1. In the echo curve, drag the endpoint up or down, or type the desired value
(Figure 7-5).

2. Select Save.

EndpointFigure 7-5:   

A. Endpoint
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Add or delete an amplitude threshold point

1. In the echo curve, select the desired amplitude threshold point, and select Split
threshold or Merge with threshold below.

2. Click again on one of the amplitude threshold points and select Save.

Suppressing false echoes

Stationary objects with horizontal surfaces may generate strong false echoes. When the
surface is close to an obstruction in the tank (e.g. beams and agitators), the surface and
false echoes might interfere and cause a decrease in performance.

However, false echoes can be suppressed to reduce the influence of such objects, in case
they cannot be totally avoided. When the surface is passing by a disturbing object, the
transmitter will then measure with higher reliability, even if the surface echo is weaker
than the false echo, see Figure 7-6.

Suppression of False EchoesFigure 7-6:   

A. Amplitude threshold
B. Disturbing object
C. False echo suppression
D. Suppressed echo
E. Surface
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Add a new false echo suppression

Prerequisites

Follow these recommendations before suppressing new false echoes:

• Make sure a correct amplitude threshold is set (see Amplitude thresholds).

• Make sure the level is stable. A fluctuating level may indicate a temporary
disturbance which is not due to an interfering object.

• Only suppress echoes which can be clearly identified as objects in the tank. Compare
the list of interfering echoes with the tank drawing or visual inspection of the tank.

• Do not suppress false echoes located below the product surface.

• Keep the number of suppressed false echoes to a minimum.

It may be necessary to suppress new false echoes at a later stage when objects have
become visible due to surface movement.

Procedure

1. In Rosemount Radar Master Plus, under Service Tools, select Echo Curve.

2. In the echo curve, click  at the unknown echo peak, and then select Suppress.

Add False Echo SuppressionFigure 7-7:   

Delete a false echo suppression

1. In Rosemount Radar Master Plus, under Service Tools, select Echo Curve.
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2. In the echo curve, click  at the left end of the false echo suppression, and then
select Delete.

Delete False Echo SuppressionFigure 7-8:   

Suppress a false echo manually

The false echo may also be suppressed manually if the position of the false echo is known.

Procedure

1. In Rosemount Radar Master Plus, under Service Tools, select Echo Curve.

2. Select Options.

3. Select Suppress False Echo Manually. Suppressed echoes are shown in the table.

• To add a new suppression, select Add, and then type the distance to the false
echo and the width of the false echo area.

• To change a suppression, select the cell you want change and type the new
value.

• To delete a suppression, select the row you want to delete, and then select
Delete.

4. Select Save.

5. Select Back.
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Suppress false echoes using AMS Device Manager

1. Select Service Tools Echo Tuning Suppress. Suppressed echoes are shown in the
table.

2. Select Suppress or Remove Suppression.

3. Type the distance to the echo that should be added to or removed from the list, and
then select Next.

4. Select Finish when the Method Complete message appears.

Suppress false echoes using Field Communicator

1. Select Service Tools > Echo Tuning > Suppress.

2. To view the current suppressed echoes, select Suppressed Echoes.

3. Select Suppress or Remove Suppression.

4. Type the distance to the echo that should be added to or removed from the list, and
then select Enter.

7.4.3 Perform an analog loop test
During a loop test, the transmitter outputs a fixed value (4 mA, 20 mA, or user-selected
value). The loop test command verifies the output of the transmitter, the integrity of the
loop, and the operations of any recorders or similar devices installed in the loop. A loop
test can also be used to determine the need for an analog output calibration (see 
Section 7.4.5).

If the transmitter is equipped with a TEST terminal, current can be measured directly at the
terminal block without disconnecting any signal wires. See Section 7.4.4.

Use Rosemount Radar Master Plus
1. Under Service Tools, select Simulate.

2. Select Loop Test.

3. Select 4 mA, 20 mA, or Other.

4. If Other is selected, enter the desired value.

5. Select Start.

6. Measure the loop current.

7. Select Stop to end loop test.

Use AMS Device Manager and Field Communicator
1. Select Service Tools > Simulate.

2. Under Analog Out, select Loop test.

3. Select 4mA, 20mA, or Other, and then select Next (Enter on Field Communicator).

4. If Other is selected, enter the desired value, and then select Next (Enter on Field
Communicator).
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5. Measure the loop current.

6. To end loop test, select Cancel (ABORT on Field Communicator).

7.4.4 Use the TEST terminal

WARNING!

Verify that the installation is consistent with the appropriate hazardous locations certifications
when the instrument used for loop current measurement is connected.

For Explosion-proof/Flameproof and Non-Incendive/Type n installations, the cover must not be
opened in an explosive atmosphere.

Note
Blue plug must only be disconnected during loop current measurement procedure. To meet the
stated EMC specification during normal operation, the blue plug must be plugged in.

Procedure

1. Turn the jam screw clockwise until it is completely threaded into the housing.

H2.5 mm

2. Remove the cover.

3. Remove the blue plug from the TEST terminal.
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4. Connect the ampere meter leads to the terminals labeled “+” and “TEST”.

5. Measure the loop current.

6. Attach the blue plug to the TEST terminal.

7. Attach and tighten the covers. Make sure the covers are fully engaged.

a. Verify the cover jam screws are completely threaded into the housing.

Cover jam screw
(one per side)

H2.5 mm

b. Attach and tighten the covers.
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c. Turn the jam screw counterclockwise until it contacts the cover.

 Required for explosion-proof/flameproof installations only.

d. Turn the jam screw an additional ½ turn counterclockwise to secure the cover.

7.4.5 Calibrate analog out
Use this function to calibrate the analog output by comparing the actual output current
with the nominal 4 mA and 20 mA currents. Calibration is done at factory and the analog
output does not normally need to be recalibrated.

Use Rosemount Radar Master Plus
1. Under Service Tools, select Maintenance > Routine Maintenance.

2. Select Calibrate Analog Out and follow the on-screen instructions.

AMS Device Manager and Field Communicator

Use AMS Device Manager and Field Communicator
1. Select Service Tools > Maintenance > Routine Maintenance.

2. Select D/A trim and follow the on-screen instructions.

7.4.6 Save a backup file of the device configuration
When configuration is finished, it is recommended to store the device configuration in a
backup file for future reference using Rosemount Radar Master Plus. A backup of the
device configuration will be saved to file as well as a configuration report (optional).
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The backup file may be useful to:

• Restore the configuration of the transmitter.

• Install another transmitter in a similar tank.

• Troubleshoot the transmitter.

Procedure

1. In Rosemount Radar Master Plus, under Service Tools, select Maintenance Backup.

2. Select Save Configuration.

3. Type your desired file name.

4. Browse to the desired directory, and then select Save.

5. (Optional) Select the Create and save report (.pdf) check box.

6. Select Save.

7.4.7 Download configuration from file to device
1. In Rosemount Radar Master Plus, under Service Tools, select Maintenance Backup.

2. Select Restore Configuration.

3. Browse to the backup file and select Open.

7.4.8 Restore to default settings
This function restores the transmitter to default settings (user configuration is
overwritten).

Prerequisites

Before restoring the transmitter to default settings, it is recommended to backup the
device configuration, see Section 7.4.6. The backup file can be used to restore
configuration at a later stage.

Use Rosemount Radar Master Plus
1. Under Service Tools, select Maintenance > Reset/Restore.

2. Select Restore Default Settings.

Use AMS Device Manager and Field Communicator
1. Select Service Tools > Maintenance > Reset/Restore.

2. Select Restore Default Settings and follow the on-screen instructions.

7.4.9 Use the simulation mode
This function can be used to simulate measurements.
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Use Rosemount Radar Master Plus
1. Under Service Tools, select Simulate.

2. Select Simulate next to desired transmitter variable and follow the on-screen
instructions.

Use AMS Device Manager and Field Communicator
1. Select Service Tools > Simulate.

2. Under Simulate Measurement Values, select desired transmitter variable and follow
the on-screen instructions.

7.4.10 View input registers
Measured data is continuously stored in the input registers. By viewing the contents of the
input registers, expert users can check that the transmitter works properly.

Use Rosemount Radar Master Plus
1. Under Configure, select Level Setup > Advanced.

2. Under More Advanced Options, select Expert Options.

3. Select the Input Registers tab.

4. Under Show registers by, do one of the following:

• Select Block, and then in the list, select the desired register group.

• Select Number, and then type the desired register number and the number of
registers.

Use AMS Device Manager and Field Communicator
1. Select Configure > Manual Setup > Level Setup > Advanced > Expert Options > Input

Registers.

2. Type the desired register number to start reading from.

3. Select Read Input Registers. 10 registers will be read, starting from the selected
number.

4. (Field Communicator) Select Input Registers.

7.4.11 View/edit holding registers
The holding registers store various transmitter parameters, such as configuration data,
used to control the measurement performance.

Note
Do not use holding registers to configure the transmitter unless you are qualified. This dialog is
mainly used for service purposes and for advanced configuration.
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Use Rosemount Radar Master Plus
1. Under Configure, select Level Setup > Advanced.

2. Under More Advanced Options, select Expert Options.

3. Select the Holding Registers tab.

4. Under Show registers by, do one of the following:

• Select Block, and then in the list, select the desired register group.

• Select Number, and then type the desired register number and the number of
registers.

5. Select Refresh.

6. To change a holding register value, type a new value in the corresponding value
field, or select a new value from the corresponding list.

7. Select Save to store the new value.

Use AMS Device Manager and Field Communicator
1. To view a holding register value:

a. Select Configure > Manual Setup > Level Setup > Advanced > Expert Options >
Holding Registers.

b. Type the desired register number to start reading from.

c. Select Read Holding Registers. 10 registers will be read, starting from the
selected number.

d. (Field Communicator) Select Holding Registers.

2. To edit a holding register value:

a. Select Configure > Manual Setup > Level Setup > Advanced > Expert Options >
Holding Registers.

a. Select Write Holding Register and follow the on-screen instructions.

7.4.12 Write protect a transmitter
The transmitter can be write protected (with or without a password) to prevent
unauthorized changes.

If the Rosemount 5408:SIS is configured for use in Safety (SIS) operational mode, then the
Safety Mode must be enabled for the transmitter to become operational. When Safety
Mode is enabled, the transmitter is write protected to prevent unauthorized changes.

Use Rosemount Radar Master Plus
1. Under Overview, select Device Information > Security.

2. Under Write Protection, select Change and follow the on-screen instructions.
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Use AMS Device Manager and Field Communicator
1. Select Configure > Manual Setup > Device Setup > Security.

2. Under Security, select Change Write Protection and follow the on-screen
instructions.

7.5 Application challenges

7.5.1 Handling disturbances at top of tank
There are two general methods for managing disturbance echoes at the top of the tank:

• Set amplitude threshold section

• Extend the Upper Null Zone

Set amplitude threshold section

If necessary, a customized amplitude threshold section can be used to block out disturbing
echoes (e.g. from the tank nozzle or bypass well inlet). Refer to Amplitude thresholds for
general guidelines.

Amplitude threshold sections are pre-configured at the factory for transmitters with
process seal antenna. For nozzles taller than 10 in. (25 cm), it may be necessary to
manually increase the distance value for the first endpoint (Figure 7-9).

Procedure

1. In Rosemount Radar Master Plus, start the echo curve reading, see Section 7.4.1.

2. View the echo curve plot to find out if there are disturbing echoes close to the
transmitter.

3. Calculate the required distance to the first endpoint.

Distance = Nozzle height + 2 in. (50 mm) =

4. In the echo curve, click the first endpoint and type the calculated value (Figure 7-9).

5. Select Save.
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First EndpointFigure 7-9:   

A. First endpoint

Change the upper null zone

The Upper Null Zone defines a zone close to the transmitter where echoes are ignored.
This zone can be extended to block out disturbing echoes at the top of the tank.

Note
Make sure the Upper Range Value (100%/20 mA) value is below the Upper Null Zone. Measurements
are not performed within the Upper Null Zone.
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Upper Null ZoneFigure 7-10:   

A. Upper Null Zone
B. Disturbance echo
C. Amplitude threshold
D. Product surface echo

Procedure

1. Identify desired Upper Null Zone using the echo curve plot.

a. In Rosemount Radar Master Plus, start the echo curve reading, see Section 7.4.1.

b. View the echo curve plot to find out if there are disturbing echoes close to the
transmitter.

2. Set the desired Upper Null Zone value.

a. Under Configure, select Level Setup > Antenna.

b. Under Advanced, type desired Upper Null Zone, and then select Save.

7.5.2 Tracking of weak surface echoes close to tank bottom

Use tank bottom projection

The Tank Bottom Projection function can be used to enhance measurement performance
in the tank bottom region. If the product surface echo is weak in the tank bottom region
and the bottom echo is strong (typical for flat tank bottoms), the transmitter may lock on
the bottom echo and report a false level measurement (empty tank). If the application
requires, the Tank Bottom Projection settings can be user-defined.
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Figure 7-11 illustrates an example of the Tank Bottom Projection when the tank is being
emptied.

Tank Bottom ProjectionFigure 7-11:   

Time

Enabled Disabled
Level Level

Time

Procedure

1. In Rosemount Radar Master Plus, under Configure, select Level Setup > Advanced.

2. Under More Advanced Options, select Empty Tank Handling.

3. In the Tank Bottom Projection list, select Enabled or Disabled.

4. If you enabled Tank Bottom Projection, then:

a. Set the Bottom Product Dielectric Constant.

b. Enter Maximum Projection Distance.

c. Enter Minimum Tank Bottom Echo Amplitude.

5. Select Save.

Bottom product dielectric constant

Enter the product dielectric constant for the product in the bottom of the tank.

Maximum projection distance

This defines the range in which the function operates. Enter the maximum distance from
the zero level (tank bottom). It is recommended to use the default setting.

Minimum tank bottom echo amplitude

Enter the minimum allowed amplitude for the echo from the tank bottom before this
function is activated. It is recommended to use the default setting.

Enable bottom echo visible when tank is empty

Enable the Bottom echo visible when tank is empty parameter if a bottom echo is visible
when tank is empty (i.e. for flat tank bottoms). The bottom echo will then be treated as a
disturbance echo to facilitate tracking of weak surface echoes close to the tank bottom.
This function may be useful for products which are relatively transparent for microwaves,
such as oil.
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Note
Only enable this parameter if a bottom echo is visible when tank is empty. To verify this, use the echo
curve function.

Bottom Echo VisibleFigure 7-12:   

A. Product surface near bottom of tank
B. Empty tank
C. Signal amplitude
D. Distance
E. Surface echo
F. Echo peak from tank bottom (at the electrical distance when product in the tank)

Procedure

1. In Rosemount Radar Master Plus, under Configure, select Level Setup > Advanced.

2. Under More Advanced Options, select Empty Tank Handling.

3. In the Empty Tank Handling list, select User Defined.

4. Select the Bottom echo visible when tank is empty check box.

5. Select Save.
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7.5.3 Handling ghost echoes in still pipes
Ghost echoes may occur in still pipes because of multiple reflections between the pipe
wall, flange, and antenna. In the echo curve, these echoes appear as amplitude peaks at
various distances below the product surface, see Figure 7-13. The Track First Echo function
can eliminate ghost echo problems below the product surface. When enabled, the first
echo above threshold will always be considered as the surface echo.

Ghost Echoes in Still PipesFigure 7-13:   

A. Signal amplitude
B. Actual level
C. Virtual level
D. Distance

Enable the track first echo function
1. In Rosemount Radar Master Plus, read the echo curve. Make sure there are no

disturbing echoes above the product surface. See Section 7.4.1.

2. Under Configure, select Level Setup > Advanced.

3. Under More Advanced Options, select Echo Tracking.

4. In the Surface Echo Tracking list, select User defined, and then select the Track First
Echo check box.
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5. Select Save.

7.5.4 Handling strong double bounce echoes
A double bounce echo occurs when a radar signal bounces back and forth between the
product surface and tank roof (or other object within the tank) before it is detected by the
transmitter. Normally, these signals have a low amplitude and are ignored by the
transmitter.

Double bounces are most commonly present in spherical or horizontal cylinder tanks, and
usually appear when the tank is about 60-70% filled. In these cases, the amplitude may be
strong enough for the transmitter to interpret the double bounce as the surface echo. The
Double Bounce Handling function is used for managing such problems.

Note
The Double Bounce Handling function should only be used if the problem of double bounces cannot
be solved by changing the mounting position.

Note
The surface echo is required to suppress the double bounce. If the surface echo enters the Upper Null
Zone, there is no product surface reference and the double bounce might be interpreted as the
surface echo.
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Double Bounce EchoesFigure 7-14:   

A. Distance to surface
B. Distance to first double bounce
C. Actual level
D. Virtual level (first double bounce)
E. Signal amplitude
F. Distance

Configure double bounce handling
1. In Rosemount Radar Master Plus, read the echo curve plot to determine if double

bounce echoes are present, see Section 7.4.1.

2. Under Configure, select Level Setup > Advanced.

3. Under More Advanced Options, select Echo Tracking.

4. In the Double Bounce Handling list, select Enabled or Disabled.

5. If you enabled Double Bounce Handling, then enter desired Double Bounce Offset.

6. Select Save.

Double bounce offset

The distance between each double bounce echo is constant. The Double Bounce Offset is
used to define the distance between detected double bounces, as given by the following
formula (see Figure 7-14):

Double Bounce Offset = B - 2A
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The Double Bounce Offset is negative if the reflection point (normally the tank roof) is
below the Tank Reference Point.

7.6 Replace the transmitter head
 In Explosion Proof/Flameproof and Non-Incendive/Type n installations, do not remove

the transmitter covers when power is applied to the unit.

Procedure

1. Disconnect the power supply.

2. If applicable, remove the external ground cable from the transmitter head.

3. Turn the jam screw clockwise until it is completely threaded into the housing.

H2.5 mm

4. Remove the cover.

5. Remove all electrical leads and disconnect conduit.
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6. Loosen the nut that connects the transmitter head to the process seal.

60 mm

7. Carefully lift the transmitter head.

 Do not attempt to loosen it by rotating the transmitter head. If it is stuck, then it
may need to be replaced with a new process connection and transmitter head, by
following all plant safety rules and procedures.
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8. Attach a protection plug to the process seal to protect it from dust and water.

Process seal

7.7 Cleaning or replacing the PTFE sealing
This section applies only to transmitters with a process seal antenna.

Replace the PTFE sealing if it shows any signs of damage. If it is not damaged, clean and
reuse it.

Remove from service

 Be aware of the following:

• Follow all plant safety rules and procedures.

• In Explosion Proof/Flameproof and Non-Incendive/Type n installations, do not
remove the transmitter covers when power is applied to the unit.

• Do not remove the process connection while in operation. Removing while in
operation may cause process gas leaks.
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Cleaning

To avoid electrostatic charges, use only a damp cloth to clean the PTFE surfaces. Clean the
PTFE sealing with care.

The transmitter is suitable for:

• Cleaning-Out-of-Place (COP)

• Cleaning-In-Place (CIP) up to 160 °F (71 °C)

• Steaming-In-Place (SIP) up to 275 °F (135 °C)

7.7.1 Flanged version

Disassembly procedures
1. Insert two flathead screwdrivers between the PFTE sealing and flange.

2. Gently push the screwdriver handles forward until the PTFE sealing pops out.

3. Carefully pull the PTFE sealing straight out.
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Reassembly procedures
1. Clean the cavity with a lint-free cloth.

2. Verify the O-ring on the PTFE sealing is in place.

3. Gently insert the PTFE sealing until it stops, and then firmly push it all the way in.

7.7.2 Tri Clamp version

Disassembly procedures
1. Insert a wide flathead screwdriver into the groove at the base of the PTFE sealing.

2. Gently wiggle the screwdriver back and forth.

Note
Be careful not to scratch or depress the PTFE surfaces (facing the process).
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3. Repeat Step 1-Step 2 at different positions until the PTFE sealing is loose.

4. Carefully lift the PTFE sealing.

Reassembly procedures
1. Clean the cavity with a lint-free cloth.
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2. Verify the O-ring on the PTFE sealing is in place.

3. Gently insert the PTFE sealing until it stops, and then firmly push it all the way in.

7.8 Service support
To expedite the return process outside of the United States, contact the nearest Emerson
representative.
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Within the United States, call the Emerson Instrument and Valve Response Center using
the 1-800-654-RSMT (7768) toll-free number. This center, available 24 hours a day, will
assist you with any needed information or materials.

The center will ask for product model and serial numbers, and will provide a Return
Material Authorization (RMA) number. The center will also ask for the process material to
which the product was last exposed.

CAUTION!

Individuals who handle products exposed to a hazardous substance can avoid injury if they are
informed of and understand the hazard. Returned products must include a copy of the required
Safety Data Sheet (SDS) for each substance.

Emerson Instrument and Valve Response Center representatives will explain the additional
information and procedures necessary to return goods exposed to hazardous substances.
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8 Safety Instrumented Systems (4-20
mA only)

8.1 Safety messages
Instructions and procedures in this section may require special precautions to ensure the
safety of the personnel performing the operations. Information that potentially raises
safety issues is indicated by a warning symbol ( ). Refer to the following safety messages
before performing an operation preceded by this symbol.

WARNING!

Failure to follow safe installation and servicing guidelines could result in death or serious
injury.

• Make sure only qualified personnel perform the installation.

Explosions could result in death or serious injury.

• Verify that the operating atmosphere of the transmitter is consistent with the
appropriate hazardous locations certifications.

• Before connecting a Field Communicator in an explosive atmosphere, ensure the
instruments are installed in accordance with intrinsically safe or non-incendive field
wiring practices.

• In Explosion-proof/Flameproof and Non-Incendive/Type n installations, do not remove
the transmitter covers when power is applied to the unit.

• Both transmitter covers must be fully engaged to meet Explosion-proof/Flameproof
requirements.

Electrical shock could cause death or serious injury.

• Avoid contact with the leads and terminals. High voltage that may be present on leads
can cause electrical shock.

• Make sure the mains power to the transmitter is off and the lines to any other external
power source are disconnected or not powered while wiring the transmitter.

8.2 Terms and definitions

Terms and DefinitionsTable 8-1:   

Term Definition

BPCS Basic Process Control System

λDU Dangerous Undetected
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Terms and Definitions (continued)Table 8-1:   

Term Definition

λDD Dangerous Detected

λSU Safe Undetected

λSD Safe Detected

Diagnostic cov-
erage

Fraction of dangerous failures detected by automatic on-line diagnostic tests.

Diagnostic test
interval

The time from when a dangerous failure/condition occurs until the device has set the safety related
output in a safe state (total time required for fault detection and fault reaction).

FIT Failure In Time per billion hours

FMEDA Failure Modes, Effects and Diagnostic Analysis

HART
®

Highway Addressable Remote Transducer

HFT Hardware Fault Tolerance

High demand
mode

The safety function is only performed on demand, in order to transfer the EUC (Equipment Under
Control) into a specified safe state, and where the frequency of demands is greater than one per year
(IEC 61508-4).

Low demand
mode

The safety function is only performed on demand, in order to transfer the EUC into a specified safe
state, and where the frequency of demands is no greater than one per year (IEC 61508-4).

Mission time The time from an instrumented system’s start-up until its replacement or refurbishment to as-new
condition.

PFDAVG Average Probability of Failure on Demand

Proof-test cov-
erage factor

The effectiveness of a proof-test is described using the coverage factor which specifies the share of
detected dangerous undetected failures (λDU). The coverage factor is an indication of a proof-test’s
effectiveness to detect dangerous undetected faults.

Safety deviation The maximum allowed deflection of the safety output due to a failure within the device (expressed as
a percentage of span).

Any failure causing the device output to change less than the Safety Deviation is considered as a "No
Effect" failure. All failures causing the device output to change more than the Safety Deviation and
with the device output still within the active range (non-alarm state) are considered dangerous fail-
ures.

 

Note that the Safety Deviation is independent of the normal performance specification or any addi-
tional application specific measurement error.

SFF Safe Failure Fraction

SIF Safety Instrumented Function

SIL Safety Integrity Level – a discrete level (one out of four) for specifying the safety integrity require-
ments of the safety instrumented functions to be allocated to the safety instrumented systems. SIL 4
has the highest level of safety integrity, and SIL 1 has the lowest level.

SIS Safety Instrumented System – an instrumented system used to implement one or more safety instru-
mented functions. An SIS is composed of any combination of sensors, logic solvers, and final ele-
ments.
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Terms and Definitions (continued)Table 8-1:   

Term Definition

Systematic Ca-
pability

Systematic Capability is a measure (expressed on a scale of SC 1 to SC 4) of the confidence that the
systematic safety integrity of an element meets the requirements of the specified SIL, in respect of
the specified element safety function, when the element is applied in accordance with the instruc-
tions specified in the compliant item safety manual for the element.

Transmitter re-
sponse time

The time from a step change in the process until transmitter output reaches 90% of its final steady
state value (step response time as per IEC 61298-2).

Type B device Complex device using controllers or programmable logic, as defined by the standard IEC 61508.

Useful lifetime Useful lifetime is a reliability engineering term that describes the operational time interval where the
failure rate of a device is relatively constant. It is not a term which covers product obsolescence, war-
ranty, or other commercial issues.

8.3 Safety Instrumented System (SIS) certification
For safety instrumented systems usage, the 4-20 mA analog output is used as the primary
safety variable. It is configured to activate the alarm function if an error occurs. If a
measured value goes beyond the measurement range, the transmitter enters saturation
mode.

The measurement signal used by the logic solver must be the analog 4-20 mA signal
proportional to the level or distance (ullage) generated. The HART protocol can only be
used for setup, calibration, and diagnostic purposes, not for safety critical operation.

The Rosemount™ 5408:SIS Level Transmitter is IEC 61508 certified accordingly:

• Low and high demand: Type B element

• SIL 2 for random integrity @ HFT=0

• SIL 3 for random integrity @ HFT=1

• SIL 3 for systematic capability
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SIF Configuration ExamplesFigure 8-1:   
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LT
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C

Single use 1oo1 (1-out-of-1) for SIL2
(SIL 2@ HFT=0)

Redundant use 1oo2 for SIL3
(SIL3@ HFT=1)

Redundant use 2oo3 for SIL3
(SIL3@ HFT=1)

LT

A. Rosemount 5408:SIS Level Transmitter (sensor)
B. Logic-solver
C. Actuator

Application examples

• Level range monitoring

• Dry-run prevention

• Overfill prevention

8.4 Safety certified identification
All Rosemount 5408:SIS Level Transmitters must be identified as safety certified before
installing into SIS systems.

1. Verify the transmitter model code starts with “5408F”.

2. Verify the software (SW) is 1.A3 or later.
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IdentificationFigure 8-2:   

!

MODEL 5408

FM16US0010X

SIL 2

A. Model code
B. Serial number
C. SW version
D. Yellow stripe for locating device from distance
E. Yellow tag for locating device from distance

8.5 Installation
The Rosemount 5408:SIS must be installed and configured as described in Chapter 3 and 
Chapter 4. No special installation is required in addition to the standard installation
practices outlined in this manual.

The loop should be designed so the terminal voltage is within the limits specified in section 
Section 4.4.

Check that environmental conditions do not exceed the ratings in Appendix A.

Note
The Rosemount 5408:SIS Level Transmitter is not safety-rated during maintenance work,
configuration changes, multidrop, loop test, proof-test, or other activity that affects the safety
function. Alternative means should be used to ensure process safety during such activities.
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8.5.1 Measuring range
The maximum measuring range is 82 ft. (25 m) for the Rosemount 5408:SIS Level
Transmitter in Safety (SIS) mode. Refer to Appendix A for performance specification data.

8.6 Configuration
Use a HART-compliant master, such as Rosemount Radar Master Plus, AMS Device
Manager, or a Field Communicator, to communicate with and verify configuration of the
Rosemount 5408:SIS.

8.6.1 Prerequisites
Before doing any configuration, do the following:

1. Write down the serial number from the transmitter label (see Figure 8-2).

2. Make sure you are connected to the correct transmitter by verifying the same serial
number in your configuration tool.

• Rosemount Radar Master Plus:

- Under Overview, select Device Information > Identification.

• AMS Device Manager and Field Communicator:

- Select Overview > Device Information > Identification.

8.6.2 Configure device using Guided Setup
Follow the Guided Setup wizard for transmitter configuration, refer to Chapter 5. When
configuring parameters not included in the Guided Setup, it may be necessary to do
additional verification.

8.6.3 Set operational mode
The Rosemount 5408:SIS can be used as the level sensor in a BPCS or as a safety device in a
safety instrumented system.

If the Rosemount 5408:SIS is used as safety device in a Safety Instrumented System, then
the operational mode must be set to Safety (SIS). The Safety (SIS) operational mode can be
activated via the Guided Setup wizard, or as follows:

Use Rosemount Radar Master Plus
1. Under Configure, select Device Setup Security.

2. Under Operational Mode, select Change and follow the on-screen instructions.

Use AMS Device Manager and Field Communicator
1. Select Configure > Manual Setup > Device Setup > Security.
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2. Under Safety Instrumented Systems, select Change Operational Mode and follow the
on-screen instructions.

Note
When entering the Safety (SIS) operational mode, the analog output will be put into alarm
mode until the Safety Mode is enabled.

8.6.4 Enable safety mode
If the transmitter is configured for use in Safety (SIS), then the Safety Mode must be
enabled for the transmitter to become operational. When Safety Mode is enabled, the
transmitter is write protected (with or without a password) to prevent unauthorized
changes.

Use Rosemount Radar Master Plus
1. Under Configure, select Device Setup > Security.

2. Under Safety Mode, select Change and follow the on-screen instructions.

Use AMS Device Manager and Field Communicator
1. Select Configure > Manual Setup > Device Setup > Security.

2. Under Safety Instrumented Systems, select Change Safety Mode and follow the on-
screen instructions.

8.6.5 Alarm and saturation levels
DCS or safety logic solver should be configured to handle both High alarm and Low alarm.
In addition, the transmitter must be configured for High or Low alarm (see Alarm mode).

Figure 8-3 identifies the alarm levels available and their operation values (1).

(1) Note that during startup, the Rosemount 5408:SIS always outputs Low alarm current even if the transmitter is configured for High alarm
mode.
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Alarm Levels and Operation ValuesFigure 8-3:   

Rosemount Alarm Level

Normal Operation

3.9 mA
low saturation 

4 mA 20 mA 21.75 mA(2)3.75 mA(1)

20.8 mA
high saturation 

Namur Alarm Level

Normal Operation

3.8 mA
low saturation 

4 mA 20 mA 22.5 mA(2)3.6 mA(1)

20.5 mA
high saturation 

1. Transmitter Failure, hardware or software alarm in Low position.

2. Transmitter Failure, hardware or software alarm in High position.

8.7 Site acceptance
After installation and/or configuration, proper operation of the transmitter (including
verification of all configuration changes) must be verified. A site acceptance test is
therefore recommended. The proof-tests outlined in section Section 8.8 can be used for
this.

8.8 Proof-testing

8.8.1 Overview
The Rosemount 5408:SIS Level Transmitter must be tested at regular intervals to reveal
faults which are undetected by automatic diagnostics. It is the user's responsibility to
choose the type of testing and the frequency of these tests.

Results from periodic proof-tests shall be recorded and periodically reviewed. If an error is
found in the safety functionality, the transmitter shall be put out of operation and the
process shall be kept in a safe state by other measures.

Note
For a valid result, always perform the proof-test on the product that will be stored in the tank while
the device is in operation.
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The following proof-tests are suggested:

• (A) 1-point level and analog output verification (see Section 8.8.2)

• (B) 2-point level and analog output verification (see Section 8.8.3)

• (C) Analog output verification (see Section 8.8.4)

• (D) Level deviation monitoring (see Section 8.8.5)

Table 8-2 can be used as a guidance for selecting the appropriate proof-test.

Suggested Proof-testsTable 8-2:   

Proof-
test # Type

Proof-test
coverage
(%) of DU

Remaining
dangerous,
undetected
failures

Test coverage
Can be per-
formed re-
motely

Output cir-
cuitry

Measurement
electronics Antenna

A Comprehensive 73% 21 FIT Y Y Y Y (1)

B 84% 13 FIT Y Y Y Y

C Partial 33% 53 FIT Y N N Y

D 61% 31 FIT N Y N Y

(1) With the assumption that the BPCS level sensor is used as independent measurement.

Proof-test interval

The time intervals for proof-testing are defined by the SIL verification calculation (subject
to the PFDAVG). The SIL verification calculation is an analytical method to calculate an
appropriate proof-test interval for the specific safety function based on equipment’s
reliability and required risk reduction for the specific SIF.

The proof-tests must be performed more frequently than or as frequently as specified in
the SIL verification calculation, in order to maintain the required safety integrity of the
overall SIF.

Tools required

• HART host/communicator or Rosemount Radar Master Plus

• Current meter

• Safety logic solver

• Independent measuring device (e.g. BPCS level sensor, measuring tape)

8.8.2 Perform 1-point level and analog output verification

WARNING!

During the proof-test, the transmitter will not output measurement values corresponding to
the product surface level. Make sure systems and people relying on measurement values from
the transmitter are made aware of the changed conditions. Failure to do so could result in
death, serious injury and/or property damage.
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Use Rosemount Radar Master Plus
1. Prior to the test, ensure there are no alarms or warnings present in the transmitter.

a. Under Service Tools, select Alerts.

2. Bypass the process safety function and take appropriate action to avoid a false trip.

3. Simulate 4.00 mA output and verify loop current.

a. Under Service Tools, select Simulate.

b. Select Loop Test.

c. Select 4 mA and then select Start.

d. Measure loop current (e.g. reading the safety logic solver or using the TEST
terminal, see Section 7.4.4).

Note
The inaccuracy of safety logic solver or current meter needs to be considered.

e. Verify the current deviation is within the safety deviation of 2% (±0.32 mA).

f. Select Stop to end loop test.

4. Simulate 20.00 mA output and verify loop current.

a. Under Service Tools, select Simulate.

b. Select Loop Test.

c. Select 20 mA and then select Start.

d. Measure loop current (e.g. reading the safety logic solver or using the TEST
terminal, see Section 7.4.4).

e. Verify the current deviation is within the safety deviation of 2% (±0.32 mA).

Note
The inaccuracy of safety logic solver or current meter needs to be considered.

f. Select Stop to end loop test.

5. Perform a one-point level measurement verification of the transmitter in the
measuring range. Compare with independent measurement (e.g. the BPCS level
sensor).

a. Under Overview, select All Variables.

b. Verify the current level or distance reading with an independent measurement is
within the safety deviation of 2%.

Note
The inaccuracy of the independent measurement needs to be considered.

6. Remove the bypass and otherwise restore normal operation.
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Use AMS Device Manager and Field Communicator
1. Prior to the test, ensure there are no alarms or warnings present in the transmitter.

a. Select Service Tools > Alerts.

2. Bypass the process safety function and take appropriate action to avoid a false trip.

3. Simulate 4.00 mA output and verify loop current.

a. Select Service Tools > Simulate.

b. Under Analog Out, select Loop test.

c. Select 4mA and then select Next (Enter on Field Communicator).

d. Measure loop current (e.g. reading the safety logic solver or using the TEST
terminal, see Section 7.4.4).

e. Verify the current deviation is within the safety deviation of 2% (±0.32 mA).

Note
The inaccuracy of safety logic solver or current meter needs to be considered.

f. To end loop test, select Cancel (ABORT on Field Communicator).

4. Simulate 20.00 mA output and verify loop current.

a. Select Service Tools > Simulate.

b. Under Analog Out, select Loop test.

c. Select 20mA and then select Next (Enter on Field Communicator).

d. Measure loop current (e.g. reading the safety logic solver or using the TEST
terminal, see Section 7.4.4).

e. Verify the current deviation is within the safety deviation of 2% (±0.32 mA).

Note
The inaccuracy of safety logic solver or current meter needs to be considered.

f. To end loop test, select Cancel (ABORT on Field Communicator).

5. Perform a one-point level measurement verification of the transmitter in the
measuring range. Compare with independent measurement (e.g. the BPCS level
sensor).

a. Select Service Tools > Variables > Process.

b. Verify the current level or distance reading with an independent measurement is
within the safety deviation of 2%.

Note
The inaccuracy of the independent measurement needs to be considered.

6. Remove the bypass and otherwise restore normal operation.
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8.8.3 Perfom 2-point level and analog output verification

WARNING!

During the proof-test, the transmitter will not output measurement values corresponding to
the product surface level. Make sure systems and people relying on measurement values from
the transmitter are made aware of the changed conditions. Failure to do so could result in
death, serious injury and/or property damage.

Use Rosemount Radar Master Plus
1. Prior to the test, ensure there are no alarms or warnings present in the transmitter.

a. Under Service Tools, select Alerts.

2. Bypass the process safety function and take appropriate action to avoid a false trip.

3. Simulate 4.00 mA output and verify loop current.

a. Under Service Tools, select Simulate.

b. Select Loop Test.

c. Select 4 mA and then select Start.

d. Measure loop current (e.g. reading the safety logic solver or using the TEST
terminal, see Section 7.4.4).

e. Verify the current deviation is within the safety deviation of 2% (±0.32 mA).

Note
The inaccuracy of safety logic solver or current meter needs to be considered.

4. Simulate 20.00 mA output and verify loop current.

a. Under Service Tools, select Simulate.

b. Select Loop Test.

c. Select 20 mA and then select Start.

d. Measure loop current (e.g. reading the safety logic solver or using the TEST
terminal, see Section 7.4.4).

e. Verify the current deviation is within the safety deviation of 2% (±0.32 mA).

Note
The inaccuracy of safety logic solver or current meter needs to be considered.

f. Select Stop to end loop test.

5. Perform a two-point level measurement verification of the transmitter in the
measuring range. Compare with independent measurement (e.g. the BPCS level
sensor).

a. Under Overview, select All Variables.
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b. Verify the current level or distance reading with an independent measurement is
within the safety deviation of 2%.

Note
The inaccuracy of the independent measurement needs to be considered.

c. Move the surface in the tank at least 10% of the full measuring span (level
0-100%).

d. Repeat steps (a) to (b) for the second point.

6. Remove the bypass and otherwise restore normal operation.

Use AMS Device Manager and Field Communicator
1. Prior to the test, ensure there are no alarms or warnings present in the transmitter.

a. Select Service Tools > Alerts.

2. Bypass the process safety function and take appropriate action to avoid a false trip.

3. Simulate 4.00 mA output and verify loop current.

a. Select Service Tools > Simulate.

b. Under Analog Out, select Loop test.

c. Select 4mA and then select Next (Enter on Field Communicator).

d. Measure loop current (e.g. reading the safety logic solver or using the TEST
terminal, see Section 7.4.4).

e. Verify the current deviation is within the safety deviation of 2% (±0.32 mA).

Note
The inaccuracy of safety logic solver or current meter needs to be considered.

f. To end loop test, select Cancel (ABORT on Field Communicator).

4. Simulate 20.00 mA output and verify loop current.

a. Select Service Tools > Simulate.

b. Under Analog Out, select Loop test.

c. Select 20mA and then select Next (Enter on Field Communicator).

d. Measure loop current (e.g. reading the safety logic solver or using the TEST
terminal, see Section 7.4.4).

e. Verify the current deviation is within the safety deviation of 2% (±0.32 mA).

Note
The inaccuracy of safety logic solver or current meter needs to be considered.

f. To end loop test, select Cancel (ABORT on Field Communicator).
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5. Perform a two-point level measurement verification of the transmitter in the
measuring range. Compare with independent measurement (e.g. the BPCS level
sensor).

a. Select Service Tools > Variables > Process.

b. Verify the current level or distance reading with an independent measurement is
within the safety deviation of 2%.

Note
The inaccuracy of the independent measurement needs to be considered.

c. Move the surface in the tank at least 10% of the full measuring span (level
0-100%).

d. Repeat steps (a) to (b) for the second point.

6. Remove the bypass and otherwise restore normal operation.

8.8.4 Perform analog output verification
Compare HART Primary Variable digital value with analog output reading. Verify that the
deviation is within the pass limit.

Procedure

1. Obtain the loop current as a digital value, do one of the following:

• In Rosemount Radar Master Plus, under Overview, select All Variables and read
the current analog output value.

• Read HART command 2 or 3 via the host system. (2)

2. Obtain the loop current as an analog value (e.g. by using the safety logic solver or
using the TEST terminal, see Section 7.4.4).

3. Compare the current values.

4. Verify the current deviation is within the safety deviation of 2% (±0.32 mA).

Note
The inaccuracy of safety logic solver needs to be considered.

8.8.5 Perform level deviation monitoring
Use the analog output to obtain level (or distance) reading and compare with an
independent level measurement. Verify that the deviation is within the pass limit.

Procedure

1. Obtain the level (or distance) measurement value derived from the analog output
(e.g. by checking measurement value in safety logic solver).

(2) Command 2: Analog output current and Percent of range Command 3: Device variables (PV, SV, TV, and QV) and Analog output current
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2. Obtain the level (or distance) measurement value from an independent level
measurement (e.g. the BPCS level sensor).

3. Compare the measurements and verify that the deviation is within the safety
deviation of 2%.

8.8.6 Product repair
The Rosemount 5408:SIS is repairable by major component replacement. All failures
detected by the transmitter diagnostics or by the proof-test must be reported. Feedback
can be submitted electronically at EmersonProcess.com/Rosemount-safety (Contact Us).

8.9 Specifications
The Rosemount 5408:SIS must be operated according to the functional and performance
specifications provided in Appendix A.

8.9.1 Failure rate data
The FMEDA report includes failure rate data, assessment details, and assumptions
regarding failure rate analysis.

8.9.2 Safety deviation
±2.0% of analog output span

8.9.3 Transmitter response time
• < 6 s at damping value 2 s (default)(3)

• < 2 s at damping value 0 s (minimum)(3)

The transmitter response time will be a function of the configured Damping value.
Rosemount Radar Master Plus has a built-in function to calculate the transmitter’s
measurement response time (requires option code EF2).

8.9.4 Diagnostic test interval
< 90 min(4)

8.9.5 Turn-on time
< 40 s (5)

(3) Step response time as per IEC 61298-2.

(4) A majority of the self-diagnostic tests is performed once every second and an action (if necessary) is taken in less than 30 seconds (default).

(5) Time from when power is applied to the transmitter until performance is within specifications.
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Appendix A
Specifications and Reference Data

A.1 Performance specifications

A.1.1 General

Conformance to specification (±3σ [Sigma])

Technology leadership, advanced manufacturing techniques, and statistical process
control ensure specification conformance to at least ±3σ.

Reference conditions

• Measurement target: Metal plate, no disturbing objects

• Temperature: 68 to 86 °F (20 to 30 °C)

• Ambient pressure: 14 to 15 psi (960 to1060 mbar)

• Relative humidity: 25-75%

• Damping: Default value, 2 s

Instrument accuracy (under reference conditions)

±0.08 in. (2 mm) (1)

Repeatability

±0.04 in. (±1 mm)

Ambient temperature effect

±0.04 in. (±1 mm)/10 K (2)

Sensor update rate

Minimum 1 update per second

(1) Refers to inaccuracy according to IEC 60770-1 when excluding installation dependent offset. See the IEC 60770-1 standard for a definition
of radar specific performance parameters and if applicable corresponding test procedures.

(2) Ambient temperature effect specification valid over temperature range -40 °F to 176 °F (-40 °C to 80 °C).
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Maximum level rate

40 mm/s as default, adjustable up to 200 mm/s

A.1.2 Measuring range

Maximum measuring range

Rosemount 5408: 130 ft. (40 m)

Rosemount 5408:SIS: 130 ft. (40 m) in Control/Monitoring mode(3)

82 ft. (25 m) in Safety (SIS) mode(3)

Note that a combination of adverse process conditions, such as heavy turbulence, foam,
and condensation, together with products with poor reflection may affect the measuring
range.

Accuracy over measuring range

The measuring range is limited by the blind zone at the very top of the tank. In the blind
zone, the accuracy exceeds ±0.20 in. (±5 mm) and measurements may not be possible.
Measurements close to the blind zone will have reduced accuracy (see Figure A-1).

For the extended cone antennas, the reduced accuracy zone ends 11.8 in. (30 cm) below
the antenna end.

(3) The Rosemount 5408:SIS has two operational modes: Safety (SIS) and Control/Monitoring. Safety (SIS) mode must be set when used in
Safety Instrumented Systems. Control/Monitoring mode is intended for use in a Basic Process Control System (BPCS).
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Accuracy Over Measuring RangeFigure A-1:   

±0.08 in.
(2 mm)

7.9 in. 
(20 cm)

19.7 in. 
(50 cm)

±0.20 in.
(5 mm)

A

D
istance

Accuracy

A. Device Reference Point

Recommended Measuring Range for Solids, ft. (m) Table A-1:   

Antenna Light powder (1) Heavy powder (2) Grain size products (3) Larger particles (4)

2-in. (DN50) cone/process seal N/A (5) 33 (10) 33 (10) 39 (12)

3-in. (DN80) cone/process seal

4-in. (DN100) process seal

10 (3) 49 (15) 49 (15) 59 (18)

4-in. (DN100) cone 23 (7) 66 (20) 130 (40) 130 (40)

8-in. (DN200) parabolic 46 (14) 115 (35) 130 (40) 130 (40)

(1) Plastic powder/granules/pellets (Dielectric constant: 1.2-2.0)

(2) Lime powder, cement, sand, etc. (Dielectric constant: 1.5-2.5)

(3) Grain, kernels, brans, etc. (Dielectric constant: 1.5-4.0)

(4) Wood chips, pellets, etc. (Dielectric constant: 1.7- 4.5)

(5) Consider using the Rosemount 5303.
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The figures given in Table A-1 should be considered as guidelines; the total measuring
range may differ depending on other contributing application conditions such as product
filling, how the product piles up, silo diameter vs. angle of repose, internal obstacles within
the silo, etc.

A.1.3 Environment

Vibration resistance

• 2 g at 10-180 Hz according to IEC 61298-3, level “field with general application”

• IACS UR E10 test 7

For compliance with these standards, the transmitter housing must be fully engaged into
the sensor module. This is achieved by rotating the transmitter housing clockwise to
thread limit (see Section 3.8).

Electromagnetic compatibility (EMC)

• EMC Directive (2014/30/EU): EN 61326-1

• EN 61326-2-3

• NAMUR recommendations NE21(4)

For Rosemount 5408:SIS and Rosemount 5408 with option code EF1, the blue plug on the
terminal block must be connected.

Pressure Equipment Directive (PED)

Complies with 2014/68/EU article 4.3

Built-in lightning protection

EN 61326, IEC 61000-4-5, level 6kV

Radio approvals
• Radio Equipment Directive (2014/53/EU): ETSI EN 302 372, ETSI EN 302 729 and EN

62479

• Part 15 of the FCC Rules

• Industry Canada RSS 211

(4) In challenging applications where the dynamic of the Rosemount 5408 and 5408:SIS sensitivity is utilized by multiple factors such as small
aperture antenna, very low product dielectric constant and/or turbulent surface, the margin for additional influence due to extreme EMC
may be limited.
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A.2 Functional specifications

A.2.1 General

Field of application

Continuous level measurements for tank monitoring, process control, and overfill
prevention on a broad range of liquids, slurries, and solids.

Ideal for applications with varying and harsh process conditions, such as heavy turbulence,
foaming, product build-up, condensing vapors, sticky, viscous, corrosive, and crystallizing
products.

Measurement principle

Frequency Modulated Continuous Wave (FMCW)

Frequency range

24.05 to 27.0 (26.5(5)) GHz

Maximum output power

-5 dBm (0.32 mW)

Internal power consumption

< 1 W in normal operation

Humidity

0 - 100% relative humidity, non-condensing

Turn-on time

< 40 s (6)

A.2.2 Display and configuration

LCD display (option code M5)

• Toggles between selected output variables

• Shows diagnostic information (alerts)

(5) 26.5 GHz in Australia and New Zealand, and for LPR (Level Probing Radar), option code OA.

(6) Time from when power is applied to the transmitter until performance is within specifications.
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LCD DisplayFigure A-2:   

Remote display

Data can be read remotely by using the Rosemount 751 Field Signal Indicator, see the
corresponding Product Data Sheet for more information.

Configuration tools

• Rosemount Radar Master Plus for Rosemount 5408 Series (accessible through any
Field Device Integration (FDI) based tool, e.g Instrument Inspector™ Application (7))

• Device Descriptor (DD) based systems, e.g. AMS Device Manager, 475 Field
Communicator, AMS Trex™ Device Communicator, and DeltaV™, or any other EDDL
or enhanced-EDDL host

• Field Device Integration (FDI) based systems

Damping

User selectable (default is 2 s, minimum is 0 s) (8)

Output units

• Level and distance: ft., in., m, cm, mm

• Level rate: ft/s, in./min, in./s, m/h, m/s

• Volume: ft3, in.3, yd3, US gal, imperial gal, barrel (bbl), m3, l

• Temperature: °F, °C

• Signal strength: mV

Output VariablesTable A-2:   

Variable 4-20 mA Digital output LCD display

Level ✓ ✓ ✓

(7) Included in delivery of the transmitter. For additional information, visit Emerson.com/RosemountRadarMasterPlus.

(8) The Damping parameter defines how fast the device responds to level changes (step response). A high value makes the level steady but the
device reacts slowly to level changes in the tank.
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Output Variables (continued)Table A-2:   

Variable 4-20 mA Digital output LCD display

Distance (Ullage) ✓ ✓ ✓

Volume ✓ ✓ ✓

Scaled Variable (1) ✓ ✓ ✓

Electronics Temperature N/A ✓ ✓

Signal Quality(1) N/A ✓ ✓

Level Rate N/A ✓ ✓

Signal strength N/A ✓ ✓

Percent of Range N/A ✓ ✓

Percent of Range Auxiliary N/A ✓ ✓

User Defined(1) ✓ ✓ ✓

(1) Only for transmitters ordered with Smart Diagnostics Suite (option code DA1).

A.2.3 4-20 mA HART

Output

Two-wire, 4-20 mA. Digital process variable is superimposed on 4-20 mA signal, and
available to any host that conforms to the HART protocol. The digital HART® signal can be
used in multidrop mode.

HART Revision

• Revision 6 (default)

• Revision 7 (option code HR7)

The HART revision can be switched in field.

Power supply

Transmitter operates on 12-42.4 Vdc transmitter terminal voltage (12-30 Vdc in
Intrinsically Safe installations).

Power consumption

Max. 1 W, current max. 23 mA

Load limitations

For HART® communication, a minimum loop resistance of 250 Ω is required. Maximum
loop resistance is determined by the voltage level of the external power supply.
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Load LimitsFigure A-3:   

Maximum Loop Resistance = 43.5 * (External Power Supply Voltage - 12)

A. Loop Resistance (Ohms)
B. External Power Supply Voltage (Vdc)

Cable selection

Use 24-14 AWG wire. Twisted pairs and shielded wiring are recommended for
environments with high EMI (electromagnetic interference).

Two wires can be safely connected to each terminal screw.

Analog signal on alarm

The transmitter automatically and continuously performs self-diagnostic routines. If a
failure or a measurement error is detected, the analog signal will be driven offscale to alert
the user. High or low failure mode is user-configurable.

Signal on AlarmTable A-3:   

Standard High Low

Rosemount standard ≥ 21.75 mA (default) ≤ 3.75 mA (option code C8)

NAMUR NE43 ≥ 22.50 mA (option code C4) ≤ 3.6 mA (option code C5)

Analog saturation levels

The transmitter will drive the output to high or low saturation values if measurement goes
outside the 4-20 mA range values.
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Saturation LevelsTable A-4:   

Standard High Low

Rosemount standard (default and option code
C8)

20.8 mA 3.9 mA

NAMUR NE43 (option code C4 and C5) 20.5 mA 3.8 mA

A.2.4 Diagnostics

Alerts

The Rosemount 5408 and 5408:SIS are compliant with NAMUR NE 107 Field Diagnostics
for standardized device diagnostic information.

Tools and logging in Rosemount Radar Master Plus
• Echo curve

• Measurement and alert log

Rosemount Radar Master Plus, embedded in Instrument Inspector, enables easy and
powerful troubleshooting with the echo curve tool as well as the measurement and alert
log.

The measurement and alert log holds records of the last seven days of level readings and
echo curve profiles, as well as the 50 last alert events. The logs can be transferred from the
transmitter’s internal memory to a local computer and be presented in a graphical time
line, enabling analysis of historical behaviors.

Smart Diagnostics Suite (option code DA1)

Signal Quality
Metrics

Diagnostics package that monitors the relations between surface,
noise, and threshold. The function can be used to detect abnormal
conditions in the process such as antenna contamination or sudden loss
of signal strength. Signal Quality is available as output variable and it
comes with user configurable alerts.

Power
Advisory

The transmitter automatically measures and monitors the input
voltage. If the voltage is too low, operators will be provided with an
early alert.

Scaled
Variable

The scaled variable configuration allows the user to convert a
transmitter variable into an alternative measurement, such as flow,
mass, or calibrated level (e.g. 5 point verification).

User Defined
Variable

Allows designating more than 200 variables in the device as output
variable.
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A.2.5 Process temperature and pressure rating
The following figures give the maximum process temperature (measured at the lower part
of the flange, Tri-Clamp, or threaded connection) and pressure rating for different antenna
types.

Final rating may be lower depending on flange selection.

For antenna type code CAB, at 100 °F (38 °C), the rating decreases with increasing
temperature per ASME B16.5 Table 2-2.2, Class 300.

Cone Antenna (PTFE Seal)Figure A-4:   

482
(250)

1450 
(100)

392
(200)

302
(150)

212
(100)

-40
(-40)

100
(38)

-76
(-60)

-15  (-1)
44 (3)

725
(50)
562

(38.5)

363 
(25)

Code CAC

Code CAB

Code CAA

Code CAD

Temperature
°F (°C)

Pressure
psig (bar)
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Cone Antenna (PEEK Seal)Figure A-5:   

Code CBF (FVMQ)

Code CBM (FKM)

Code CBM (FKM)

Code CBK (Kalrez 6375)

Temperature
°F (°C)

Pressure
psig (bar)

482
(250)

428
(220)

392
(200)

338
(170)

-76
(-60)

5
(-15)

-13
(-25)

-22
(-30)-15 

(-1)

754 
(52)

Process Seal AntennaFigure A-6:   

Tri-Clamp

Temperature
°F (°C)

Pressure
psig (bar)

392 
(200)

-76 
(-60)

-13 
(-25)

-7 (-0.5)

363 (25)

232 (16)

Parabolic AntennaFigure A-7:   

Temperature
°F (°C)

Pressure
psig (bar)

392
(200)

-67
(-55)

-7 (-0.5)

43 (3)

A.2.6 Temperature limits
Verify that the operating atmosphere of the transmitter is consistent with the appropriate
hazardous locations certifications, see Appendix B.
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Ambient Temperature LimitsTable A-5:   

Description Operating limit Storage limit (1)

Without LCD display -40 °F to 176 °F (-40 °C to 80 °C) -58 °F to 176 °F (-50 °C to 80 °C)

With LCD display (2) -40 °F to 176 °F (-40 °C to 80 °C)

(1) The minimum storage temperature is -22 °F (-30 °C) for the cone antenna with Kalrez 6375 O-ring (antenna
type code CBK).

(2) LCD display may not be readable and LCD display updates will be slower at temperatures below -4 °F (-20 °C).

The ambient temperature limits may be further restricted by the process temperature as
described by Figure A-8.

Ambient Temperature vs. Process TemperatureFigure A-8:   

104 (40)

176 (80)

482
(250)

-76
(-60)

248
(120)

-40 (-40)

Ambient temperature
°F (°C)

Process temperature
°F (°C)

A.2.7 Flange rating
ASME

• 316 SST according to ASME B16.5 Table 2-2.2

• 316L SST according to ASME B16.5 Table 2-2.3 (for protective plate design)(9)

• Alloy C-276 (UNS N10276) according to ASME B16.5 Table 2-3.8

• Alloy 400 (UNS N04400) according to ASME B16.5 Table 2-3.4

EN

• 1.4404 according to EN 1092-1 material group 13E0

JIS

• 316 SST according to JIS B2220 material group No. 2.2

• 316L SST according to JIS B2220 material group No. 2.3 (for protective plate
design)(9)

(9) Flange rating according to backing flange.
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A.2.8 Conditions used for flange strength calculations

316/316L SST (EN 1.4404) FlangesTable A-6:   

Item ASME EN, JIS

Bolting material SA193 B8M CL.2, SA193 B7(1), or SA320
L7(1)

EN 1515-1/2, ISO 3506 A4-70, or Bumax®

88(1)

Gasket(2) Soft (1a) with min. thickness 1.6 mm

or

Spiral wound gasket with nonmetallic filler
(1b)

Soft (EN 1514-1) with min. thickness 1.6
mm

or

Spiral wound gasket with nonmetallic filler
(EN 1514-2)

Flange material Stainless steel A182 Gr. F316 and EN 10222-5-1.4404

Hub material(3) Stainless steel SA479 316 and EN 10272-1.4404

(1) Only applicable to forged one-piece flanges.

(2) Not applicable to process seal antenna (features an integrated gasket).

(3) Only applicable to flanges with welded construction per Table A-12.
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Flanges with Protective Plate DesignTable A-7:   

 Item ASME EN, JIS

Bolting material SA193 B8M Cl.2 EN 1515-1/2, ISO 3506 A4-70

Gasket(1) Soft (1a) with min. thickness 1.6 mm

or

Spiral wound gasket with nonmetallic filler
(1b)

Soft (EN 1514-1) with min. thickness 1.6
mm

or

Spiral wound gasket with nonmetallic filler
(EN 1514-2)

Flange material Stainless steel A182 Gr. F316L/F316 and EN 10222-5-1.4404

Hub material SB574 Gr. N10276 (solution annealed condition) or SB164 Gr. N04400 (solution an-
nealed condition)

(1) Note that a minimum gasket thickness of 0.125 in. (3.2 mm) is required when using an air purge ring (option code PC1).

Alloy C-276 (UNS N10276) FlangesTable A-8:   

 Item ASME EN, JIS

Bolting material UNS N10276 UNS N10276

Gasket Soft (1a) with min. thickness 1.6 mm

or

Spiral wound gasket with nonmetallic filler
(1b)

Soft (EN 1514-1) with min. thickness 1.6
mm

or

Spiral wound gasket with nonmetallic filler
(EN 1514-2)

Flange material SB462 Gr. N10276 (solution annealed condition) or SB575 Gr. N10276 (solution an-
nealed condition)

Hub material SB574 Gr. N10276 (solution annealed condition)

Alloy 400 (UNS N04400) FlangesTable A-9:   

 Item ASME EN, JIS

Bolting material UNS N04400 UNS N04400

Gasket Soft (1a) with min. thickness 1.6 mm

or

Spiral wound gasket with nonmetallic filler
(1b)

Soft (EN 1514-1) with min. thickness 1.6
mm

or

Spiral wound gasket with nonmetallic filler
(EN 1514-2)

Flange material SB/B564 Gr. N04400 (solution annealed condition) or SB/B127 Gr. N04400 (solution an-
nealed condition)

Hub material SB164 Gr. N04400 (solution annealed condition)
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A.2.9 Air purging
An air purge connection can prevent clogging of the antenna in extreme applications with
dirt or heavy coating. The easiest way to determine if air purging is needed, is to inspect
the tank internal conditions at the location intended for the transmitter. If there is
normally a thick layer of product build-up there, air purging is most likely needed. Typical
purging media to use is air.

All parabolic antennas come with an integrated air purge connection (see Figure A-9).

Air Purging for Parabolic AntennaFigure A-9:   

An air purge connection is also available for cone antennas with flanged connection by
selecting option code PC1. This option consists of an antenna with purge holes and a
separate air purge ring (see Figure A-10).
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Air Purging for Cone AntennaFigure A-10:   

Incoming air supply specification

• Maximum pressure: 190 psi (13 bar)

• Recommended pressure: 100 to 115 psi (7 to 8 bar)

• Inlet/outlet connection: BSPP (G) 3/8-in.

• Air consumption: 252 gal/min at 65 psi (955 l/min at 4.5 bar)

A.2.10 System integration

Rosemount 333 HART Tri-Loop™

By sending the digital HART signal to the optional HART Tri-Loop, it is possible to have up
to three additional 4–20 mA analog signals.

See the Rosemount 333 HART Tri-Loop Product Data Sheet for additional information.

Emerson™ Wireless 775 THUM™ Adapter

The optional Emerson Wireless 775 THUM Adapter can be mounted directly on the
transmitter or by using a remote mounting kit.
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IEC 62591 (WirelessHART®) enables access to multivariable data and diagnostics, and adds
wireless to almost any measurement point.

See the Emerson Wireless 775 THUM Adapter Product Data Sheet and Technical Note for
additional information.

A.3 Physical specifications

A.3.1 Material selection
Emerson provides a variety of Rosemount products with various product options and
configurations including materials of construction that can be expected to perform well in
a wide range of applications. The Rosemount product information presented is intended
as a guide for the purchaser to make an appropriate selection for the application. It is the
purchaser’s sole responsibility to make a careful analysis of all process parameters (such as
all chemical components, temperature, pressure, flow rate, abrasives, contaminants, etc.),
when specifying product, materials, options and components for the particular
application. Emerson is not in a position to evaluate or guarantee the compatibility of the
process fluid or other process parameters with the product, options, configuration or
materials of construction selected.

A.3.2 Engineered solutions
When standard model codes are not sufficient to fulfill requirements, please consult the
factory to explore possible Engineered Solutions. This is typically, but not exclusively,
related to the choice of wetted materials or the design of a process connection. These
Engineered Solutions are part of the expanded offerings and may be subject to additional
delivery lead time. For ordering, factory will supply a special P-labeled numeric option code
that should be added at the end of the standard model string.

A.3.3 Housing and enclosure
Electrical connections

Two cable/conduit entries (½-14 NPT, M20 x 1.5, or G½)

Optional adapters: M12 4-pin male eurofast connector or A size Mini 4-pin male minifast
connector

Materials

• Electronics housing: Polyurethane-covered Aluminum or Stainless Steel Grade
CF-8M (ASTM A743)

• Sensor module: 316L SST
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Weight

• Aluminum housing: 6.2 lb (2.8 kg) (10)

• Stainless steel housing: 10.0 lb (4.5 kg)(10)

Ingress protection

IP 66/67/68 (11) and NEMA® 4X

A.3.4 Tank connection
The tank connection consists of a tank seal, a flange, NPT or BSPP (G) threads, Tri Clamp, or
a specific welded connection with swivel feature for parabolic antenna.

A.3.5 Flange dimensions
Follows ASME B16.5, JIS B2220, and EN 1092-1 standards. For more information, see 
Section A.7.1.

A.3.6 Antenna versions
Cone antenna

• Best choice for most applications, including closed vessels, still pipe/chamber
installations, and open air applications

• Extended cone antennas are available for tall nozzles (option code S1 and S2).
Depending on measurement conditions, a reduction of sensitivity close to antenna
end might be present.

Process seal antenna

• All PTFE wetted parts ideal for use in corrosive and hygienic applications

• Suitable for applications with heavy condensation/build-up

Parabolic antenna

• Alternative for long measuring ranges in combination with conditions such as low
reflective media

• Suitable for a broad range of solid materials (may need air purging in dusty
environments)

A.3.7 Material exposed to tank atmosphere
Cone antenna, PTFE seal

• 316/316L SST (EN 1.4404), Alloy C-276 (UNS N10276), or Alloy 400 (UNS N04400)

• PTFE fluoropolymer

(10) Fully functional transmitter with sensor module, housing, terminal block, LCD display, and covers

(11) The transmitter meets IP 68 at 9.8 ft. (3 m) for 30 minutes.
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Cone antenna, PEEK seal

• 316/316L SST (EN 1.4404), Alloy C-276 (UNS N10276), or Alloy 400 (UNS N04400)

• PEEK polyetheretherketone with PTFE fluoropolymer filler

• FVMQ fluorosilicone, Kalrez 6375 perfluoroelastomer, FKM fluoroelastomer, or
Viton fluoroelastomer (O-ring)

Process seal antenna

• PTFE fluoropolymer

Parabolic antenna

• 316/316L SST (EN 1.4404)

• PTFE fluoropolymer

• FVMQ fluorosilicone (O-ring)

A.4 Ordering Information

A.4.1 Rosemount 5408 Level Transmitter
The starred offerings (★) represent the most common options and should be selected for
best delivery. The non-starred offerings are subject to additional delivery lead time.

Rosemount 5408 Level Transmitter Ordering InformationTable A-10:   

Model Product Description  

5408 Radar Level Transmitter ★

Profile  

A Standard Monitoring & Control Applications ★

Measurement type  

1 Liquid Level Measurement ★

3 Solids Level Measurement ★

4 Liquid & Solids Level Measurement ★

Performance class  

S Standard ★

Signal output  

H 4–20 mA with digital signal based on HART® Revision 6 protocol (HART Revision 7 available as option) ★

Housing material  

A Aluminum ★

S Stainless Steel (SST) ★
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Rosemount 5408 Level Transmitter Ordering Information (continued)Table A-10:   

Conduit/cable threads  

1 ½-14 NPT ★

2 M20 x 1.5 ★

3(1) G½  

Hazardous locations certifications  

NA None ★

E1 ATEX Flameproof ★

I1 ATEX Intrinsic Safety ★

N1 ATEX Type n ★

E5 USA Explosion-proof, Dust Ignition-proof ★

I5 USA Intrinsically Safe; Nonincendive ★

E6 Canadian Explosion-proof, Dust Ignition-proof ★

I6 Canadian Intrinsically Safe; Nonincendive ★

E7 IECEx Flameproof, Dust Ignition-proof ★

I7 IECEx Intrinsic Safety ★

N7 IECEx Type n ★

E2 INMETRO Flameproof ★

I2 INMETRO Intrinsic Safety ★

N2 INMETRO Type n ★

E3 China Flameproof ★

I3 China Intrinsic Safety ★

N3 China Type n ★

IP Republic of Korea Intrinsic Safety ★

Materials of construction Available antenna types  

1 316/316L/EN 1.4404 Cone, Parabolic ★

7 All PTFE Wetted Parts Process Seal ★

2 Alloy C-276 (UNS N10276) with Protective Plate Cone

3 Alloy 400 (UNS N04400) with Protective Plate Cone

H Alloy C-276 (UNS N10276) Process Connection, Flange, and Antenna Cone

M Alloy 400 (UNS N04400) Process Connection, Flange, and Antenna Cone

Process connection type (see Table A-12, Table A-13, Table A-14, and Table A-15) Available antenna types  

F (2) Flat Face Flange Cone, Parabolic ★

R (3) Raised Face Flange All ★

N NPT Thread Cone ★

G BSPP (G) Thread Cone, Parabolic ★

B Bracket Mounting Cone ★
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Rosemount 5408 Level Transmitter Ordering Information (continued)Table A-10:   

C Tri-Clamp® Process Seal ★

W Welded Connection Parabolic ★

Process connection size (see Table A-12, Table A-13, Table A-14, and Table A-15) Available antenna types  

A 1½-in. Cone ★

2 2-in./DN50/50A Cone, Process Seal ★

3 3-in./DN80/80A Cone, Process Seal ★

B 3½-in. Parabolic ★

4 4-in./DN100/100A Cone, Process Seal ★

6 6-in./DN150/150A Cone ★

8 8-in./DN200/200A Cone, Parabolic ★

T 10-in./DN250/250A Parabolic ★

Z None (use when ordering bracket mounting) Cone ★

Process connection rating (see Table A-12, Table A-13, Table A-14, and Table A-15)  

ZZ For use with non-flange process connection type ★

ASME flanges  

AA ASME B16.5 Class 150 ★

AB ASME B16.5 Class 300 ★

AC ASME B16.5 Class 600 ★

EN flanges Note  

DK EN1092-1 PN6 N/A ★

DA EN1092-1 PN16 PN10 and PN16 dimensions are identical for DN50 to DN150 ★

DB EN1092-1 PN40 PN25 and PN40 dimensions are identical for DN50 to DN150 ★

DC EN1092-1 PN63 N/A ★

DD EN1092-1 PN100 N/A ★

JIS flanges  

JK JIS 5K ★

JA JIS 10K ★

JB JIS 20K ★

Antenna type Operating pressure Operating temperature  

CAA Cone Antenna (PTFE seal) -15 to 363 psig (-1 to 25 bar) -76 to 392 °F (-60 to 200 °C) ★

CAB Cone Antenna (PTFE seal) -15 to 725 psig (-1 to 50 bar) (4) -40 to 302 °F (-40 to 150 °C) ★

CAC Cone Antenna (PTFE seal) -15 to 1450 psig (-1 to 100 bar) -40 to 212 °F (-40 to 100 °C) ★

CAD Cone Antenna (PTFE seal) -15 to 44 psig (-1 to 3 bar) -76 to 482 °F (-60 to 250 °C) ★

CBF Cone Antenna (PEEK seal, FVMQ) -15 to 754 psig (-1 to 52 bar) -76 to 338 °F (-60 to 170 °C) ★

CBK Cone Antenna (PEEK seal, Kalrez® 6375) -15 to 754 psig (-1 to 52 bar) 5 to 482 °F (-15 to 250 °C) ★

CBM Cone Antenna (PEEK seal, FKM) -15 to 754 psig (-1 to 52 bar) -13 to 428 °F (-25 to 220 °C) ★
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Rosemount 5408 Level Transmitter Ordering Information (continued)Table A-10:   

CBV Cone Antenna (PEEK seal, Viton®) -15 to 754 psig (-1 to 52 bar) -22 to 392 °F (-30 to 200 °C) ★

SAA Process Seal Antenna -7 to 363 psig (-0.5 to 25 bar) (5) -76 to 392 °F (-60 to 200 °C)(5) ★

PAS Parabolic Antenna, Swivel Mount -7 to 43 psig (-0.5 to 3 bar) -67 to 392 °F (-55 to 200 °C) ★

Antenna size Available antenna types  

2 2-in. (DN50) Cone, Process Seal ★

3 3-in. (DN80) Cone, Process Seal ★

4 4-in. (DN100) Cone, Process Seal ★

8 8-in. (DN200) Parabolic ★

Options (include with selected model number)

Antenna extensions (see Figure A-11) Total length  

S1 Extended Cone Antenna 24-in. (600 mm) ★

S2 Extended Cone Antenna, Segmented 48-in. (1200 mm) ★

Purging connection (see Figure A-10)(6)(7)  

PC1 Purging Connector (Purge Ring) ★

Display  

M5 LCD Display ★

Functional safety options  

EF1 Ready for upgrade to Rosemount 5408:SIS ★

Diagnostic functionality  

DA1 Smart Diagnostics Suite (see Smart Diagnostics Suite (option code DA1)) ★

HART revision configuration  

HR7 4-20 mA with digital signal based on HART Revision 7 protocol ★

Open air applications configuration (8)  

OA Open Air Applications Configuration; LPR (Level Probing Radar) ★

Factory configuration  

C1 Factory Configuration per Configuration Data Sheet ★

Alarm limits  

C4 NAMUR Alarm and Saturation Levels, High Alarm ★

C5 NAMUR Alarm and Saturation Levels, Low Alarm ★

C8 (9) Standard Rosemount Alarm and Saturation Levels, Low Alarm ★

Welding standard for flanges (10)  

AW According to ASME IX ★

EW According to EN-ISO ★
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Rosemount 5408 Level Transmitter Ordering Information (continued)Table A-10:   

Country certification(11)  

J1 Canadian Registration (CRN) ★

Special quality assurance  

Q4 Calibration Data Certificate ★

Hydrostatic testing (12)  

Q5 Hydrostatic Testing, including certificate ★

Material traceability certification (13)  

Q8 Material Traceability Certification per EN 10204 3.1 (2.1 for non-metallic) ★

Hygienic certification(14)  

QA Certificate of compliance to 3-A® ★

Materials certification (15)  

Q15 NACE® Material Recommendation per NACE MR0175/ISO 15156 ★

Q25 NACE Material Recommendation per ANSI/NACE MR0103/ISO 17495-1 ★

Q35 NACE Material Recommendation per NACE MR0175/ISO 15156 and ANSI/NACE MR0103/ISO 17495-1 ★

Welding procedure qualification record documentation(10)  

Q66 Welding Procedure Qualification Record (WPQR) ★

Q67 Welder Performance Qualification (WPQ) ★

Q68 Welding Procedure Specification (WPS) ★

Q79 WPQR/WPQ/WPS ★

Dye penetration test certificate(10)  

Q73 Certificate of Liquid Penetrant Inspection ★

Positive material identification certificate  

Q76 Positive Material Identification Certificate of Conformance ★

Overfill prevention  

U1 Overfill Prevention According to WHG/TUV ★

Extended product warranty  

WR3 3-year Limited Warranty ★

WR5 5-year Limited Warranty ★

Conduit electrical connector (shipped uninstalled) (16)  

EC M 12, 4-pin, Male connector (eurofast®) ★

MC A size Mini, 4-pin, Male connector (minifast®) ★

Specials (see Section A.3.2)  

PXXXX Custom Engineered Solutions beyond standard model codes. Consult factory for details.  

Typical model number: 5408 A 1 S H A 1 E5 1 R 3 AB CAB 3 M5 DA1  
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(1) G½ thread form is not available with hazardous locations approvals.

(2) Type A flat face for EN 1092-1 flanges.

(3) Type B1 raised face for EN 1092-1 flanges.

(4) Pressure limit is derated for process temperatures above 100 °F (38 °C), see Figure A-4 for details.

(5) Refer to Figure A-6 for pressure/temperature ratings of Tri-Clamp connection.

(6) Option code PC1 is for cone antennas only, and requires matching flange and antenna sizes. Note that all parabolic antennas come
with an integrated air purge connection.

(7) A minimum gasket thickness of 0.125 in. (3.2 mm) is required for flanges with protective plate design.

(8) Only available with parabolic antenna and 4-in. (DN100) cone antenna.

(9) The standard alarm setting is high.

(10) Only applies to flanged process connections with welded construction or protective plate design; only applicable to cone antennas (see 
Table A-12 and Table A-13).

(11) Only available with ASME B16.5 flange connections, and materials of construction codes 1 and 7.

(12) Hydrostatic testing is only available for cone antennas and process seal antennas with flanged process connections.

(13) Certificate includes all pressure retaining and wetted parts.

(14) Only available for process seal antennas with Tri-Clamp connection.

(15) Not available with parabolic antenna.

(16) Requires ½-14 NPT conduit/cable threads (code 1). Available with Intrinsically Safe approvals only.

A.4.2 Rosemount 5408:SIS Level Transmitter
The starred offerings (★) represent the most common options and should be selected for
best delivery. The non-starred offerings are subject to additional delivery lead time.

Rosemount 5408:SIS Level Transmitter Ordering InformationTable A-11:   

Model Product Description  

5408 Radar Level Transmitter ★

Profile (1)  

F Functional Safety / SIS Applications ★

Measurement type  

1 Liquid Level Measurement ★

4 (2) Liquid & Solids Level Measurement ★

Performance class  

S Standard ★

Signal output  

H 4–20 mA with digital signal based on HART Revision 6 protocol (HART Revision 7 available as option) ★

Housing material  

A Aluminum ★

S Stainless Steel (SST) ★

Conduit/cable threads  

1 ½-14 NPT ★

2 M20 x 1.5 ★
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Rosemount 5408:SIS Level Transmitter Ordering Information (continued)Table A-11:   

3(3) G½  

Hazardous locations certifications  

NA None ★

E1 ATEX Flameproof ★

I1 ATEX Intrinsic Safety ★

N1 ATEX Type n ★

E5 USA Explosion-proof, Dust Ignition-proof ★

I5 USA Intrinsically Safe; Nonincendive ★

E6 Canadian Explosion-proof, Dust Ignition-proof ★

I6 Canadian Intrinsically Safe; Nonincendive ★

E7 IECEx Flameproof, Dust Ignition-proof ★

I7 IECEx Intrinsic Safety ★

N7 IECEx Type n ★

E2 INMETRO Flameproof ★

I2 INMETRO Intrinsic Safety ★

N2 INMETRO Type n ★

E3 China Flameproof ★

I3 China Intrinsic Safety ★

N3 China Type n ★

IP Republic of Korea Intrinsic Safety ★

Materials of construction Available antenna types  

1 316/316L/EN 1.4404 Cone, Parabolic ★

7 All PTFE Wetted Parts Process Seal ★

2 Alloy C-276 (UNS N10276) with Protective Plate Cone

3 Alloy 400 (UNS N04400) with Protective Plate Cone

H Alloy C-276 (UNS N10276) Process Connection, Flange, and Antenna Cone

M Alloy 400 (UNS N04400) Process Connection, Flange, and Antenna Cone

Process connection type (see Table A-12, Table A-13, Table A-14, and Table A-15) Available antenna types  

F (4) Flat Face Flange Cone, Parabolic ★

R (5) Raised Face Flange All ★

N NPT Thread Cone ★

G BSPP (G) Thread Cone, Parabolic ★

B Bracket Mounting Cone ★

C Tri-Clamp Process Seal ★

W Welded Connection Parabolic ★
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Rosemount 5408:SIS Level Transmitter Ordering Information (continued)Table A-11:   

Process connection size (see Table A-12, Table A-13, Table A-14, and Table A-15) Available antenna types  

A 1½-in. Cone ★

2 2-in./DN50/50A Cone, Process Seal ★

3 3-in./DN80/80A Cone, Process Seal ★

B 3½-in. Parabolic ★

4 4-in./DN100/100A Cone, Process Seal ★

6 6-in./DN150/150A Cone ★

8 8-in./DN200/200A Cone, Parabolic ★

T 10-in./DN250/250A Parabolic ★

Z None (use when ordering bracket mounting) Cone ★

Process connection rating (see Table A-12, Table A-13, Table A-14, and Table A-15)  

ZZ For use with non-flange process connection type ★

ASME flanges  

AA ASME B16.5 Class 150 ★

AB ASME B16.5 Class 300 ★

AC ASME B16.5 Class 600 ★

EN flanges Note  

DK EN1092-1 PN6 N/A ★

DA EN1092-1 PN16 PN10 and PN16 dimensions are identical for DN50 to DN150 ★

DB EN1092-1 PN40 PN25 and PN40 dimensions are identical for DN50 to DN150 ★

DC EN1092-1 PN63 N/A ★

DD EN1092-1 PN100 N/A ★

JIS flanges  

JK JIS 5K ★

JA JIS 10K ★

JB JIS 20K ★

Antenna type Operating pressure Operating temperature  

CAA Cone Antenna (PTFE seal) -15 to 363 psig (-1 to 25 bar) -76 to 392 °F (-60 to 200 °C) ★

CAB Cone Antenna (PTFE seal) -15 to 725 psig (-1 to 50 bar) (6) -40 to 302 °F (-40 to 150 °C) ★

CAC Cone Antenna (PTFE seal) -15 to 1450 psig (-1 to 100 bar) -40 to 212 °F (-40 to 100 °C) ★

CAD Cone Antenna (PTFE seal) -15 to 44 psig (-1 to 3 bar) -76 to 482 °F (-60 to 250 °C) ★

CBF Cone Antenna (PEEK seal, FVMQ) -15 to 754 psig (-1 to 52 bar) -76 to 338 °F (-60 to 170 °C) ★

CBK Cone Antenna (PEEK seal, Kalrez 6375) -15 to 754 psig (-1 to 52 bar) 5 to 482 °F (-15 to 250 °C) ★

CBM Cone Antenna (PEEK seal, FKM) -15 to 754 psig (-1 to 52 bar) -13 to 428 °F (-25 to 220 °C) ★

CBV Cone Antenna (PEEK seal, Viton) -15 to 754 psig (-1 to 52 bar) -22 to 392 °F (-30 to 200 °C) ★

SAA Process Seal Antenna -7 to 363 psig (-0.5 to 25 bar) (7) -76 to 392 °F (-60 to 200 °C)(7) ★
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Rosemount 5408:SIS Level Transmitter Ordering Information (continued)Table A-11:   

PAS Parabolic Antenna, Swivel Mount -7 to 43 psig (-0.5 to 3 bar) -67 to 392 °F (-55 to 200 °C) ★

Antenna size Available antenna types  

2 2-in. (DN50) Cone, Process Seal ★

3 3-in. (DN80) Cone, Process Seal ★

4 4-in. (DN100) Cone, Process Seal ★

8 8-in. (DN200) Parabolic ★

Options (include with selected model number)

Antenna extensions (see Figure A-11) Total length  

S1 Extended Cone Antenna 24-in. (600 mm) ★

S2 Extended Cone Antenna, Segmented 48-in. (1200 mm) ★

Purging connection (see Figure A-10) (8)(9)  

PC1 Purging Connector (Purge Ring) ★

Display  

M5 LCD Display ★

Functional safety options  

EF2 Extended SIS Package ★

Diagnostic functionality  

DA1 Smart Diagnostics Suite (see Smart Diagnostics Suite (option code DA1)) ★

HART revision configuration  

HR7 4-20 mA with digital signal based on HART Revision 7 protocol ★

Factory configuration  

C1 Factory Configuration per Configuration Data Sheet ★

Alarm limits  

C4 NAMUR Alarm and Saturation Levels, High Alarm ★

C5 NAMUR Alarm and Saturation Levels, Low Alarm ★

C8 (10) Standard Rosemount Alarm and Saturation Levels, Low Alarm ★

Welding standard for flanges (11)  

AW According to ASME IX ★

EW According to EN-ISO ★

Country certification(12)  

J1 Canadian Registration (CRN) ★

Special quality assurance  

Q4 Calibration Data Certificate ★

Specifications and Reference Data

Rosemount 5408 and 5408:SIS Level Transmitters 173

http://www.emerson.com/documents/automation/193128.pdf


Rosemount 5408:SIS Level Transmitter Ordering Information (continued)Table A-11:   

Hydrostatic testing (13)  

Q5 Hydrostatic Testing, including certificate ★

Material traceability certification (14)  

Q8 Material Traceability Certification per EN 10204 3.1 (2.1 for non-metallic) ★

Hygienic certification(15)  

QA Certificate of compliance to 3-A ★

Quality certification for safety  

QS Certificate of FMEDA Data ★

QT Safety-certified to IEC 61508 with certificate of FMEDA data ★

Materials certification (16)  

Q15 NACE Material Recommendation per NACE MR0175/ISO 15156 ★

Q25 NACE Material Recommendation per ANSI/NACE MR0103/ISO 17495-1 ★

Q35 NACE Material Recommendation per NACE MR0175/ISO 15156 and ANSI/NACE MR0103/ISO 17495-1 ★

Welding procedure qualification record documentation(11)  

Q66 Welding Procedure Qualification Record (WPQR) ★

Q67 Welder Performance Qualification (WPQ) ★

Q68 Welding Procedure Specification (WPS) ★

Q79 WPQR/WPQ/WPS ★

Dye penetration test certificate(11)  

Q73 Certificate of Liquid Penetrant Inspection ★

Positive material identification certificate  

Q76 Positive Material Identification Certificate of Conformance ★

Overfill prevention  

U1 Overfill Prevention According to WHG/TUV ★

Extended product warranty  

WR3 3-year Limited Warranty ★

WR5 5-year Limited Warranty ★

Paint option for aluminum housing  

PY1 Housing and Covers in Yellow per RAL 1003 ★

PY2 Covers in Yellow per RAL 1003 ★

PR1 Housing and Covers in Red per RAL 3002 ★

PR2 Covers in Red per RAL 3002 ★

PO1 Housing and Covers in Orange per Munsell 2.5 YR 6/14 ★

PO2 Covers in Orange per Munsell 2.5 YR 6/14 ★
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Rosemount 5408:SIS Level Transmitter Ordering Information (continued)Table A-11:   

Conduit electrical connector (shipped uninstalled) (17)  

EC M 12, 4-pin, Male connector (eurofast) ★

MC A size Mini, 4-pin, Male connector (minifast) ★

Specials (see Section A.3.2)  

PXXXX Custom Engineered Solutions beyond standard model codes. Consult factory for details.  

Typical model number: 5408 F 1 S H A 1 E5 1 R 3 AB CAB 3 M5 DA1 EF2 QT  

(1) The Rosemount 5408:SIS has two operational modes: Safety (SIS) and Control/Monitoring. Safety (SIS) mode must be set when used
in Safety Instrumented Systems. Control/Monitoring mode is intended for use in a Basic Process Control System (BPCS).

(2) Solids level measurement is only available when operating in Control/Monitoring mode.

(3) G½ thread form is not available with hazardous locations approvals.

(4) Type A flat face for EN 1092-1 flanges.

(5) Type B1 raised face for EN 1092-1 flanges.

(6) Pressure limit is derated for process temperatures above 100 °F (38 °C), see Figure A-4 for details.

(7) Refer to Figure A-6 for pressure/temperature ratings of Tri-Clamp connection.

(8) Option code PC1 is for cone antennas only, and requires matching flange and antenna sizes. Note that all parabolic antennas come
with an integrated air purge connection.

(9) A minimum gasket thickness of 0.125 in. (3.2 mm) is required for flanges with protective plate design.

(10) The standard alarm setting is high.

(11) Only applies to flanged process connections with welded construction or protective plate design; only applicable to cone antennas (see 
Table A-12 and Table A-13).

(12) Only available with ASME B16.5 flange connections, and materials of construction codes 1 and 7.

(13) Hydrostatic testing is only available for cone antennas and process seal antennas with flanged process connections.

(14) Certificate includes all pressure retaining and wetted parts.

(15) Only available for process seal antennas with Tri-Clamp connection.

(16) Not available with parabolic antenna.

(17) Requires ½-14 NPT conduit/cable threads (code 1). Available with Intrinsically Safe approvals only.
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A.5 Availability of process connections

Cone Antenna - 316/316L SST/EN 1.4404 (Type vs. Size and Rating)Table A-12:   

Process
connec-
tion size

Process connection rating

Thread(1)

ASME B16.5 flanges(2) EN1092-1 flanges(2)
JIS B2220 flang-
es(2)

Class
150 (3)

Class
300(3)

Class
600 (4) PN16 (5) PN40(5) PN63(4) PN100(4) 10K(3) 20K(4)

1½-in. G, N N/A N/A N/A N/A N/A N/A N/A N/A N/A

2-in./
DN50/50A

G, N R R R F F, R F, R F R R

3-in./
DN80/80A

G, N R R R F, R F, R F, R F, R R R

4-in./
DN100/
100A

G, N R R N/A F, R F, R F F R R

6-in./
DN150/
150A

N/A R R N/A F, R F, R N/A N/A R R

8-in./
DN200/
200A

N/A R R N/A F, R F, R N/A N/A R R

(1) BSPP (G) thread (process connection type code G). N = NPT thread (process connection type code N)

(2) F = Flat Face (process connection type code F). R = Raised Face (process connection type code R)

(3) Forged one-piece flange (see Figure A-15).

(4) Welded construction (see Figure A-15).

(5) Welded construction for type A flat face; forged one-piece flange for type B1 raised face.
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Cone Antenna - Alloy C-276 and Alloy 400 (Type vs. Size and Rating)Table A-13:   

Process
connection
size

Process connection rating

Thread(1)

ASME B16.5 flanges(2)(3) EN1092-1 flanges(2)(4)(6)
JIS B2220 flang-
es(2)(6)

Class 150 Class 300 Class 600 PN16 PN40 PN63 10K 20K

1½-in. N N/A N/A N/A N/A N/A N/A N/A N/A

2-in./DN50/
50A

N R(5) R(5) R(5) R R R R R

3-in./DN80/
80A

N/A R(5) R(5) R(5) R R R R R

4-in./
DN100/
100A

N/A R(5) R(5) N/A R R R R R

6-in./
DN150/
150A

N/A R(5) R(6) N/A R R N/A R R

8-in./
DN200/
200A

N/A R(6) N/A N/A R R N/A R R

(1) N = NPT thread (process connection type code N)

(2) R = Raised Face (process connection type code R)

(3) Welded construction for materials of construction codes H and M (see Figure A-15).

(4) Backing flange in flat face.

(5) Available with materials of construction codes 2, 3, H, and M.

(6) Only available with protective plate design (materials of construction codes 2 and 3).

Process Seal Antenna (Type vs. Size and Rating)Table A-14:   

Process con-
nection size

Process connection rating

Tri-Clamp(1)

ASME B16.5 flanges (2)(3) EN1092-1 flanges(2)(3)
JIS B2220
flanges(2)(3)

Class 150 Class 300 PN6 PN16 PN40 10K

2-in./DN50/
50A

C R R R R R R

3-in./DN80/
80A

C R R R R R R

4-in./
DN100/
100A

N/A R R R R R R

(1) C = Tri-Clamp (process connection type code C)

(2) Forged one-piece flange (see Figure A-15).

(3) R = Raised Face (process connection type code R)
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Parabolic Antenna (Type vs. Size and Rating)Table A-15:   

Process connec-
tion size

Process connection rating

Thread(1) Welded(2)

ASME B16.5
Class 150
flange(3)

EN1092-1 PN6
flange(4)

JIS B2220 5K
flange(3)

3½-in. G W N/A N/A N/A

8-in./DN200/
200A

N/A N/A R F R

10-in./DN250/
250A

N/A N/A R F R

(1) G = BSPP (G) thread (process connection type code G)

(2) W = Welded connection (process connection type code W)

(3) R = Raised Face face (process connection type code R)

(4) F = Flat Face face (process connection type code F)

A.6 Spare parts and accessories

Rosemount 5408 and 5408:SIS Spare Parts List - Transmitter HeadTable A-16:   

Model Product Description

5408 Radar Level Transmitter

Profile

A Standard Monitoring & Control Applications

F (1) Functional Safety / SIS Applications

Measurement type

1 Liquid Level Measurement

3 Solids Level Measurement (profile code A only)

4 (2) Liquid & Solids Level Measurement

Performance class

S Standard

Signal output

H 4–20 mA with digital signal based on HART Revision 6 protocol (HART Revision 7 available as option)

Housing material

A Aluminum

S Stainless Steel (SST)

Conduit/cable threads

1 ½-14 NPT

2 M20 x 1.5
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Rosemount 5408 and 5408:SIS Spare Parts List - Transmitter Head (continued)Table A-16:   

3(3) G½

Hazardous locations certifications

NA None

E1 ATEX Flameproof

I1 ATEX Intrinsic Safety

N1 ATEX Type n

E5 USA Explosion-proof, Dust Ignition-proof

I5 USA Intrinsically Safe; Nonincendive

E6 Canadian Explosion-proof, Dust Ignition-proof

I6 Canadian Intrinsically Safe; Nonincendive

E7 IECEx Flameproof, Dust Ignition-proof

I7 IECEx Intrinsic Safety

N7 IECEx Type n

E2 INMETRO Flameproof

I2 INMETRO Intrinsic Safety

N2 INMETRO Type n

E3 China Flameproof

I3 China Intrinsic Safety

N3 China Type n

IP Republic of Korea Intrinsic Safety

Materials of construction

Z None (Spare Transmitter Head)

Process connection type

Z None (Spare Transmitter Head)

Process connection size

Z None (Spare Transmitter Head)

Process connection rating

ZZ None (Spare Transmitter Head)

Antenna type

ZZZ None (Spare Transmitter Head)

Antenna size

Z None (Spare Transmitter Head)

Options (include with selected model number)

Display

M5 LCD Display
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Rosemount 5408 and 5408:SIS Spare Parts List - Transmitter Head (continued)Table A-16:   

Functional safety options

EF1 Ready for upgrade to Rosemount 5408:SIS (profile code A only)

EF2 Extended SIS Package (profile code F only)

Diagnostic functionality

DA1 Smart Diagnostics Suite (see Smart Diagnostics Suite (option code DA1))

HART revision configuration

HR7 4-20 mA with digital signal based on HART Revision 7 protocol

Open air applications configuration (4)

OA Open Air Applications Configuration; LPR (Level Probing Radar) (profile code A only)

Factory configuration

C1 Factory Configuration per Configuration Data Sheet

Alarm limits

C4 NAMUR Alarm and Saturation Levels, High Alarm

C5 NAMUR Alarm and Saturation Levels, Low Alarm

C8 (5) Standard Rosemount Alarm and Saturation Levels, Low Alarm

Special quality assurance

Q4 Calibration Data Certificate

Hygienic certification(6)

QA Certificate of compliance to 3-A

Quality certification for safety (profile code F only)

QS Certificate of FMEDA Data

QT Safety-certified to IEC 61508 with certificate of FMEDA data

Overfill prevention

U1 Overfill Prevention According to WHG/TUV

Extended product warranty

WR3 3-year Limited Warranty

WR5 5-year Limited Warranty

Paint option for aluminum housing (profile code F only)

PY1 Housing and Covers in Yellow per RAL 1003

PY2 Covers in Yellow per RAL 1003

PR1 Housing and Covers in Red per RAL 3002

PR2 Covers in Red per RAL 3002

PO1 Housing and Covers in Orange per Munsell 2.5 YR 6/14

PO2 Covers in Orange per Munsell 2.5 YR 6/14
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Rosemount 5408 and 5408:SIS Spare Parts List - Transmitter Head (continued)Table A-16:   

Conduit electrical connector (shipped uninstalled) (7)

EC M 12, 4-pin, Male connector (eurofast)

MC A size Mini, 4-pin, Male connector (minifast)

Adapter wetted parts (8)

A1 Adapter for Rosemount 5402 Antennas

Specials (see Section A.3.2)

PXXXX Custom Engineered Solutions beyond standard model codes. Consult factory for details.

Typical model number: 5408 A 1 S H A 1 E5 Z Z Z ZZ ZZZ Z M5 DA1

(1) The Rosemount 5408:SIS (profile code F) has two operational modes: Safety (SIS) and Control/Monitoring. Safety (SIS) mode must be
set when used in Safety Instrumented Systems. Control/Monitoring mode is intended for use in a Basic Process Control System (BPCS).

(2) Note that for the Rosemount 5408:SIS (profile code F), solids level measurement is only available when operating in Control/
Monitoring mode.

(3) G½ thread form is not available with hazardous locations approvals.

(4) Only available with parabolic antenna and 4-in. (DN100) cone antenna.

(5) The standard alarm setting is high.

(6) Only available for process seal antennas with Tri-Clamp connection.

(7) Requires ½-14 NPT conduit/cable threads (code 1). Available with Intrinsically Safe approvals only.

(8) Rosemount 5408 is backward compatible with the full range of Rosemount 5402 antennas manufactured after September 2013,
when ordered with the appropriate adapter (option code A1). The Rosemount 5408 transmitter head can also be ordered with a
Rosemount 5402 antenna, or pre-configured to an existing Rosemount 5402 antenna. Contact your Emerson sales representative for
more information.

 

Rosemount 5408 and 5408:SIS Spare Parts List - AntennaTable A-17:   

Model Product Description

5408 Radar Level Transmitter

Profile

Z None (Spare Antenna)

Measurement type

9 None (Spare Antenna)

Performance class

Z None (Spare Antenna)

Signal output

Z None (Spare Antenna)

Housing material

Z None (Spare Antenna)

Conduit/cable threads

Z None (Spare Antenna)
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Rosemount 5408 and 5408:SIS Spare Parts List - Antenna (continued)Table A-17:   

Hazardous locations certifications

NA None

Materials of construction Available antenna types

1 316/316L/ EN 1.4404 Cone, Parabolic

7 All PTFE Wetted Parts Process Seal

2 Alloy C-276 (UNS N10276) with Protective Plate Cone

3 Alloy 400 (UNS N04400) with Protective Plate Cone

H Alloy C-276 (UNS N10276) Process Connection, Flange, and Antenna Cone

M Alloy 400 (UNS N04400) Process Connection, Flange, and Antenna Cone

Process connection type (see Table A-12, Table A-13, Table A-14, and Table A-15) Available antenna types

F (1) Flat Face Flange Cone, Parabolic

R (2) Raised Face Flange All

N NPT Thread Cone

G BSPP (G) Thread Cone, Parabolic

B Bracket Mounting Cone

C Tri-Clamp Process Seal

W Welded Connection Parabolic

Process connection size (see Table A-12, Table A-13, Table A-14, and Table A-15) Available antenna types

A 1½-in. Cone

2 2-in./DN50/50A Cone, Process Seal

3 3-in./DN80/80A Cone, Process Seal

B 3½-in. Parabolic

4 4-in./DN100/100A Cone, Process Seal

6 6-in./DN150/150A Cone

8 8-in./DN200/200A Cone, Parabolic

T 10-in./DN250/250A Parabolic

Z None (use when ordering bracket mounting) Cone

Process connection rating (see Table A-12, Table A-13, Table A-14, and Table A-15)

ZZ For use with non-flange process connection type

ASME flanges

AA ASME B16.5 Class 150

AB ASME B16.5 Class 300

AC ASME B16.5 Class 600

EN flanges Note

DK EN1092-1 PN6 N/A

DA EN1092-1 PN16 PN10 and PN16 dimensions are identical for DN50 to DN150
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Rosemount 5408 and 5408:SIS Spare Parts List - Antenna (continued)Table A-17:   

DB EN1092-1 PN40 PN25 and PN40 dimensions are identical for DN50 to DN150

DC EN1092-1 PN63 N/A

DD EN1092-1 PN100 N/A

JIS flanges

JK JIS 5K

JA JIS 10K

JB JIS 20K

Antenna type Operating pressure Operating temperature

CAA Cone Antenna (PTFE seal) -15 to 363 psig (-1 to 25 bar) -76 to 392 °F (-60 to 200 °C)

CAB Cone Antenna (PTFE seal) -15 to 725 psig (-1 to 50 bar) (3) -40 to 302 °F (-40 to 150 °C)

CAC Cone Antenna (PTFE seal) -15 to 1450 psig (-1 to 100 bar) -40 to 212 °F (-40 to 100 °C)

CAD Cone Antenna (PTFE seal) -15 to 44 psig (-1 to 3 bar) -76 to 482 °F (-60 to 250 °C)

CBF Cone Antenna (PEEK seal, FVMQ) -15 to 754 psig (-1 to 52 bar) -76 to 338 °F (-60 to 170 °C)

CBK Cone Antenna (PEEK seal, Kalrez 6375) -15 to 754 psig (-1 to 52 bar) 5 to 482 °F (-15 to 250 °C)

CBM Cone Antenna (PEEK seal, FKM) -15 to 754 psig (-1 to 52 bar) -13 to 428 °F (-25 to 220 °C)

CBV Cone Antenna (PEEK seal, Viton) -15 to 754 psig (-1 to 52 bar) -22 to 392 °F (-30 to 200 °C)

SAA Process Seal Antenna -7 to 363 psig (-0.5 to 25 bar) (4) -76 to 392 °F (-60 to 200 °C)(4)

PAS Parabolic Antenna, Swivel Mount -7 to 43 psig (-0.5 to 3 bar) -67 to 392 °F (-55 to 200 °C)

Antenna size Available antenna types

2 2-in. (DN50) Cone, Process Seal

3 3-in. (DN80) Cone, Process Seal

4 4-in. (DN100) Cone, Process Seal

8 8-in. (DN200) Parabolic

Options (include with selected model number)

Antenna extensions (see Figure A-11) Total length

S1 Extended Cone Antenna 24-in. (600 mm)

S2 Extended Cone Antenna, Segmented 48-in. (1200 mm)

Purging connection (5)(6)

PC1 Purging Connector (Purge Ring)

Welding standard for flanges (7)

AW According to ASME IX

EW According to EN-ISO

Country certification(8)

J1 Canadian Registration (CRN)
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Rosemount 5408 and 5408:SIS Spare Parts List - Antenna (continued)Table A-17:   

Hydrostatic testing (9)

Q5 Hydrostatic Testing, including certificate

Material traceability certification (10)

Q8 Material Traceability Certification per EN 10204 3.1 (2.1 for non-metallic)

Hygienic certification(11)

QA Certificate of compliance to 3-A

Materials certification (12)

Q15 NACE Material Recommendation per NACE MR0175/ISO 15156

Q25 NACE Material Recommendation per ANSI/NACE MR0103/ISO 17495-1

Q35 NACE Material Recommendation per NACE MR0175/ISO 15156 and ANSI/NACE MR0103/ISO 17495-1

Welding procedure qualification record documentation(7)

Q66 Welding Procedure Qualification Record (WPQR)

Q67 Welder Performance Qualification (WPQ)

Q68 Welding Procedure Specification (WPS)

Q79 WPQR/WPQ/WPS

Dye penetration test certificate(7)

Q73 Certificate of Liquid Penetrant Inspection

Positive material identification certificate

Q76 Positive Material Identification Certificate of Conformance

Extended product warranty

WR3 3-year Limited Warranty

WR5 5-year Limited Warranty

Specials (see Section A.3.2)

PXXXX Custom Engineered Solutions beyond standard model codes. Consult factory for details.

Typical model number: 5408 Z 9 Z Z Z Z NA 1 R 3 AB CAB 3

(1) Type A flat face for EN 1092-1 flanges.

(2) Type B1 raised face for EN 1092-1 flanges.

(3) Pressure limit is derated for process temperatures above 100 °F (38 °C), see Figure A-4 for details.

(4) Refer to Figure A-6 for pressure/temperature ratings of Tri-Clamp connection.

(5) Option code PC1 is for cone antennas only, and requires matching flange and antenna sizes. Note that all parabolic antennas come
with an integrated air purge connection.

(6) A minimum gasket thickness of 0.125 in. (3.2 mm) is required for flanges with protective plate design.

(7) Only applies to flanged process connections with welded construction or protective plate design; only applicable to cone antennas (see 
Table A-12 and Table A-13).

(8) Only available with ASME B16.5 flange connections, and materials of construction codes 1 and 7.

(9) Hydrostatic testing is only available for cone antennas and process seal antennas with flanged process connections.

(10) Certificate includes all pressure retaining and wetted parts.
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(11) Only available for process seal antennas with Tri-Clamp connection.

(12) Not available with parabolic antenna.

A.6.1 Accessories

AccessoriesTable A-18:   

HART modem and cable

03300-7004-0002 MACTek® VIATOR® HART modem and cables (USB connection)
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A.7 Dimensional drawings

Cone AntennaFigure A-11:   
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Cone Antenna DimensionsTable A-19:   

Cone size A B L

2-in. (DN50) 6.10 in. (155 mm) 1.85 in. (47 mm) 5.39 in. (137 mm)

3-in. (DN80) 6.02 in. (153 mm) 2.64 in. (67 mm) 6.77 in. (172 mm)

4-in. (DN100) 6.93 in. (176 mm) 3.62 in. (92 mm) 7.80 in. (198 mm)

Process Seal AntennaFigure A-12:   
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Parabolic AntennaFigure A-13:   
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Bracket Mounting (Process Connection Type Code B)Figure A-14:   
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A.7.1 Standard flanges

Cone Antenna Flange ConnectionFigure A-15:   

A. Forged one-piece
B. Welded construction
C. Protective plate design
D. Weld
E. Backing flange
F. Protective plate

Standard Flanges for Cone AntennaTable A-20:   

Standard Face type (1) Face surface finish, Ra Material

ASME B16.5 Raised face 125-250 µin 316/316L SST

EN 1092-1 Type B1 raised face 3.2-12.5 µm EN 1.4404

Type A flat face 3.2-12.5 µm EN 1.4404

JIS B2220 Raised face 3.2-6.3 µm EN 1.4404

(1) Face gasket surface is serrated per mating standard.

Cone Antennas with Protective PlateTable A-21:   

Standard Face type including protective plate Plate surface finish, Ra Material

ASME B16.5 Raised face 3.2-6.3 µm 316/316L SST

EN 1092-1 Raised face 3.2-6.3 µm EN 1.4404

JIS B2220 Raised face 3.2-6.3 µm EN 1.4404

Parabolic Antenna Flange ConnectionFigure A-16:   
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Standard Flanges for Parabolic AntennaTable A-22:   

Standard Face type (1) Face surface finish Material

ASME B16.5 Raised face 125-250 µin 316/316L SST

EN 1092-1 Type A flat face 3.2-12.5 µm EN 1.4404

JIS B2220 Raised face 3.2-12.5 µm EN 1.4404

(1) Face gasket surface is serrated per mating standard.
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Appendix B
Product Certifications

Rev 2.3

B.1 European directive information
A copy of the EU Declaration of Conformity can be found at the end of the Rosemount™

5408 and 5408:SIS Product Certifications document. The most recent revision of the EU
Declaration of Conformity can be found at Emerson.com/Rosemount.

B.2 Safety Instrumented Systems (SIS)
SIL 3 Capable: IEC 61508 certified for use in safety instrumented systems up to SIL 3
(Minimum requirement of single use (1oo1) for SIL 2 and redundant use (1oo2) for SIL 3).

B.3 Telecommunication compliance
Measurement principle

Frequency Modulated Continuous Wave (FMCW), 26 GHz

Maximum output power

-5 dBm (0.32 mW)

Frequency range

24.05 to 27.0(1) GHz (TLPR)

24.05 to 26.5 GHz (LPR)

LPR (Level Probing Radar) equipment are devices for measurement of level in the open air
or in a closed space. Model option “OA”. Hardware Version Identification Number (HVIN) is
5408L.

TLPR (Tank Level Probing Radar) equipment are devices for measurement of level in a
closed space only (i.e metallic, concrete or reinforced fiberglass tanks, or similar enclosure
structures made of comparable attenuating material). Hardware Version Identification
Number (HVIN) is 5408T.

(1) 26.5 GHz in Australia and New Zealand.
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B.4 FCC
Note: This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed and
used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one or more of the following
measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

FCC ID: K8C5408L (for LPR)

K8C5408T (for TLPR)

B.5 IC
This device complies with Industry Canada’s licence-exempt RSS standard. Operation is
subject to the following conditions:

1. This device may not cause interference.

2. This device must accept any interference received, including interference that may
cause undesired operation.

3. The installation of the LPR/TLPR device shall be done by trained installers in strict
compliance with the manufacturer’s instructions.

4. The use of this device is on a “no-interference, no-protection” basis. That is, the user
shall accept operations of high-powered radar in the same frequency band which
may interfere with or damage this device. However, devices found to interfere with
primary licensing operations will be required to be removed at the user’s expense.

5. Devices operating under TLPR conditions (i.e. not operating in “Open Air” Mode)
shall be installed and operated in a completely enclosed container to prevent RF
emissions, which can otherwise interfere with aeronautical navigation.

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils
radio exempts de licence. L'exploitation est autorisée aux conditions suivantes:

1. l'appareil ne doit pas produire de brouillage.
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2. l'utilisateur de l'appareil doit accepter tout brouillage radioélectrique subi, même si
le brouillage est susceptible d'en compromettre le fonctionnement.

3. L’installation d’un dispositif LPR ou TLPR doit être effectuée par des installateurs
qualifiés, en pleine conformité avec les instructions du fabricant.

4. Ce dispositif ne peut être exploité qu'en régime de non-brouillage et de non-
protection, c'est-à-dire que l'utilisateur doit accepter que des radars de haute
puissance de la même bande de fréquences puissent brouiller ce dispositif ou même
l'endommager. D'autre part, les capteurs de niveau qui perturbent une exploitation
autorisée par licence de fonctionnement principal doivent être enlevés aux frais de
leur utilisateur.

5. Un dispositif visé comme TLPR (“Open Air”) doit être installé et exploité dans un
réservoir entièrement fermé afin de prévenir les rayonnements RF qui pourraient
autrement perturber la navigation aéronautique.

Certificate: 2827A-5408L (for LPR)

2827A-5408T (for TLPR)

B.6 Radio Equipment Directive (RED) 2014/53/EU
This device complies with ETSI EN 302 372 (TLPR), ETSI EN 302 729 (LPR) and EN 62479.

For the receiver test that covers the influence of an interferer signal to the device, the
performance criterion has at least the following level of performance according to ETSI TS
103 361 [6].

• Performance criterion: measurement value variation Δd over time during a distance
measurement

• Level of performance: Δd ≤ ±2 mm

LPR (Level Probing Radar), model code “OA”

Install at a separation distance of >4 km from Radio Astronomy sites, unless a special
authorization has been provided by the responsible National regulatory authority (a list of
Radio Astronomy sites may be found at www.craf.eu).

Between 4 km to 40 km around any Radio Astronomy site the LPR antenna height shall not
exceed 15 m height above ground.

TLPR (Tank Level Probing Radar)

The device must be installed in closed tanks. Install according to requirements in ETSI EN
302 372 (Annex E).
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B.7 Installing equipment in North America
The US National Electrical Code® (NEC) and the Canadian Electrical Code (CEC) permit the
use of Division marked equipment in Zones and Zone marked equipment in Divisions. The
markings must be suitable for the area classification, gas, and temperature class. This
information is clearly defined in the respective codes.

B.8 U.S.A.

B.8.1 E5 Explosionproof (XP), Dust-Ignitionproof (DIP)

Certificate: FM-US FM16US0010X

Standards: FM Class 3600 – 2011; FM Class 3615 – 2006; FM Class 3810 – 2005; ANSI/
ISA 60079-0 – 2013; ANSI/UL 60079-1 – 2015; ANSI/ISA 60079-26 – 2011;
ANSI/ISA 60079-31 – 2015; ANSI/NEMA® 250 – 1991; ANSI/IEC 60529 –
2004, ANSI/ISA 12.27.01:2011

Markings: XP CL I, DIV 1, GRPS A, B, C, D T6…T2
DIP CLII/III, DIV 1, GRPS E, F, G; T6...T3
CL I Zone 0/1 AEx db IIC T6…T2 Ga/Gb
Zone 21 AEx tb IIIC T85 °C…T250 °C Db
(-40°C ≤ Ta ≤ +70°C) (2); Type 4X/IP6X
SINGLE SEAL

Specific Conditions of Use (X):

1. Flamepath joints are not for repair. Contact the manufacturer.

2. Plastic wire-on tag, Plastic part of Process Seal Antenna and Non-standard paint
options (paint options other than Rosemount Blue) may cause risk from
Electrostatic discharge. Avoid installation that could cause electrostatic build-up,
and only clean with a damp cloth.

3. Appropriate cable, glands, and plugs need to be suitable for a temperature of 5°C
greater than the maximum specified ambient temperature for location where
installed.

4. The Transmitter can be installed in the boundary wall between a Zone 0 and Zone 1
area. In this configuration, the process connection is installed in Zone 0, while the
transmitter housing is installed in Zone 1. Refer to Control Drawing D7000002-885.

5. Cable entries must be used which maintain the ingress protection of the enclosure
to at least IP6X and/or Type 4X rating. To maintain the ingress protection ratings.
Covers and Sensor Module to be fully tightened and PTFE tape or pipe dope is
required for cable entries and blanking plugs. See Instruction Manual on application
requirements.

6. Install per Control drawing D7000002-885.

(2) Other temperature ranges may apply, see Specific Conditions of Use (X).
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7. Using the box provided on the nameplate, the User shall permanently mark the type
of protection chosen for the specific installation. Once the type of protection has
been marked it shall not be changed.

8. Display glass shall be positioned in such a way as to minimize the risk of mechanical
impact.

9. The applicable temperature class, ambient temperature range and process
temperature range of the equipment is as follows;

For Divisions:Table B-1:   

Temperature class / Maximum
surface temperature Ambient temperature range Process temperature range

Division Gas groups:   

T2 -40°C ≤ Ta ≤ 70°C -40°C to 250°C

T3 -40°C ≤ Ta ≤ 70°C -40°C to 195°C

T4 -40°C ≤ Ta ≤ 70°C -40°C to 130°C

T5 -40°C ≤ Ta ≤ 70°C -40°C to 95°C

T6 -40°C ≤ Ta ≤ 70°C -40°C to 80°C

Division Dust groups:   

T3 -50°C ≤ Ta ≤ 70°C -50°C to 160°C

T4 -50°C ≤ Ta ≤ 70°C -50°C to 130°C

T5 -50°C ≤ Ta ≤ 70°C -50°C to 95°C

T6 -50°C ≤ Ta ≤ 70°C -50°C to 80°C

For Zones:Table B-2:   

Temperature class / Maximum
surface temperature Ambient temperature range Process temperature range

Zone Gas groups:   

T2 -50°C ≤ Ta ≤ 70°C -50°C to 250°C

T3 -50°C ≤ Ta ≤ 70°C -50°C to 195°C

T4 -50°C ≤ Ta ≤ 70°C -50°C to 130°C

T5 -50°C ≤ Ta ≤ 70°C -50°C to 95°C

T6 -50°C ≤ Ta ≤ 70°C -50°C to 80°C

Zone Dust groups:   

T250°C -60°C ≤ Ta ≤ 70°C -60°C to 250°C

T200°C -60°C ≤ Ta ≤ 70°C -60°C to 195°C

T135°C -60°C ≤ Ta ≤ 70°C -60°C to 130°C

T100°C -60°C ≤ Ta ≤ 70°C -60°C to 95°C

T85°C -60°C ≤ Ta ≤ 70°C -60°C to 80°C
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B.8.2 I5 Intrinsic Safety (IS), Non-Incendive (NI)

Certificate: FM-US FM16US0010X

Standards: FM Class 3600 – 2011; FM Class 3610 – 2015; FM Class 3611 – 2016; FM
Class 3810 – 2005; ANSI/ISA 60079-0 – 2013; ANSI/ISA 60079-11 – 2013;
ANSI/ISA 60079-26 – 2011; ANSI/NEMA 250 – 1991; ANSI/IEC 60529 –
2004; ANSI/ISA 12.27.01:2011

Markings: IS CL I, ll, lll DIV 1, GRPS A-G T4…T2
NI CL I, DIV 2, GRPS A-D T4…T2
S CL Il, lll DIV 2, GRPS E-G T4…T3
CL l Zone 0 AEx ia IIC T4...T2 Ga
CL l Zone 0/1 AEx ib IIC T4...T2 Ga/Gb
Zone 20 AEx ia IIIC T85°C…T250°C Da
(-60°C ≤ Ta ≤ +70°C)
When installed per Control Drawing D7000002-885
SINGLE SEAL

Safety parameter HART®

Voltage Ui 30 V

Current Ii 133 mA

Power Pi 1.0 W

Capacitance Ci 7.3 nF

Inductance Li 0

Specific Conditions of Use (X):

1. The Model 5408 Level Transmitter will not pass the 500Vrms dielectric strength test
between the circuits and the earth ground. This must be taken into account during
installation.

2. Plastic wire-on tag, Plastic part of Process Seal Antenna and Non-standard paint
options (paint options other than Rosemount Blue) may cause risk from
Electrostatic discharge. Avoid installation that could cause electrostatic build-up,
and only clean with a damp cloth.

3. Appropriate cable, glands, and plugs need to be suitable for a temperature of 5°C
greater than the maximum specified ambient temperature for location where
installed.

4. The Transmitter can be installed in the boundary wall between a Zone 0 and Zone 1
area. In this configuration, the process connection is installed in Zone 0, while the
transmitter housing is installed in Zone 1. Refer to Control Drawing D7000002-885.

5. Using the box provided on the nameplate, the User shall permanently mark the type
of protection chosen for the specific installation. Once the type of protection has
been marked it shall not be changed.
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6. The applicable temperature class, ambient temperature range and process
temperature range if the equipment is as follows;

For Divisions:Table B-3:   

Temperature class / Maximum
surface temperature Ambient temperature range Process temperature range

Division Gas groups:   

T2 -60°C ≤ Ta ≤ 70°C -60°C to 250°C

T3 -60°C ≤ Ta ≤ 70°C -60°C to 195°C

T4 -60°C ≤ Ta ≤ 70°C -60°C to 130°C

Division Dust groups:   

T3 -60°C ≤ Ta ≤ 70°C -60°C to 160°C

T4 -60°C ≤ Ta ≤ 70°C -60°C to 130°C

T5 -60°C ≤ Ta ≤ 70°C -60°C to 95°C

T6 -60°C ≤ Ta ≤ 70°C -60°C to 80°C

For Zones:Table B-4:   

Temperature class / Maximum
surface temperature Ambient temperature range Process temperature range

Zone Gas groups:   

T2 -60°C ≤ Ta ≤ 70°C -60°C to 250°C

T3 -60°C ≤ Ta ≤ 70°C -60°C to 195°C

T4 -60°C ≤ Ta ≤ 70°C -60°C to 130°C

Zone Dust groups:   

T250°C -60°C ≤ Ta ≤ 70°C -60°C to 250°C

T200°C -60°C ≤ Ta ≤ 70°C -60°C to 195°C

T135°C -60°C ≤ Ta ≤ 70°C -60°C to 130°C

T100°C -60°C ≤ Ta ≤ 70°C -60°C to 95°C

T85°C -60°C ≤ Ta ≤ 70°C -60°C to 80°C

B.9 Canada

B.9.1 E6 Explosionproof, Dust-Ignitionproof

Certificate: FM-C FM16CA0011X
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Standards: C22.2 NO. 0.4-04:2004 (R2013), C22.2 NO. 0.5-16:2016, C22.2 No.
25-1966:1966 (R:2014), C22.2 No.30-M1986:1986 (R:2012), C22.2 No.94-
M91:1991 (R:2011), C22.2 No. 1010.1:2004, CAN/CSA C22.2 No.
60079-0:2015 Ed. 3, C22.2 No. 60079-1:2016 Ed. 3, C22.2 No.
60079-26:2016; CAN/CSA-C22.2 No. 60079-31:2015, C22.2. 60529:2005
(R:2015), ANSI/ISA 12.27.01:2011

Markings: XP CL I, DIV 1, GRPS A-D T6…T2
DIP CLII/III, DIV 1, GRPS E-G; T6...T3
Ex db IIC T6…T3 Gb
Ex tb IIIC T85 °C…T250°C Db
(-40°C ≤ Ta ≤ +70°C) (3); Type 4X/IP6X
SINGLE SEAL

Specific Conditions of Use (X):

1. Flamepath joints are not for repair. Contact the manufacturer.

2. Plastic wire-on tag, Plastic part of Process Seal Antenna and Non-standard paint
options (paint options other than Rosemount Blue) may cause risk from
Electrostatic discharge. Avoid installation that could cause electrostatic build-up,
and only clean with a damp cloth.

3. Appropriate cable, glands, and plugs need to be suitable for a temperature of 5°C
greater than the maximum specified ambient temperature for location where
installed.

4. Metric Field Wiring Entries are not allowed for Divisions.

5. The Transmitter can be installed in the boundary wall between a Zone 0 and Zone 1
area. In this configuration, the process connection is installed in Zone 0, while the
transmitter housing is installed in Zone 1. Refer to Control Drawing D7000002-885.

6. Cable entries must be used which maintain the ingress protection of the enclosure
to at least IP6X and/or Type 4X rating. To maintain the ingress protection ratings.
Covers and Sensor Module to be fully tightened and PTFE tape or pipe dope is
required for cable entries and blanking plugs. See Instruction Manual on application
requirements.

7. Install per Control Drawing D7000002-885.

8. Using the box provided on the nameplate, the User shall permanently mark the type
of protection chosen for the specific installation. Once the type of protection has
been marked it shall not be changed.

9. Display glass shall be positioned in such a way as to minimize the risk of mechanical
impact.

10. The applicable temperature class, ambient temperature range and process
temperature range of the equipment is as follows;

(3) Other temperature ranges may apply, see Specific Conditions of Use (X).
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For Divisions:Table B-5:   

Temperature class / Maximum
surface temperature Ambient temperature range Process temperature range

Division Gas groups:   

T2 -40°C ≤ Ta ≤ 70°C -40°C to 250°C

T3 -40°C ≤ Ta ≤ 70°C -40°C to 195°C

T4 -40°C ≤ Ta ≤ 70°C -40°C to 130°C

T5 -40°C ≤ Ta ≤ 70°C -40°C to 95°C

T6 -40°C ≤ Ta ≤ 70°C -40°C to 80°C

Division Dust groups:   

T3 -50°C ≤ Ta ≤ 70°C -50°C to 160°C

T4 -50°C ≤ Ta ≤ 70°C -50°C to 130°C

T5 -50°C ≤ Ta ≤ 70°C -50°C to 95°C

T6 -50°C ≤ Ta ≤ 70°C -50°C to 80°C

For Zones:Table B-6:   

Temperature class / Maximum
surface temperature Ambient temperature range Process temperature range

Zone Gas groups:   

T2 -50°C ≤ Ta ≤ 70°C -50°C to 250°C

T3 -50°C ≤ Ta ≤ 70°C -50°C to 195°C

T4 -50°C ≤ Ta ≤ 70°C -50°C to 130°C

T5 -50°C ≤ Ta ≤ 70°C -50°C to 95°C

T6 -50°C ≤ Ta ≤ 70°C -50°C to 80°C

Zone Dust groups:   

T250°C -60°C ≤ Ta ≤ 70°C -60°C to 250°C

T200°C -60°C ≤ Ta ≤ 70°C -60°C to 195°C

T135°C -60°C ≤ Ta ≤ 70°C -60°C to 130°C

T100°C -60°C ≤ Ta ≤ 70°C -60°C to 95°C

T85°C -60°C ≤ Ta ≤ 70°C -60°C to 80°C

B.9.2 I6 Intrinsically Safe and Non-Incendive Systems

Certificate: FM-C FM16CA0011X

Standards: C22.2 NO. 0.4-04:2004 (R2013), C22.2 NO. 0.5-16:2016, C22.2 No.
25-1966:1966 (R:2014), C22.2 No.94-M91:1991 (R:2011), C22.2 No.
213-16:2016, C22.2 No. 1010.1:2004, CAN/CSA C22.2 No. 60079-0:2015
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Ed. 3, CAN/CSAC22.2 No. 60079-11:2014 Ed. 2, CAN/CSAC22.2 No.
60079-15:2015 Ed.2, C22.2 No. 60079-26:2016, C22.2. 60529:2005 (R:
2015); ANSI/ISA 12.27.01:2011

Markings: IS CL I, ll, lll DIV 1, GRPS A-G T4…T2
NI CL I, DIV 2, GRPS A-D T4…T2
S CL Il, lll DIV 2, GRPS E-G T4…T3
Ex ia IIC T4...T2 Ga
Ex ib IIC T4...T2 Ga/Gb
Ex ia IIIC T85°C…T250°C Da
(-60°C ≤ Ta ≤ +70°C)
When installed per Control Drawing D7000002-885
SINGLE SEAL

Safety parameter HART

Voltage Ui 30 V

Current Ii 133 mA

Power Pi 1.0 W

Capacitance Ci 7.3 nF

Inductance Li 0

Specific Conditions of Use (X):

1. The Model 5408 Level Transmitter will not pass the 500Vrms dielectric strength test
between the circuits and the earth ground. This must be taken into account during
installation.

2. Plastic wire-on tag, Plastic part of Process Seal Antenna and Non-standard paint
options (paint options other than Rosemount Blue) may cause risk from
Electrostatic discharge. Avoid installation that could cause electrostatic build-up,
and only clean with a damp cloth.

3. Appropriate cable, glands, and plugs need to be suitable for a temperature of 5°C
greater than the maximum specified ambient temperature for location where
installed.

4. The Transmitter can be installed in the boundary wall between a Zone 0 and Zone 1
area. In this configuration, the process connection is installed in Zone 0, while the
transmitter housing is installed in Zone 1. Refer to Control Drawing D7000002-885.

5. Using the box provided on the nameplate, the User shall permanently mark the type
of protection chosen for the specific installation. Once the type of protection has
been marked it shall not be changed.

6. The applicable temperature class, ambient temperature range and process
temperature range of the equipment is as follows;
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For Divisions:Table B-7:   

Temperature class / Maximum
surface temperature Ambient temperature range Process temperature range

Division Gas groups:   

T2 -60°C ≤ Ta ≤ 70°C -60°C to 250°C

T3 -60°C ≤ Ta ≤ 70°C -60°C to 195°C

T4 -60°C ≤ Ta ≤ 70°C -60°C to 130°C

Division Dust groups:   

T3 -60°C ≤ Ta ≤ 70°C -60°C to 160°C

T4 -60°C ≤ Ta ≤ 70°C -60°C to 130°C

T5 -60°C ≤ Ta ≤ 70°C -60°C to 95°C

T6 -60°C ≤ Ta ≤ 70°C -60°C to 80°C

For Zones:Table B-8:   

Temperature class / Maximum
surface temperature Ambient temperature range Process temperature range

Zone Gas groups:   

T2 -60°C ≤ Ta ≤ 70°C -60°C to 250°C

T3 -60°C ≤ Ta ≤ 70°C -60°C to 195°C

T4 -60°C ≤ Ta ≤ 70°C -60°C to 130°C

Zone Dust groups:   

T250°C -60°C ≤ Ta ≤ 70°C -60°C to 250°C

T200°C -60°C ≤ Ta ≤ 70°C -60°C to 195°C

T135°C -60°C ≤ Ta ≤ 70°C -60°C to 130°C

T100°C -60°C ≤ Ta ≤ 70°C -60°C to 95°C

T85°C -60°C ≤ Ta ≤ 70°C -60°C to 80°C

B.10 Europe

B.10.1 E1 ATEX Flameproof

Certificate: FM15ATEX0055X

Standards: EN 60079-0:2012, EN 60079-1:2014, EN 60079-26:2015, EN
60079-31:2014, EN 60529+A1+A2:2013

Markings: II 1/2G Ex db IIC T6…T2 Ga/Gb
II 2D Ex tb IIIC T85°C… T250°C Db, IP6X
(-60°C ≤ Ta ≤ +70 °C)
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Specific Conditions of Use (X):

1. Flamepath joints are not for repair. Contact the manufacturer.

2. Plastic wire-on tag, Plastic part of Process Seal Antenna and Non-standard paint
options (paint options other than Rosemount Blue) may cause risk from
Electrostatic discharge. Avoid installation that could cause electrostatic build-up,
and only clean with a damp cloth.

3. Appropriate cable, glands, and plugs need to be suitable for a temperature of 5°C
greater than the maximum specified ambient temperature for location where
installed.

4. The Transmitter can be installed in the boundary wall between a Category 1 and
Category 2 location. In this configuration, the process connection is installed in
Category 1, while the transmitter housing is installed in Category 2. Refer to Control
Drawing D7000002-885.

5. Cable entries must be used which maintain the ingress protection of the enclosure
to at least IP6X. To maintain the ingress protection ratings. Covers and Sensor
Module to be fully tightened and PTFE tape or pipe dope is required for cable entries
and blanking plugs. See Instruction Manual on application requirements.

6. Install per Control Drawing D7000002-885.

7. Using the box provided on the nameplate, the User shall permanently mark the type
of protection chosen for the specific installation. Once the type of protection has
been marked it shall not be changed.

8. Display glass shall be positioned in such a way as to minimize the risk of mechanical
impact.

9. The applicable temperature class, ambient temperature range and process
temperature range of the equipment is as follows;

Temperature class / Maximum
surface temperature Ambient temperature range Process temperature range

Gas & Dust groups:   

T2 / T250°C -60°C ≤ Ta ≤ 70°C -60°C to 250°C

T3 / T200°C -60°C ≤ Ta ≤ 70°C -60°C to 195°C

T4 / T135°C -60°C ≤ Ta ≤ 70°C -60°C to 130°C

T5 / T100°C -60°C ≤ Ta ≤ 70°C -60°C to 95°C

T6 / T85°C -60°C ≤ Ta ≤ 70°C -60°C to 80°C

B.10.2 I1 ATEX Intrinsic Safety

Certificate: FM15ATEX0055X

Standards: EN 60079-0:2012, EN 60079-11:2012, EN 60079-26:2015

Markings: II 1G Ex ia IIC T4…T2 Ga
II 1/2G Ex ib IIC T4…T2 Ga/Gb
II 1D Ex ia IIIC T85°C…T250°C Da
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(-60°C ≤ Ta ≤ +70°C)

Safety parameter HART

Voltage Ui 30 V

Current Ii 133 mA

Power Pi 1.0 W

Capacitance Ci 7.3 nF

Inductance Li 0

Specific Conditions of Use (X):

1. The Model 5408 Level Transmitter will not pass the 500Vrms dielectric strength test
between the circuits and the earth ground. This must be taken into account during
installation.

2. Plastic wire-on tag, Plastic part of Process Seal Antenna and Non-standard paint
options (paint options other than Rosemount Blue) may cause risk from
Electrostatic discharge. Avoid installation that could cause electrostatic build-up,
and only clean with a damp cloth.

3. Appropriate cable, glands, and plugs need to be suitable for a temperature of 5°C
greater than the maximum specified ambient temperature for location where
installed.

4. The Transmitter can be installed in the boundary wall between a Category 1 and
Category 2 location. In this configuration, the process connection is installed in
Category 1, while the transmitter housing is installed in Category 2. Refer to Control
Drawing D7000002-885.

5. Using the box provided on the nameplate, the User shall permanently mark the type
of protection chosen for the specific installation. Once the type of protection has
been marked it shall not be changed.

6. The applicable temperature class, ambient temperature range and process
temperature range of the equipment is as follows;

Temperature class / Maximum
surface temperature Ambient temperature range Process temperature range

Gas groups:   

T2 -60°C ≤ Ta ≤ 70°C -60°C to 250°C

T3 -60°C ≤ Ta ≤ 70°C -60°C to 195°C

T4 -60°C ≤ Ta ≤ 70°C -60°C to 130°C

Dust groups:   

T250°C -60°C ≤ Ta ≤ 70°C -60°C to 250°C

T200°C -60°C ≤ Ta ≤ 70°C -60°C to 195°C

T135°C -60°C ≤ Ta ≤ 70°C -60°C to 130°C

T100°C -60°C ≤ Ta ≤ 70°C -60°C to 95°C
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Temperature class / Maximum
surface temperature Ambient temperature range Process temperature range

T85°C -60°C ≤ Ta ≤ 70°C -60°C to 80°C

B.10.3 N1 ATEX Type N: Non-Sparking

Certificate: FM15ATEX0056X

Standards: EN 60079-0:2012, EN 60079-15:2010

Markings: II 3G Ex nA IIC T4…T2 Gc, IP65
(-34°C ≤ Ta ≤ +70°C)
V ≤ 42.4V, I ≤ 23 mA

Specific Conditions of Use (X):

1. The Model 5408 Level Transmitter will not pass the 500Vrms dielectric strength test
between the circuits and the earth ground. This must be taken into account during
installation.

2. Plastic part of Process Seal Antenna may cause risk from Electrostatic discharge.
Avoid installation that could cause electrostatic build-up, and only clean with a
damp cloth.

3. Cable entries must be used which maintain the ingress protection of the enclosure
to at least IP65. To maintain the ingress protection ratings, Covers and Sensor
Module to be fully tightened and PTFE tape or pipe dope is required for cable entries
and blanking plugs. See Instruction Manual on application requirements.

4. The applicable temperature class, ambient temperature range and process
temperature range of the equipment is as follows;

Temperature class Ambient temperature range Process temperature range

T2 -34°C ≤ Ta ≤ 70°C -34°C to 250°C

T3 -34°C ≤ Ta ≤ 70°C -34°C to 195°C

T4 -34°C ≤ Ta ≤ 70°C -34°C to 130°C

B.11 International

B.11.1 E7 IECEx Flameproof

Certificate: IECEx FMG15.0033X

Standards: IEC 60079-0:2011, IEC 60079-1:2014; IEC 60079-26:2014, IEC
60079-31:2013

Markings Ex db IIC T6…T2 Ga/Gb
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Ex tb IIIC T85 °C…T250°C Db IP6X
(-60°C ≤ Ta ≤ +70 °C)

Specific Conditions of Use (X):

1. Flamepath joints are not for repair. Contact the manufacturer.

2. Plastic wire-on tag, Plastic part of Process Seal Antenna and Non-standard paint
options (paint options other than Rosemount Blue) may cause risk from
Electrostatic discharge. Avoid installation that could cause electrostatic build-up,
and only clean with a damp cloth.

3. Appropriate cable, glands, and plugs need to be suitable for a temperature of 5°C
greater than the maximum specified ambient temperature for location where
installed.

4. The Transmitter can be installed in the boundary wall between EPL Ga and EPL Gb. In
this configuration, the process connection is EPL Ga, while the transmitter housing is
EPL Gb. Refer to Control Drawing D7000002-885.

5. Cable entries must be used which maintain the ingress protection of the enclosure
to at least IP6X. To maintain the ingress protection ratings, Covers and Sensor
Module to be fully tightened and PTFE tape or pipe dope is required for cable entries
and blanking plugs. See Instruction Manual on application requirements.

6. Install per Control Drawing D7000002-885.

7. Using the box provided on the nameplate, the User shall permanently mark the type
of protection chosen for the specific installation. Once the type of protection has
been marked it shall not be changed.

8. Display glass shall be positioned in such a way as to minimize the risk of mechanical
impact.

9. The applicable temperature class, ambient temperature range and process
temperature range of the equipment is as follows;

Temperature class / Maximum
surface temperature Ambient temperature range Process temperature range

Gas & Dust groups:   

T2 / T250°C -60°C ≤ Ta ≤ 70°C -60°C to 250°C

T3 / T200°C -60°C ≤ Ta ≤ 70°C -60°C to 195°C

T4 / T135°C -60°C ≤ Ta ≤ 70°C -60°C to 130°C

T5 / T100°C -60°C ≤ Ta ≤ 70°C -60°C to 95°C

T6 / T85°C -60°C ≤ Ta ≤ 70°C -60°C to 80°C

B.11.2 I7 IECEx Intrinsic Safety

Certificate: IECEx FMG15.0033X

Standards: IEC 60079-0:2011, IEC 60079-11:2011, IEC 60079-26:2014

Markings: Ex ia IIC T4…T2 Ga
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Ex ib IIC T4…T2 Ga/Gb
Ex ia IIIC T85°C…T250°C Da
(-60°C ≤ Ta ≤ +70°C)

Safety parameter HART

Voltage Ui 30 V

Current Ii 133 mA

Power Pi 1.0 W

Capacitance Ci 7.3 nF

Inductance Li 0

Specific Conditions of Use (X):

1. The Model 5408 Level Transmitter will not pass the 500Vrms dielectric strength test
between the circuits and the earth ground. This must be taken into account during
installation.

2. Plastic wire-on tag, Plastic part of Process Seal Antenna and Non-standard paint
options (paint options other than Rosemount Blue) may cause risk from
Electrostatic discharge. Avoid installation that could cause electrostatic build-up,
and only clean with a damp cloth.

3. Appropriate cable, glands, and plugs need to be suitable for a temperature of 5°C
greater than the maximum specified ambient temperature for location where
installed.

4. The Transmitter can be installed in the boundary wall between EPL Ga and EPL Gb. In
this configuration, the process connection is EPL Ga, while the transmitter housing is
EPL Gb. Refer to Control Drawing D7000002-885.

5. Using the box provided on the nameplate, the User shall permanently mark the type
of protection chosen for the specific installation. Once the type of protection has
been marked it shall not be changed.

6. The applicable temperature class, ambient temperature range and process
temperature range of the equipment is as follows;

Temperature class / Maximum
surface temperature

Ambient temperature
range Process temperature range

Gas groups:   

T2 -60°C ≤ Ta ≤ 70°C -60°C to 250°C

T3 -60°C ≤ Ta ≤ 70°C -60°C to 195°C

T4 -60°C ≤ Ta ≤ 70°C -60°C to 130°C

Dust groups:   

T250°C -60°C ≤ Ta ≤ 70°C -60°C to 250°C

T200°C -60°C ≤ Ta ≤ 70°C -60°C to 195°C

T135°C -60°C ≤ Ta ≤ 70°C -60°C to 130°C
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Temperature class / Maximum
surface temperature

Ambient temperature
range Process temperature range

T100°C -60°C ≤ Ta ≤ 70°C -60°C to 95°C

T85°C -60°C ≤ Ta ≤ 70°C -60°C to 80°C

B.11.3 N7 IECEx Type N: Non-Sparking

Certificate: IECEx FMG15.0033X

Standards: IEC 60079-0:2011, IEC 60079-15:2010

Markings: Ex nA IIC T4…T2 Gc
(-34°C ≤ Ta ≤ +70°C), IP65
V≤42.4V, I≤23 mA

Specific Conditions of Use (X):

1. The Model 5408 Level Transmitter will not pass the 500Vrms dielectric strength test
between the circuits and the earth ground. This must be taken into account during
installation.

2. Plastic part of Process Seal Antenna may cause risk from Electrostatic discharge.
Avoid installation that could cause electrostatic build-up, and only clean with a
damp cloth.

3. Cable entries must be used which maintain the ingress protection of the enclosure
to at least IP65. To maintain the ingress protection ratings, Covers and Sensor
Module to be fully tightened and PTFE tape or pipe dope is required for cable entries
and blanking plugs. See Instruction Manual on application requirements.

4. The applicable temperature class, ambient temperature range and process
temperature range of the equipment is as follows;

Temperature class / Maximum
surface temperature Ambient temperature range Process temperature range

T2 -34°C ≤ Ta ≤ 70°C -34°C to 250°C

T3 -34°C ≤ Ta ≤ 70°C -34°C to 195°C

T4 -34°C ≤ Ta ≤ 70°C -34°C to 130°C

B.12 Brazil

B.12.1 E2 INMETRO Flameproof

Certificate: UL-BR 17.0344X
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Standards: ABNT NBR IEC 60079-0:2013, ABNT NBR IEC 60079-1:2016, ABNT NBR IEC
60079-26:2016, ABNT NBR IEC 60079-31:2014

Markings: Ex db IIC T6…T2 Ga/Gb
Ex tb III C T85°C…T250°C Db
Tamb = -60° to +70°C; IP6X

Specific Conditions of Use (X):

1. See certificate.

B.12.2 I2 INMETRO Intrinsic Safety

Certificate: UL-BR 17.0344X

Standards: ABNT NBR IEC 60079-0:2013, ABNT NBR IEC 60079-11:2013, ABNT NBR IEC
60079-26:2016, ABNT NBR IEC 60079-31:2014

Markings: Ex ia IIC T4…T2 Ga
Ex ib IIC T4…T2 Ga/Gb
Ex ia IIIC T85°C…T250°C Da
Tamb = -60° to +70°C

Safety parameter HART

Voltage Ui 30 V

Current Ii 133 mA

Power Pi 1.0 W

Capacitance Ci 7.3 nF

Inductance Li 0

Specific Conditions of Use (X):

1. See certificate.

B.12.3 N2 INMETRO Type N: Non-Sparking

Certificate: UL-BR 17.0344X

Standards: ABNT NBR IEC 60079-0:2013, ABNT NBR IEC 60079-15:2012

Markings: Ex nA IIC T4…T2 Gc
Tamb = -34° to +70°C; IP65
V≤42.4V, I≤23 mA

Specific Conditions of Use (X):

1. See certificate.
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B.13 China

B.13.1 E3 Flameproof

Certificate: NEPSI GYJ17.1226X

Standards: GB3836.1/2/4/20-2010, GB12476.1/5-2013

Markings: Ex d IIC T6~T2 Ga/Gb
Ex tD A21 IP6X T85°C~250°C
Tamb = -60° to +70°C; IP6X

Specific Conditions of Use (X):

1. See certificate.

B.13.2 I3 Intrinsic Safety

Certificate: NEPSI GYJ17.1226X

Standards: GB3836.1/2/4/20-2010, GB12476.1/5-2013, GB12476.4-2010

Markings: Ex ia IIC T4~T2 Ga
Ex ib IIC T4~T2 Ga/Gb
Ex iaD 20 T85~250 Da
Tamb = -60° to +70°C

Safety parameter HART

Voltage Ui 30 V

Current Ii 133 mA

Power Pi 1.0 W

Capacitance Ci 7.3 nF

Inductance Li 0

Specific Conditions of Use (X):

1. See certificate.

B.13.3 N3 Type N: Non-Sparking

Certificate: NEPSI GYJ17.1226X

Standards: GB3836.1-2010, GB3836.8-2014

Markings: Ex nA IIC T4~T2 Gc
Tamb = -34° to +70°C; IP65
V≤42.4V, I≤23 mA
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Specific Conditions of Use (X):

1. See certificate.

B.14 India

B.14.1 Intrinsic Safety

Certificate: PESO P403812

Markings: Ex ia IIC T4…T2 Ga

B.14.2 Flameproof Safety

Certificate: PESO P403810

Markings: Ex db IIC T6…T2 Ga/Gb

B.14.3 Intrinsic Safety and Flameproof

Certificate: PESO P402545

Markings: Ex ia IIC T4…T2 Ga/Gb
Ex db IIC T6…T2 Ga/Gb

B.15 Republic of Korea

B.15.1 IP Intrinsic Safety

Certificate: KTL 17-KA4BO-0448X

Markings: Ex ia IIC T4…T2 Ga
Tamb = -60° to +70°C

Safety parameter HART

Voltage Ui 30 V

Current Ii 133 mA

Power Pi 1.0 W

Capacitance Ci 7.3 nF

Inductance Li 0
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Specific Conditions of Use (X):

1. See certificate.

B.16 Additional certifications

B.16.1 QT Safety-certified to IEC 61508:2010 with certificate of
FMEDA data

Certificate: exida ROS 15-01-149 C001 R1.0

B.16.2 Suitable for intended use
Compliant with NAMUR NE 95:2013, “Basic Principles of Homologation”.

B.16.3 U1 Overfill prevention

Certificate: Z-65.16-575

Application: TÜV tested and approved by DIBt for overfill prevention according to the
German WHG regulations.

B.16.4 QA 3-A

Certificate Authorization Number: 3626

The following options are conforming to the 3-A Sanitary Standards, Number 74-06
(Sensors and Sensor Fittings and Connections):

Process connection type: C (Tri-Clamp)

Process connection size: 2, 3

Antenna type: SAA (Process Seal antenna)

Antenna size: 2, 3

The certification of the transmitter relies upon the following materials used in its
construction:

Product Contact SurfacesTable B-9:   

Item Material

Microwave launcher PTFE fluoropolymer
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Nonproduct Contact SurfacesTable B-10:   

Item Material

Metal housing Stainless steel 300 series or aluminium 360, painted with epoxy-poly-
ester or polyurethane

Fasteners and plugs Stainless steel 300 series

Seals Nitrile rubber NBR, Ethylene propylene peroxide and FKM fluoroelas-
tomer

Labels Stainless steel 300 series, metallized polyester, polyester/polycarbon-
ate

It is the responsibility of the user to ensure:

1. The materials listed in Table B-9 and Table B-10 are suitable for the media and
cleaning/sanitizing processes.

2. The installation of the transmitter is drainable and cleanable.

3. That the joint/clamping between the transmitter and the nozzle is compatible with
the tank pressure and media.

4. That for the application suitable cable entry devices are used and with appropriate
ingress protection.

5. That any unused cable entries are sealed with suitable plugs to maintain the ingress
protection ratings.

B.17 Installation drawings
The installation guidelines presented by the System Control Drawing must be followed in
order to maintain certified ratings for installed transmitters.
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D7000002-885 - System Control DrawingFigure B-1:   
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Appendix C
Configuration Parameters

C.1 Menu tree
The menu tree structure in Figure C-1 is applicable for Rosemount™ Radar Master Plus. For
AMS Device Manager and the Field Communicator, see Figure C-2.

Menu Tree for Rosemount Radar Master PlusFigure C-1:   
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Menu Tree for AMS Device Manager and Field CommunicatorFigure C-2:   
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C.2 Device setup

C.2.1 HART protocol

HART/polling address

The address range is 0 to 63. The transmitter operates in either standard mode with a 4–20
mA output signal or in multidrop. When the transmitter is in multi-drop mode, the current
output is fixed to 4 mA.

Burst mode

When set to burst mode, the transmitter regularly sends out messages instead of waiting
for the host to request it.

Both the transmitter and host must be configured to operate in burst mode. Almost all
HART host systems today are designed to communicate in poll/response mode, not burst
mode. However, the Rosemount 333 HART Tri-Loop™ requires burst mode communication
(see Section 5.9).

Variable mapping

Up to four transmitter variables can be assigned for the HART protocol. The transmitter
outputs a 4-20 mA signal proportional to the primary variable. Additional variables are
available through the HART digital signal. See Table A-2 for a list of available transmitter
variables.

Damping value

This parameter defines how fast the transmitter reacts to a change of the level value (step
response). The default value is 2 seconds.

A high value makes the level reading steady, while a low value allows the transmitter to
respond to rapid level changes (but the presented level value may be less steady).

Percent of range auxiliary

Set this parameter to output the percent of range for another transmitter variable (in
addition to the primary variable).
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Percent of range auxiliaryTable C-1:   

Parameter Description

100% auxiliary Value corresponding to 100% range of variable
selected for percent of range auxiliary.

0% auxiliary Value corresponding to 0% range of variable se-
lected for percent of range auxiliary.

C.2.2 Units
The units for length, volume, temperature, and level rates are selectable. All configuration
parameters and transmitter variables will be expressed in these units. For information on
available units of measure, see Output units.

C.2.3 Analog output
The output source (primary variable), range values, and alarm mode are specified for the
analog output.

Primary variable

Select the desired transmitter variable to use for the analog output.

Upper/lower range value

Enter the range values that correspond to the analog output values 4 and 20 mA. The
transmitter will drive the output to saturation mode if a measured value goes outside the
4-20 mA range values.

Note
Measurements may not be possible in the blind zone, and measurements close to the blind zone will
have reduced accuracy (see Figure A-1). Therefore, the 20 mA point should be configured outside
these zones.
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Example of Range Value SettingsFigure C-3:   

100%
(20 mA)

0% (4 mA)

D

C

A
Accuracy

Distance

B

± 0.08 in. 
(2 mm)

± 0.20 in. 
(5 mm)

A. Upper blind zone
B. Upper reduced accuracy zone
C. Level measurement range 0-100%
D. Zero Level

Alarm mode

The transmitter automatically and continuously performs self-diagnostic routines. If a
failure or a measurement error is detected, the transmitter drives the output to selected
alarm limit (high or low).

C.2.4 Display
Select variables to show on the optional LCD display (option code M5). If more than one
variable is selected, then the LCD display toggles between the output variables.

C.2.5 Security

Write protection

The transmitter can be write protected (with or without a password) to prevent
unauthorized changes.
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Operational mode

There are two Operational Modes to choose from for the Rosemount 5408:SIS: Control/
Monitoring and Safety (SIS).

If the transmitter is used as safety device in a Safety Instrumented System, the Operational
Mode must be set to Safety (SIS).

Safety mode

The Safety Mode applies only to the Rosemount 5408:SIS.

When the operational mode is set to Safety (SIS), then the Safety Mode must be enabled
for the transmitter to become operational. When Safety Mode is enabled, the transmitter
is write protected (with or without a password) to prevent unauthorized changes.

Change counter

A counter that increments each time the device enters active Safety Mode. Change
counter applies only to the Rosemount 5408:SIS.

C.2.6 Device Information

Tag

Identifier of up to 8 characters for the transmitter used by host system. The tag is typically
a reference number, location, or duty description.

Long tag

Identifier of up to 32 characters for the transmitter used by host system. It is
recommended to enter both a short and a long tag (they may be the same).

Date

The date field can be used for any purpose, for example to save the date of the last
configuration change.

Descriptor

The 16-character descriptor field can be used for any purpose.

Message

The 32-character message field can be used for any purpose, such as providing details of
the last configuration change.
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C.3 Level setup

C.3.1 Geometry
The transmitter configuration includes setting the tank geometry parameters, see 
Figure C-4 and Figure C-5.

Tank Geometry, Basic DimensionsFigure C-4:   

A. Device Reference Point
B. Reference Height
C. Zero Level
D. Vertical cylinder
E. Cubical Tank
F. Horizontal cylinder
G. Spherical tank
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Tank Geometry, All DimensionsFigure C-5:   

 A.  Tank Reference Point I. Bottom Shape Height*/Bottom Height**

B. Reference Height J. Height of Tank*/Height (of tank)**

C. Zero Level K. End Shape Length*/End Length**

D. Bottom Offset L. Length of Tank*/Length**

E. Device Reference Point M. Vertical cylinder

F. Reference Offset N. Cubical cylinder

G. Top Shape Height*/Top Height** O. Horizontal cylinder

H. Width of Tank*/Width** P. Spherical cylinder

* AMS Device Manager and Field Communicator

** Rosemount Radar Master Plus
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Mounting type

Select option best describing how transmitter is mounted on the tank. There are four
options to choose from: Nozzle, Still pipe, Chamber, and Bracket.

Mounting TypeFigure C-6:   

A. Nozzle
B. Still pipe
C. Chamber
D. Bracket (open air)

Inner diameter, pipe/chamber

Enter the inner diameter for the pipe or chamber in which the antenna is mounted. The
inner diameter value is used to compensate for the lower microwave propagation speed
inside the pipe/chamber. An incorrect value will give a scale factor error.

Tank shape

Select a tank shape that corresponds to the actual tank. If the actual tank does not match
one of the pre-defined tank shapes, then select Other (e.g. level measurements of sumps,
basins, or ponds).

Tank top shape

Form of the upper tank closure.
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Tank Top ShapeFigure C-7:   

A. Dome
B. Flat
C. Conical

Tank bottom shape

Form of the lower tank closure.

Tank Bottom ShapeFigure C-8:   

A. Dome
B. Flat
C. Conical/pyramid
D. Flat, inclined (for vertical cylinder)
E. Flat, inclined (for cubical tank)

Tank end shape

For a horizontal tank, form of the tank ends. Same shape is assumed at both ends.
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Tank End ShapeFigure C-9:   

A. Dome
B. Flat

Reference height

Distance between the Tank Reference Point (typically same as Device Reference Point) and
zero level.

Ensure the Reference Height is set as accurate as possible. The transmitter measures the
distance to the product surface and subtracts this value from the Reference Height to
determine the level.

Device reference point

Figure C-10, Figure C-11, and Figure C-12 show the Device Reference Point for various
antennas and tank connections.

Device Reference Point for Cone AntennasFigure C-10:   

A. Device Reference Point
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Device Reference Point for Process Seal AntennasFigure C-11:   

A. Device Reference Point

Device Reference Point for Parabolic AntennasFigure C-12:   

A. Device Reference Point

Reference offset

Distance between the Device Reference Point and the Tank Reference Point (typically the
upper side of a customer plug where levels can be manually measured).

The Reference Offset parameter can be used to specify your own reference point, for
example when the measured level by the transmitter should correspond with the level
value obtained by hand-dipping.

Configuration Parameters

232  Reference Manual



Reference OffsetFigure C-13:   

A. Tank Reference Point
B. Device Reference Point
C. Reference Offset > 0
D. Reference Offset < 0

Bottom offset

The Bottom Offset is defined as the distance between Zero Level and the tank bottom. The
default value is zero.

If the Zero Level is not located at the tank bottom, then enter a Bottom Offset. It is needed
for the transmitter to know the position of the tank bottom echo and for correct volume
calculations.
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Bottom OffsetFigure C-14:   

+

A. Tank Reference Point
B. Reference Offset
C. Device Reference Point
D. Reference Height
E. Zero Level
F. Bottom Offset

Height of tank

The vertical distance between tank bottom and tank roof. For a horizontal cylinder or
spherical tank, this is the diameter of the tank.

Width of tank

The horizontal distance between tank ends. For a vertical cylinder, this is the diameter of
the tank. The width of tank is also the shortest horizontal side of a box-shaped (cubical)
tank.

Length of tank

The longest horizontal side of a cubical tank.
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Top shape height

The height of the shape on tank top (typically from shape floor to cap top, measured at
cylinder center line).

Bottom shape height

The height of the shape at tank bottom (typically from shape floor to shape bottom,
measured at cylinder center line).

End shape length

The width of the spherical cap at tank end (measured at cylinder center line).

Show negative level as zero

When this setting is selected and the product surface is at or below Zero Level, the level
measurement output will be zero.

C.3.2 Environment

Product type

The media (liquid/solid) used in the monitored process.

• Liquid (requires measurement type code 1 or 4)

• Solid (requires measurement type code 3 or 4)

The solids measurement mode should never be used for measuring liquid products due to
the solids specific signal processing method, and vice versa.

Note
Solid is not supported for a Rosemount 5408:SIS operating in Safety (SIS) mode.

Process conditions

Turbulent surface

Set this parameter to improve the performance of the transmitter when there are small
and local rapid level changes caused by surface turbulence. The reason for the turbulence
might be splash loading, agitators, mixers, or boiling product.

Foam

This parameter should be used if there is, or may be, surface foam. When setting this
parameter, the transmitter is optimized for conditions with weak and varying surface echo
amplitudes, which is typical for presence of surface foam.
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Maximum level rate

Fastest rate that may occur in the monitored process to (partially) fill or empty this tank.
Note that product level rate may be higher during upset conditions.

Product dielectric range

Select the range of the dielectric constant for the product in the tank. If the range is not
known, or if the product in the tank is changed on a regular basis, then select Default.

C.3.3 Volume
Select if the volume measurement should be calculated from the configured tank
dimensions or a strapping table.

Strapping tables can be used for irregularly shaped tanks, to eliminate errors due to
bulging when product is added to a tank, or if a pre-defined tank type does not provide
sufficient accuracy.

Strapping table

Strapping table requires entering level-volume pairs in a table (maximum 50 points). Use
most of the strapping points in regions where the tank shape is non-linear. Starting at the
bottom of the tank, for each new point, enter the total volume up to the specified level
value.

Volume offset

Use this parameter to add a volume to each calculated volume value, for example a sump
volume below the Zero Level in the tank.

C.3.4 Scaled variable
The scaled variable can be used to convert a transmitter variable into an alternative
measurement, such as open channel flow, mass, or calibrated level (e.g. 5 point
verification). This variable is available only for transmitters ordered with Smart Diagnostics
Suite (option code DA1).

The scaled variable is defined by creating a table of transmitter variables and
corresponding output variables. A maximum of 50 points can be specified. Between the
points linearly interpolated values are calculated.

Scaled Variable ExamplesFigure C-15:   

Input Variable: 

Output Variable:

Level

Calibrated Level

Volume

Mass

Level

Flow

Configuration Parameters

236  Reference Manual



As an example, consider a product with a density of 900 kg/m3. In this case, the volume to
mass conversion is given by the following table:

Example of Scaled Variable TableTable C-2:   

Number Input value (volume) Output value (mass)

1 0 m3 0 ton

2 100 m3 90 ton

Scaled variable name

Name of the scaled variable. It is recommended to enter a short name to fit into the LCD
display area.

Scaled variable unit

Units of measurement of the scaled variable.

Number of scaled values

Number of values in the scaled variable table.

Input variable

Select the input variable to use for scaled variable calculation.

C.3.5 Antenna

Antenna type

The transmitter is designed to optimize measurement performance for each available
antenna type. This parameter is pre-configured at factory; it only needs to be set if the
antenna is changed to another type, or if you have installed a spare transmitter.

Antenna extension length

This parameter is pre-configured at factory. The Antenna Extension Length (see 
Figure C-16) must be changed if the extension is shortened, or if you have ordered a spare
transmitter head. Enter zero (0) for antennas without extensions.

Antenna Extension Length (L)Figure C-16:   

1 2 3 4 5 6 7 80 9
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User defined antenna options

Parameters for user defined antenna. These settings are typically provided by factory and
should only be modified for customized antennas.

When a Rosemount 5408 transmitter head is mounted on a Rosemount 5402 antenna,
refer to Table C-3 and Table C-4 for antenna parameters.

Rosemount 5402 Antenna Parameters, Free PropagationTable C-3:   

Antenna type

Tank connection
length

Antenna
gain

Nearzone
threshold
(mV)

Nearzone range Upper null zone (1)

ft m ft m ft m

2-in. cone, 316L SST (EN
1.4404)

0.509 0.155 2.45 4500 5.09 1.55 0.541 0.165

2-in. cone, Alloy C-276 or
Alloy 400

0.509 0.155 2.45 5000 5.25 1.60 0.492 0.150

2-in. process seal 0.929 0.283 3.4 3400 4.13 1.26 0.492 0.150

3-in. cone, 316L SST (EN
1.4404)

0.509 0.155 1.4 1170 3.38 1.03 0.492 0.150

3-in. cone, Alloy C-276 or
Alloy 400

0.509 0.155 1.4 4400 5.41 1.65 0.591 0.180

3-in. process seal 1.191 0.363 1.7 3400 4.13 1.26 0.492 0.150

4-in. cone, 316L SST (EN
1.4404)

0.509 0.155 0.9 1170 3.38 1.03 0.738 0.225

4-in. cone, Alloy C-276 or
Alloy 400

0.509 0.155 0.9 2400 4.27 1.30 0.820 0.250

4-in. process seal 1.316 0.401 0.8 1000 3.48 1.06 0.492 0.150

(1) Default setting. The Upper Null Zone may need to be increased if there are disturbance echoes in the region close to the antenna.

Rosemount 5402 Antenna Parameters, Still Pipe/Chamber InstallationTable C-4:   

Antenna type

Tank connection
length

Antenna
gain

Nearzone
threshold
(mV)

Nearzone range Upper null zone (1)

ft m ft m ft m

2-in. cone, 316L SST (EN
1.4404)

0.509 0.155 0.035 800 2.03 0.62 0.541 0.165

2-in. cone, Alloy C-276
or Alloy 400

0.509 0.155 0.035 900 3.28 1.00 0.492 0.150

2-in. process seal 0.929 0.283 0.035 930 2.56 0.78 0.492 0.150

3-in. cone, 316L SST (EN
1.4404)

0.509 0.155 0.035 800 2.03 0.62 0.492 0.150

3-in. cone, Alloy C-276
or Alloy 400

0.509 0.155 0.035 1100 4.27 1.30 0.591 0.180
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Rosemount 5402 Antenna Parameters, Still Pipe/Chamber Installation (continued)Table C-4:   

Antenna type

Tank connection
length

Antenna
gain

Nearzone
threshold
(mV)

Nearzone range Upper null zone (1)

ft m ft m ft m

3-in. process seal 1.191 0.363 0.035 1000 2.53 0.77 0.492 0.150

4-in. cone, 316L SST (EN
1.4404)

0.509 0.155 0.035 800 2.03 0.62 0.738 0.225

4-in. cone, Alloy C-276
or Alloy 400

0.509 0.155 0.035 1000 3.61 1.10 0.820 0.250

4-in. process seal 1.316 0.401 0.035 900 4.59 1.40 0.492 0.150

(1) Default setting. The Upper Null Zone may need to be increased if there are disturbance echoes in the region close to the antenna.

Upper null zone

The Upper Null Zone defines how close to the transmitter's reference point a level value is
accepted. You can extend this value to block out disturbing echoes close to the antenna,
for example from the tank nozzle or bypass well inlet. See Section 7.5.1 for more
information.

Note
Make sure the 20 mA value is below the Upper Null Zone. Measurements are not performed within
the Upper Null Zone (UNZ).

C.3.6 Advanced

Calibration offset

Difference between surface distance measured by transmitter and the same distance
measured by e.g. hand-dipping with a measurement tape. A positive Calibration Offset
value will increase the presented level value.

It is recommended to run the Verify Level tool to match the product level reported by the
transmitter to a reference measurement, see Section 5.7.

User defined variable setup

This section applies only to transmitters ordered with Smart Diagnostics Suite (option
code DA1).

Name

Name of the user defined variable. It is recommended to enter a short name to fit into the
LCD display area.
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Input register

Enter the number of the input register that contains value of the user defined variable. See 
Table C-5 for a list of suitable input registers.

The default value is 20210 (Distance).

List of Input Registers to the User Defined VariableTable C-5:   

Variable Register Description

Min Electronics Tempera-
ture

20146 Minimum electronics temperature measured by the de-
vice (°C)

Max Electronics Tempera-
ture

20148 Maximum electronics temperature measured by the
device (°C)

Surface Update Relation 21028 Determines how robust the surface echo measurement
is (0 to 1). A decreasing value may be used to identify
turbulence or foam in the process.

Min Signal Quality 21034 Minimum signal quality measured by the device since
last signal quality reset. Signal quality calculation must
be enabled to use this variable.

Max Signal Quality 21036 Maximum signal quality measured by the device since
last signal quality reset. Signal quality calculation must
be enabled to use this variable.

Distance to Upper Surface 21042 Distance to the upper product surface (m) when meas-
uring on multiple products in the tanks. Double Surface
function must be enabled to use this variable.

Distance to Lower Surface 21044 Distance to the lower product surface (m) when meas-
uring on multiple products in the tanks. Double Surface
function must be enabled to use this variable.

Surface Signal/Noise Ratio 21054 Ratio between surface echo signal strength and signal
noise (dB). A high value (>20 dB) indicates very good
margin to noise.

Product Dielectric Con-
stant

22800 Square root of the product dielectric constant estima-
ted by the transmitter when the Bottom Projection
function is enabled.

 

The product dielectric constant is calculated when both
the bottom and surface echoes are found by device,
and when surface echo is within the Max Projection Dis-
tance. Product dielectric constant estimation is frozen
if any of these conditions are not fulfilled.

Unit

Units of measurement of the user defined variable.
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More advanced options

More advanced options are only available in Rosemount Radar Master Plus.

By default, these parameters are automatically set based on current configuration. It is
recommended that these parameters should remain at the default settings, unless there is
a good understanding of the function and capability of the parameters.

Empty tank handling

The Empty Tank Handling functions handle situations when the surface echo is close to the
tank bottom.

Empty Tank HandlingTable C-6:   

Parameter Description

Empty tank detection area The Empty Tank Detection Area defines a range
where it is accepted to lose the echo from the
product. If the echo is lost in this range, the tank
is considered empty and the level is presented
as 0.

When the tank is empty, the transmitter looks in
this range for the product surface. When a new
echo is found in this range, it is considered to be
the product surface. Therefore, if there are dis-
turbance echoes in this area, they may need to
be filtered out.

This function requires the Bottom echo visible
when tank is empty parameter to be disabled.

Bottom echo visible when tank is empty Only enable this parameter if the bottom echo is
visible when tank is empty. By setting this pa-
rameter, the bottom echo will be treated as a
disturbance echo to facilitate tracking of weak
surface echoes close to the tank bottom (see 
Enable bottom echo visible when tank is empty).

Tank bottom projection

The Tank Bottom Projection is used to enhance measurement performance near the
bottom of the tank. When the tank bottom echo is strong (typical for flat tank bottoms)
and the dielectric constant of the product is low (e.g. oil), the transmitter may lock on the
bottom echo and report a false level measurement (empty tank). This problem can be
solved by using the Tank Bottom Projection function. See Section 7.5.2 for further
instructions.
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Tank Bottom ProjectionTable C-7:   

Parameter Description

Bottom product dielectric constant Enter the product dielectric constant for the
product in the bottom of the tank.

Maximum projection distance This defines the range where the function is ac-
tive. Enter the maximum distance from the zero
level (tank bottom).

Minimum tank bottom amplitude Enter the minimum allowed amplitude for the
echo from the tank bottom before this function
is activated.

Echo tracking

Surface echo tracking

Use these settings to configure how the transmitter should keep track of the surface.
These are advanced settings. Normally, they should not be changed.

Surface Echo TrackingTable C-8:   

Parameter Description

Search window size This parameter defines a window centered at
the current surface position where new surface
echo candidates can be selected. The size of the
window is ±Search Window Size. Echoes outside
this window will not be considered as surface
echoes.

If there are rapid level changes in the tank, the
value of the Search Window Size can be in-
creased to prevent the transmitter from missing
level changes. On the other hand, a large value
may cause the transmitter to select an invalid
echo as the surface echo.

Track first echo Select the Track First Echo check box if the first
echo above threshold always should be consid-
ered as the surface echo (see Section 7.5.3).

Double surface handling

If there are multiple products in the tank, the Double Surface Handling function can be
manually set to allow user to select if the upper or lower product should be used as output.

The upper and lower surface echoes must be stronger than any disturbance echoes in the
search region for Double Surface Handling to function properly.

Configuration Parameters

242  Reference Manual



Double Surface HandlingTable C-9:   

Parameter Description

Track upper surface Track upper surface when there are multiple
products in the tank (for example thin oil layer
on top of water).

Track lower surface Track the lower product surface, such as the in-
terface when there are multiple products in the
tank, or the product surface instead of a foam
layer.

Upper product dielectric constant Enter the dielectric constant for the upper prod-
uct. A more precise value results in better accu-
racy for the lower surface level.

Double bounce handling

Use this function to prevent transmitter from locking on strong double bounce echoes
(may occur in spherical and horizontal cylinder tanks). See Section 7.5.4 for more
information.

Overfill prevention

The Overfill Prevention function adds an extra layer of protection to prevent tank overfills.
The function uses an independent echo logic algorithm to identify the surface echo close
to the top of the tank.

In the unlikely event there is a conflict between the normal and the overfill prevention
echo logic, the Overfill Prevention function will have a precedence in determining the
position of the surface. The transmitter will then output this new value, or generate an
alarm if the normal echo logic is not able to find the surface echo at the new position.

The Overfill Prevention Range defines the lower end of the range in which the function
operates. The range is configurable. See Figure C-17 for default factory settings.
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Overfill Prevention RangeFigure C-17:   
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B. Overfill Prevention Range
C. Rosemount 5408:SIS
D. Rosemount 5408

Expert options

Use the expert options to view input registers, and to view and edit holding registers.

Note
Instructions for how to use Expert options are typically provided by factory and should only be
modified if required.

Expert options

Use the expert options to view input registers, and to view and edit holding registers.

Note
Instructions for how to use Expert options are typically provided by factory and should only be
modified if required.
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C.4 Alert setup

C.4.1 Measurement recovery
Measurement recovery time

The Measurement Recovery Time (Echo Timeout) parameter controls the maximum time
from when measurement is lost (e.g. due to process conditions such as foam or
turbulence) until it is annunciated. If measurement is recovered within the time specified
by this parameter, then it will not be annunciated.

Measurement recovery handling

By default, the Measurement Recovery Time is set up automatically by the device based on
the transmitter configuration.

It is recommended to leave the Measurement Recovery Handling at default unless
required by your application. A higher value may be entered to increase robustness and
avoid nuisance alarms. Only enter a lower value if lost measurement is required to be
annunciated within a certain time for your application.

Used measurement recovery time

This is the value used by the transmitter.

C.4.2 Signal quality alert
This section applies only to transmitters ordered with Smart Diagnostics Suite (option
code DA1).

Signal Quality is a measure of the product surface echo amplitude compared to the surface
threshold and noise.

The Signal Quality spans from 0 to 10. A low value means that there is a risk for the noise
peak to be mistaken for the product surface peak.

Note
The Signal Quality may not be 10 even if the antenna is clean. The value depends on antenna type,
application conditions, configured surface threshold, as well as the condition of the antenna.

Build up on the antenna and different surface conditions are factors that can result in a low
Signal Quality value. By setting an alert(1), the Signal Quality value can be used to schedule
maintenance to clean the antenna, fine-tune the surface threshold, or detect and monitor
adverse surface conditions such as turbulence or foam.

Suitable alert limits vary from application to application. Appropriate value can be
determined by logging Signal Quality over time and viewing maximum/minimum values.
The Signal Quality Alert limit should be at least 1, but a better guideline is 2-3.

(1) Signal strength fluctuations are common when measuring solids, so Signal Quality alerts may not be appropriate in this case.
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Signal Quality AlertFigure C-18:   

A. Signal quality
B. Time
C. Alert ON
D. Deadband
E. Limit
F. The Signal Quality drops below the alert limit and an alert message is triggered.
G. The alert message is reset once the Signal Quality value rises above the Deadband range.

Limit

The Signal Quality value that will trigger the alert.

Deadband

The Deadband is a buffer zone so the alerts do not toggle on and off when the Signal
Quality fluctuates around the alert limit. The alert is set when value falls below the alert
limit. The alert is then cleared when value rises above the Deadband range.

C.4.3 High/low user defined alert
A high and low alert may be established to output an alert message when the
measurement readings exceed the specified limits.

Variable

Select the transmitter variable to use for the alert.

Limit

The value that will trigger the alert.

Deadband

The Deadband is a buffer zone so the alerts do not toggle on and off when the
measurement value fluctuates around the alert limit. The alert is set when the value
exceeds the alert limit. The alert is then cleared when the value falls outside the Deadband
range.

Configuration Parameters

246  Reference Manual



High User Defined AlertFigure C-19:   

A. User Defined Alert
B. Time
C. High Alert ON
D. Limit
E. Deadband
F. The alert is active when the level value rises above the alert limit.
G. The alert turns off when the value falls below the deadband.

Low User Defined AlertFigure C-20:   

A. User Defined Alert
B. Time
C. Low Alert ON
D. Deadband
E. Limit
F. The alert is active when the level value falls below the alert limit.
G. The alert turns off when the value rises above the deadband.
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